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Harga Rp. 6.500,- (Pulau Jawa), Rp. 7.000,- (Luar Jawa)
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Edisi Khusus Akhir Tahun

• Mempercepat Proses Penyimpanan
File di Word

• Membuat Efek Flip-Flop dengan
Microsoft Power Point

• Menggunakan Fungsi Bookmark
pada Microsoft Word

• Menulis Kata Ulang
dengan Cepat

• Mobo
All In One:
Teknologi
dan Fitur
Baru
Bermunculan

• Komponen PC yang
Memberi Warna pada
Tahun 2003

• Manuver “Mobile” untuk
Menemukan Jalan Tol ke Internet

• Wireless: Sistem Komunikasi
Masa Depan

• PC Multimedia: Tren PC yang
Multifungsi

Badai Serangan
Virus di Tahun
2003

Menjelajah Kota
Melalui
Peta Virtual

Kirim
Fax
dari
Kom-
puter
via Inter-
net

Kenali Kode Error
pada PC
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PCplus
TABLOID KOMPUTER

EDITORIAL ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

WORKSHOP PCPLUS DI
DAERAH

Saya adalah pelanggan
PCplus dan saya baca ada
workshop PCplus di Yogya,
Surabaya, dan Jakarta.  Saya
usul untuk mengadakan
workshop di Cirebon, kota
tempat tinggal saya.  Dulu saya
juga sempat mengikuti work-
shop Merakit PC yang diadakan
di kota tetangga (Kuningan).
Saat ini saya sedang belajar
Linux dan akan sangat gembira
jika PCplus bisa mengadakan
kembali workshop tentang
Linux di Cirebon atau kota-kota
di sekitar Cirebon. Salam
hormat.

Ester Yulianti Dewi
cbnsit@bankbuana.com

Red: Terima kasih atas usulannya.
Kesulitan kami adalah mencari
partner lokal di daerah. Melalui
rubrik ini kami informasikan juga
bahwa PCplus membuka
kesempatan kepada partner lokal
untuk bekerja sama dalam
penyelenggaraan workshop. Untuk
mendapatkan informasi
selengkapnya, silakan
menghubungi jimmy@e-
pcplus.com.

SOFTWARE AKUNTANSI
Saya mau tanya nih kepada

para redaksi PCplus, ada gak sih
software buat acounting/
pembukuan yang berbahasa
Indonesia dengan kapasitas yang
tidak terlalu besar dan kalo bisa
gratis. Atas perhatiannya saya
ucapkan terima kasih.

Resti putriyanti
restiputriyanti@plasa.com

Red: Setahu kami, yang gratisan sih
belum ada. Ada software tersebut
tetapi umumnya tidak bisa
didapatkan secara cuma-cuma.
Kalau program berbahasa Inggris,
kemungkinan ada. Anda bisa
mencarinya misalnya di
www.download.com atau coba
masukkan keyword “accounting
freeware” di mesin pencari
www.google.com.

KOMPUTER REWEL DAN
LANGGANAN

Pertama kali saya kirim e-
mail ke PCplus, tapi bukan berarti
baru kenal kamu sekarang
melainkan sudah lama saya me-
ngenalmu dan mengikuti semua
artikelmu sampai edisi sekarang
kagak pernah ketinggalan.

To the point
aja...nich.....mohon bantuan
penjelasan spesifikasi komputer
merek XYZ** yang aku punya
saat ini. Kok selalu rewel alias
setiap kita lagi kerja, tiba-tiba
komputer ini restart sendiri
sehingga data-data yang belum
sempat di-save ikut hilang juga.
PCplus yang baik hati, mohon
bantuannya dan gimana kalau
kita mau langganan tabloidmu
harus kemana contact
kamuuu.......??? Thanks you.

Lilik Hadiyanto
Lilik@car.co.id

Red: Sayang penjelasan dari masalah
Anda kurang lengkap sehingga kami
sulit untuk menawarkan solusi.
Untuk berlangganan, silakan Anda
menghubungi agen koran terdekat
dari rumah Anda.

USULAN INSTALASI
JARINGAN

Kaulah lubuk ilmu yang
membuatku tahu dan mengerti
tentang komputer dan teknologi
informasi. Selamat ultah buat
PCplus. Sebagai pembaca
setiamu, saya mengharapkan
PCplus terus menjadi muara ilmu
karena ilmu pengetahuan adalah
harta karun yang selalu dapat
kita bawa ke manapun tanpa
membebani.

Sedikit usul, bagaimana
kalau PCplus mengupas tuntas
tentang instalasi jaringan beserta
software dan hardware-nya
dalam SisiPlus, untuk rubrik
plusTrik boleh juga tuh ada
sisipan trik pemrograman. Saya
harap ini dipertahankan karena
sebagai tambahan wawasan
dalam belajar pemrograman.

Sebagai informasi buat rekan
PCplus, kotaku kini punya
website cantik yaitu
www.purwakarta.go.id,
silakan kunjungi buat yang ingin
tahu lebih banyak tentang
daerah Kabupaten Purwakarta.

Terus maju PCplus!

Hendarlan
hendarlanvb@yahoo.com

Purwakarta-Jawa Barat

Red: Thanks atas usulannya dan
maaf atas telatnya pemuatan surat
Anda. Kami akan coba realisasikan
sesuai dengan segmen pembaca
PCplus yang umumnya adalah end
user dan pemula.

TANYA LINUX
Saya seorang pelajar dan

saya baru saja ingin menekuni
bidang komputer. Beberapa
waktu lalu saya membeli sebuah
komputer, tetapi di dalamnya
belum terinstal sistem operasi
dan komputer tersebut sama
sekali belum bisa digunakan. Hal
ini dikarenakan harga MS-
Windows yang tidak terjangkau
oleh kalangan seperti saya,

sementara sebagai pelajar saya
sangat membutuhkan komputer
sebagai sarana belajar.

Saya sempat putus asa dan
tidak tahu apa yang harus saya
lakukan dengan komputer
tersebut, sampai pada akhirnya
ada seorang teman yang
menyarankan saya untuk
menggunakan Linux dan saya
sangat tertarik untuk
mendapatkannya. Tetapi saya
belum mengerti benar tentang
Linux. Yang ingin saya tanyakan:
1. Linux terbaru apakah dan

versi berapa yang bisa saya
gunakan?

2. Jika saya men-download-nya
dari Internet, apakah saya
bisa mendapatkan versi
penuhnya dan bisakah saya
simpan Linux tersebut pada
media CD?

3. Apakah saya tidak dikenakan
biaya sama sekali (gratis)?

Cukup sekian pertanyaan
saya dan saya sangat mengharap-
kan saran dan masukan dari
PCplus karena saya sangat-sangat
membutuhkannya agar komputer
saya bisa berfungsi dan bisa
digunakan sebagaimana
mestinya.

Priyo Tunggul
priyo_tunggul@yahoo.com

Red: Jawaban dari pertanyaan Anda
tidak bisa diuraikan secara singkat di
sini. Silakan menghubungi salah satu
kru PCplus, vincent@e-pcplus.com
untuk menanyakan hal-hal tersebut.

TRANSFER DAN EDIT
REKAMAN

Dear PCplus, saya punya
masalah nich. Tolong bantu kasih
solusi ya. Saya punya komputer
yang akan saya gunakan untuk
mengedit dan mentransfer hasil
rekaman dari handycam ke
kepingan VCD. Masalahnya saya
gak tau gimana caranya terus
alat serta software apa aja yang
dibutuhkan untuk keperluan
transfer dan editing hasil
rekaman tersebut. Dear PCplus
tolong ya...kasih jawaban ya,
kalau bisa jawabannya dalam
bentuk tutorial dan kirim ke e-
mail-ku. Thanks atas
perhatiannya, selanjutnya saya
menunggu solusi dari PCplus.

Sutan Alam Bona Parlindungan
alien_dark@myway.com

Red: Transfernya bisa menggunakan
interkoneksi firewire (IEEE 1394),
sedangkan software-nya gunakan
saja Ulead Video Edition. Maaf, kami
belum bisa memberikan jawaban
dalam bentuk tutorial seperti yang
Anda minta.

TANYA INSTALASI
SOFTWARE

Saya ingin bertanya tentang
hal berikut. Saya ingin meng-
uninstall/remove beberapa

program yang tidak terlalu
penting sehingga yang tersisa
betul-betul hanya program-
program yang aplikatif (sesuai
dengan kemanfaatan yang ada
pada saya dan pengguna lainnya,
adik-adik) misalnya: Microsoft
office 2000 Premium,
Macromedia Flash 5, Norton
Utilities 2002 for Windows, dan
lain-lain. Pertanyaan saya:
1. Jika saya remove semua, apa

tidak mempengaruhi program
lainnya yang terkait? Ada
pengaruhnya tidak?

2. Apa bedanya XingMPEG
Encoder dengan XingMPEG
player?

3. Jika saya me-remove program
Epson Printer Software, Epson
Status Monitor, ES C41
Problem solver, apa printer
saya masih bisa jalan?

4. Waktu saya me-remove
beberapa program game
muncul sebagai berikut:
The following file does not

exist or is not a valid
uninstallation log file.

C:\[nama program
game]\uninstal.log. Apa
maksudnya? Atau muncul
sebagai berikut: Unable to
locate the installation log file.
C:\program file\[nama pro-
gram game]\\DeisL1.ism.
Uninstall will not continue.
Apa maksudnya juga? Mohon
penjelasan semua pertanyaan
saya ini?

Maksud saya ingin me-
remove beberapa program yang
tidak terlalu penting adalah
supaya saya bisa mendapatkan
sisa space harddisk yang banyak
(karena akan saya instal program
baru lagi) dan juga untuk bisa
meningkatkan performansi yang
lumayan. Spesifikasi komputer
saya: Pentium II 233 MHz MMX,
HD 3,2GB, RAM 32MB.

Syaiful Amin
syaiful_am@engineer.com

Red: 1. Biasanya ada program yang
membutuhkan program lain yang
harus diinstalasikan agar dapat
bekerja. Kalau Anda sudah yakin
tidak terlalu membutuhkan program
tersebut, silakan uninstall. 2.
XingMPEG Encoder merupakan
software untuk mengolah video,
sedangkan XingMPEG Player adalah
software untuk memutar video. 3.
Asalkan Anda tidak meng-uninstall
driver printer tersebut, biasanya
tidak apa-apa. Software-software
tersebut biasanya cuma software
tambahan untuk meningkatkan
fungsionalitas printer Anda. 4. File
tersebut merupakan sebuah file log
instalasi. Kemungkinan file tersebut
terhapus/hilang atau instalasinya
tidak sempurna. Kalau dengan
uninstall biasa tidak mau, coba Anda
hapus folder game tersebut, lalu
Anda bersihkan registry dengan
software pembersih registry.

Edisi Spesial di Penghujung Tahun

Beberapa artikel di PCplus edisi spesial ini berbicara tentang masa lalu.
Apa gunanya masa lalu? Tak lain untuk membuat kita semakin mantap
berjalan ke arah masa depan. Membicarakan masa lalu menjadi semakin
relevan tatkala kita membutuhkan pegangan untuk berjalan di masa
mendatang, yang barangkali agak berangin dan berkerikil lantaran politik
yang menghangat oleh Pemilu 2004.

Artikel yang lainnya banyak membahas tentang trik Office 2003 yang
baru diluncurkan! Apa gunanya? Bukankah harganya juga masih mahal? Tak
perlu berdebat, trik tetaplah bacaan paling menarik untuk diikuti langkah
demi langkahnya, kata demi katanya, karena trik menyimpan rahasia-rahasia
tersembunyi yang tak banyak orang tahu. Dengan demikian, kita menjadi
semakin pede untuk menyelami geliat teknologi terbaru dan tidak akan me-
rasa kuper ketika harus berdiskusi dengan orang lain mengenai masalah ini.

Sebagian artikel berbicara pula tentang isu-isu penting seputar dunia
teknologi informasi! Mengapa PCplus membesar-besarkan isu? Jangan
samakan isu dalam konteks di sini dengan berita-berita gosip tentang
selebriti dan artis yang bertebaran di layar kaca dan tabloid-tabloid
infotainment. Isu TI yang kami angkat tak lain justru merupakan informasi
yang menjadi tonggak penting alias milestone dari seluruh perkembangan
teknologi informasi yang sekarang ini kita nikmati bersama.

Artikel yang lain lagi bicara soal Linux dan juga Software. Dua hal ini
penting karena bagaimanapun, keduanya adalah pilar dalam perkembangan
komputer masa kini. Rasanya amat aneh tidak membicarakan Linux dan juga
perkembangan software ketika kita sudah memutuskan untuk mencintai
komputer dan teknologi informasi.

Itulah serangkain bonus yang kami siapkan untuk Anda di edisi
penghujung tahun 2003 ini. Tentu saja, bonus tersebut merupakan sajian
khusus menjelang libur Natal dan Tahun Baru. Selain bonus-bonus itu, masih
ada beberapa artikel reguler yang tetap bisa Anda dapatkan seperti game,
ulasan produk, dan juga rubrik-rubrik menarik lainnya.

Sebagaimana sudah kami informasikan, edisi ini akan beredar selama
tiga minggu, terhitung mulai 16 Desember hingga 5 Januari tahun depan.
Untuk itulah kami tampil spesial, supaya Anda tetap tidak merasa kehilangan
selama beberapa minggu. Untuk itu, di edisi ini harga juga kami sesuaikan
dengan jumlah halaman yang kami hidangkan untuk Anda.

Akhirul kata, menutup tahun 2003 ini, ijinkan kami meminta maaf
atas segala kekurangan yang telah kami buat, dan sekaligus perkenan-
kan kami berujar tekad, untuk memberi yang lebih baik buat Anda
di tahun mendatang.

Selamat menikmati, selamat Natal, selamat Tahun Baru.

Salam hangat dari Palmerah
Redaksi
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TROUBLESHOOTING PC
Salam hormat untuk semua

redaksi PCplus. Saya mempunyai
pertanyaan yang mungkin
redaksi dapat menjawabnya,
soalnya saya masih awam dalam
dunia komputer.
1. Saya pernah melihat iklan

memori di PCplus, di sana
tertera misalnya: Visipro
SDRAM 128MB (4 IC) PC-133,
ada yang  8 IC dan 16 IC. IC ini

maksudnya apa, bagaimana
mengetahui bahwa memori IC
dengan angka tersebut dapat
digunakan di komputer ter-
tentu. Apakah setiap kom-
puter dapat menggunakan
memori dengan IC yang
berbeda. Memori dengan IC
yang mana yang paling baik?

2. Pada kotak monitor tertera
dot pitch 0.28 mm, ini
maksudnya apa sich? Dengan
dot pitch yang semakin besar
atau yang semakin kecil

angkanya yang paling bagus
bagi komputer? Apakah
setiap dot pitch pada monitor
itu berbeda.

3. Saya mempunyai komputer di
rumah dengan spesifikasi
Pentium III 1 GHz, memori
SDRAM 128 mb, VGA dan
soundcard onboard, monitor
Samsung 15 GLsi,
motherboard Jetway dengan
Chipset SiS 630/730,  CD-ROM
Samsung 52x, harddisk
Samsung 20G, multi OS
dengan Win 98 (C:\) dan Win
2000 (D:\). Yang ingin saya
tanyakan, mengapa pada saat
komputer ingin saya Stand By
melalui menu Shut Down
selalu muncul blue screen. Ini
terjadi di Win 98 sedangkan
di Win 2000 ini tidak terjadi.

4. Bagaimana mengubah default
awal untuk booting pada

[boot loader] dari Windows
2000 menjadi Windows 98 SE?
Soalnya setiap pertama kali
booting komputer saya selalu
menunjukkan ke Windows
2000.

5. Komputer saya pernah
tertular sebuah virus, jika
terkena virus itu maka ia akan
mengopikan  ke setiap folder
dengan Extension
"Hollo.roro.htt" dan sebuah

file lagi yang saya lupa
namanya. Jika dihapus maka
pada saat kita mengklik
kanan Refresh maka file itu
akan muncul lagi. Lalu pada
Windows Explorer pada
View>Folder Options>View
pada option "Hidden Files"
selalu pada pilihan "Do not
show hidden or system files",
meskipun pada saat kita ubah
menjadi "Show all files", pada
saat setelah Refresh itu akan
kembali pada pilihan semula.

Begitu juga pada "Hide file
extension for known file
types" meskipun saya telah
menghilangkan tanda hitam
pada pilihan itu, pada saat
Refresh selalu kembali ke
pilihan awal. Bagaimana cara
menghapus virus ini dan apa
sih nama virus itu?

6. Bagaimana supaya setiap
folder di MyComputer
menjadi as A Web Page",
kadang-kadang meskipun
telah kita pilih "as A Web
Page" pada suatu folder,
setelah kita buka folder lain
dan kembali ke folder itu
maka "as A Web Page" akan
tidak terpilih. Mengapa itu
bisa terjadi?

7. Bagaimana cara supaya
tombol Ctrl+Alt+Del dapat
berfungsi, soalnya pada
komputer warnet kadang jika

kita menekan Ctrl+Alt+Del
untuk menutup program yang
"Not Responding" kadang
menu "Close Program" tidak
muncul. Akibatnya jika ada
program yang "Not Respond-
ing" saya tidak bisa
menutupnya.

Demikianlah pertanyaan
saya, saya harap PCplus dapat
menjawabnya dengan jelas
walaupun ringkas. Soalnya saya
butuh jawaban dari PCplus.
Terima kasih.

Nino
tepekong@plasa.com

Red:
1. IC yang dimaksud di sini adalah

chip DRAM yang digunakan.
Keping memori itu tersusun dari
beberapa chip DRAM. Kapasitas
dari keping memori itu adalah
jumlah kapasitas dari chip DRAM
yang digunakannya. Ini berarti
sebuah keping memori 128MB
yang 4 IC akan menggunakan
chip DRAM dengan kapasitas
lebih besar dibandingkan yang
16 IC. Setiap mainboard memiliki
dukungan terhadap chip DRAM
dengan kapasitas tertentu saja
(yang populer saat itu biasanya).
Jadi mainboard lama bisa
bermasalah dengan chip DRAM
yang berkapasitas melebihi nilai
tertentu. Untuk mainboard lama
sebaiknya tidak menggunakan
keping memori dengan IC (chip
DRAM) yang terlampau sedikit.

2. Suatu monitor CRT bisa
menghasilkan gambar dengan
banyak warna dengan
mengombinasikan tiga warna
dasar yang dimilikinya. RGB (Red
Green Blue) adalah ketiga warna
dasar tersebut. Agar beragam
warna lain bisa terjadi, ketiga
warna ini harus dipadukan
ataupun diletakkan sangat
berdekatan. CRT meletakkan
ketiga warna ini sebagai titik-titik
kecil yang sangat berdekatan
dengan pola tertentu pada layar.
Jarak antara titik merah dengan
titik merah sebelahnya adalah
dot pitch. Semakin kecil dot
pitch pada monitor berarti
semakin bagus kerapatan
gambar monitor tersebut.

3. Pada beberapa PC yang
menggunakan OS Windows
98SE, masalah ini memang
kadang-kadang muncul. Untuk
mengatasinya Anda dapat men-
download patch untuk shut-
down di situs Microsoft.

4. Untuk mengubah default boot
ke Windows 98 Anda dapat
mengganti default=
multi(0)disk(0)rdisk
(0)partition(2)\WINDOWS
menjadi default=c:\.

5. Coba gunakan Norton Antivirus
atau McAfee Virusscan dengan
update terbaru.

6. Di Windows Explorer klik
View>Folder Options>View,
kemudian tandai checkbox
'Remember each folder's view
settings'.

7. Buka Registry Editor, kemudian
masuk ke key
HKEY_CURRENT_USER\
Software\Microsoft\
Windows\CurrentVersion\
Polici s\. Ubah value data
Disabletaskmgr menjadi 0.

MIRC DAN WORKSHOP
Bagaimana nih kabarnya

semua yang ada di redaksi
PCplus? Saya pengen usul nih
buat PCplus, tolong ulas
tentang trick yang ada di MIRC
seperti script-script/code-code
khusus yang bisa ngejailin
teman chat kita dan saya punya
script-script-nya tapi saya ngak
bisa ngejalaninnya dan juga
saya pengen tau caranya kick,
ban dan kalau bisa kasih tau
saya cara-caranya.

Terus, kapan nih ngadaian
workshop di Bandung? Saya

tunggu informasinya dan sekali
lagi saya minta bantuannya
dari PCplus tentang MIRC.
Semoga PCplus makin bagus
saja dalam informasi-
informasinya.

Indra Suryawijaya
indra_suryawijaya@yahoo.com

Red:  Terima kasih usulannya, akan
kami usahakan. Workshop akan
dijadwalkan kembali pada tahun
2004 dengan tema yang bervariasi.
Tunggu informasi selanjutnya dari
Bagian Promosi PCplus.

MENGHUBUNGKAN DUA
PC

Salam kenal. Saya adalah
pembaca barumu. Dengan ini
ada beberapa hal yang ingin
saya tanyakan:
1. Bagaimanakah cara

menghubungkan dua
komputer agar dapat
berkomunikasi serta
bagaimanakah seting
pengaturannya, mengingat
saya memiliki dua komputer
di rumah?

2. Apakah PCplus selalu
mengeluarkan CD pada tiap
ulang tahunnya? Jika iya,
bagaimana cara untuk
mendapatkannya
mengingat saya sudah
memiliki CD PCplus pada
ulang tahunnya yang
pertama (pemberian
saudara).

Demikian pertanyaan saya.
Atas perhatiannya saya ucapkan
banyak terima kasih.

Bayu Super
bayusuper@yahoo.co.uk

Red: 1. Anda bisa menggunakan
direct cable connection (DCC)
menggunakan kabel laplink yang
berbasis port paralel. 2. Selama
tiga kali ulang tahun, kami
memang menerbitkan CD PCplus.
Untuk mendapatkannya, Anda
bisa menghubungi sirkulasi@
e-pcplus.com

ROBBY/PCplus
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Januari 2003, Yaha.M
dan Klez.H menutup

akhir tahun 2002 dan
menjadi bingkisan

tahun baru yang
tidak menyenangkan

di awal tahun 2003.
Klez menunjukkan

kehebatannya
sebagai salah satu

virus paling panjang
umur sepanjang masa

karena dapat
bertahan di peringkat

satu lebih dari 1
tahun.

lez.A muncul
pertama kali
di bulan Oktober 2001,
dan sampai tahun 2003

variannya terutama Klez.H
mampu menduduki singgasana
sebagai virus yang paling banyak
terdeteksi menyebar di internet.
Tercatat juga pembuat virus yang
mendompleng ketenaran
penyanyi Avril Lavigne dengan
mengeluarkan virus Lirva
(kebalikan dari Avril). Selain itu,
para pembuat virus tidak mau
kalah dengan Chrisye dan Sofia
Latjuba yang menyanyikan

kembali lagu “Kangen”
milik group musik Dewa.

Pada tanggal 8
Januari 2003, Explorezip.N
sebuah worm yang pernah
sangat ngetop di
jamannya 3,5 tahun yang
lalu tepatnya awal Juni
1999 dikompres dengan
teknik baru dan
disebarkan kembali ke
Internet. Dengan teknik
kompresi baru,
Explorezip.N merupakan
tamparan bagi para
vendor antivirus karena
mampu mengelabui
banyak program antivirus
yang mengklaim memiliki
kemampuan heuristic dan
update definisi < 9 Januari 2003
terbukti tidak dapat mengenali virus
Explorezip.N. Celakanya,
Explorezip.N ini menghancurkan
semua data MS Office dan hanya
dapat di-recover dengan

menggunakan teknik data recovery
tingkat tinggi.

Seakan tidak cukup membuat
pengguna komputer menderita,
pada tanggal 27 Januari muncul
satu virus baru sejenis CodeRed

dengan nama Slammer yang
menyerang SQL Server 2000. Di
Indonesia 3 perusahaan webhosting
yang cukup ternama yang
terkoneksi ke IDC mengalami
kondisi down server-nya karena
serangan DDos. Traffic yang dihasil-
kan oleh Slammer bukan main-
main, router sekelas Cisco 3600 yang
termasuk middle class switch tidak
mampu menampung bandwidth
yang dihasilkan Slammer sehingga
mau tidak mau hubungan server ke
router harus dicabut dan baru diko-
neksikan kembali setelah Slammer
dibasmi dan SQL Server di-patch.

OPASERV.K: HUKUMAN BSA
UNTUK PEMBAJAK

Setelah mengalami badai
serangan virus di awal tahun, bulan
Februari diwarnai dengan
munculnya Opaserv.K, varian
Opaserv yang menyebar hanya
melalui jaringan, baik jaringan
Internet maupun jaringan komputer
lokal dengan penambahan
kemampuan menghancurkan
harddisk komputer yang terinfeksi.
Opaserv akan melakukan scanning
atas port 137 dan jika berhasil ia
akan menginfeksi melalui port 139.

Serangan Opaserv.K yang
menghancurkan harddisk
korbannya dan memunculkan pesan
“seolah-olah” dari BSA (Business
Software Alliance) yang
menghukum pengguna komputer
karena menggunakan program

bajakan. Hal ini sempat membuat
BSA kebakaran jenggot sehingga
mengeluarkan sanggahan.

Jangan lupa dengan Sobig.C
yang pada tanggal 8 Juni 2003
membuat printer Anda kerja bakti
menghasilkan banyak sekali print-
out dengan karakter-karakter aneh.

Bugbear Reloaded,
demikianlah Sophos
menggambarkan aksi Bugbear.B
yang pada hari pertama
kemunculannya langsung
menggeser semua virus top
termasuk Sobig.C yang barusan
mengganas dari singgasananya.
Serangan Bugbear.B ini termasuk
kategori dashyat, sebagai
perbandingan, perhatikan bahwa
jumlah Bugbear.B di peringkat satu
yang dihentikan adalah 95.000an e-
mail, bandingkan dengan Sobig.C
yang menempati peringkat dua

dengan jumlah e-mail yang
dihentikan 25.000an. Hal ini
menunjukkan perbedaan kasus
yang sangat signifikan (4 kali lipat).

Bulan Juli 2003, Fortnight.D
secara diam-diam mengganas di
pengguna komputer Indonesia.
Vaksincom mendapatkan banyak
keluhan dari aksi Fortnight yang
diperkirakan Fortnight.D. Cirinya
adalah browser IE Anda
mendapatkan 4 ikon baru yaitu
Antivirus, Entertaintment, Security,
dan Search. Fortnight
memanfaatkan celah keamanan
Microsoft Virtual Machine ActiveX
Component yang sebenarnya sejak
Oktober 2000 sudah tersedia patch-
nya, tapi seperti biasanya pengguna
tidak ada yang melakukan patch
pada program IE nya sehingga
setiap kali menerima e-mail yang
mengandung Fortnight, kode virus
akan berjalan secara otomatis tanpa
perlu klik pada pesan e-mail
tersebut.

BENCANA SETELAH
CODERED

Pada tanggal 30 Juli 2003 RPC
Dcom vulnerability sudah tersedia
patchnya dan PT. Vaksincom sudah
mengeluarkan peringatan akan
pentingnya patch ini, tetapi “seperti
biasa”, pengguna komputer belum
merasa perlu melakukan update
security patch. Tanggal 13 Agustus
2003 celah keamanan RPC Dcom
yang sangat berpotensi

menimbulkan masalah ini berhasil
di eksploitasi oleh virus Blaster guna
menyebarkan dirinya.

Hebatnya, Blaster memiliki
ukuran yang sangat kecil, 6 KB
sehingga sangat cepat dan efektif
untuk disebarkan melalui Internet.
Varian Blaster yang berikutnya,
MSBlast.D atau Nachi melambatkan
koneksi Internet semua ISP di
Indonesia secara signifikan sehingga
selama berbulan-bulan dan bebe-
rapa ISP memutuskan untuk mem-
blok pengguna Internet yang tidak
melakukan update patch RPC Dcom.

MAILSERVER KERJA BAKTI
Setelah seminggu penuh

disibukkan oleh ulah Blaster, para
pengguna Internet tidak
mendapatkan kesempatan bernafas
lega, karena pada 18 Agustus 2003
telah muncul satu worm baru lagi.

Alfons Tanujaya
alfons@vaksin.com Badai Serangan V

di Tahun 2003

K
Business Software Alliance (BSA) sampai
dibuat repot harus mengumumkan
sanggahannya atas penyebaran virus yang
mendompleng otoritas BSA dalam
menangani pembajakan software.

Tambahan ikon pada menu browser menandakan bahwa komputer
Anda diinvasi oleh virus.
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Kalau Blaster menyebar melalui
jaringan antarkomputer dengan
sasaran utama sistem operasi
Windows 2000 dan XP
(Windows NT dan 2003
tidak terlalu “diincar”
oleh Blaster), maka
Sobig.F menyebar
menggunakan cara
lama, e-mail. Hal ini
mengingatkan pada
duet maut Nimda dan
CodeRed di tahun 2001.

Jangan lupa
dengan Mimail, yang
menyebar melalui SMTP
miliknya sendiri, dan
selalu membawa
sebuah file attach di
dalam sebuah file
MESSAGE.ZIP yang
bertujuan untuk
mengelabui blocking
executable yang banyak dilakukan
oleh mailserver korporat.

BULAN WORM 2003
Agustus - September 2003

dinobatkan sebagai bulan worm.
Para pengguna komputer panik. ISP

lumpuh. Mungkin ini adalah salah
satu berita terbesar yang pernah
dialami oleh para pengguna
komputer di tahun 2003. Dalam 1
minggu dari tanggal 12 Agustus
sampai dengan 19 Agustus 2003
seluruh jaringan internet dunia
hampir lumpuh total. Akses menjadi
sangat lambat karena virus-virus
worm yang mengganas. Adapun
virus-virus tersebut adalah, W32/
Blaster.A, W32/Nachi.A dan W32/
Sobig.F@mm. Blaster dan Nachi
menyerang para pengguna

komputer dengan
memanfaatkan celah
keamanan yang ada di
dalam Windows NT 4,
2000, XP,dan Win 2003.
Pertama-tama virus ini
akan memeriksa port
135 apakah dapat
ditembus atau tidak.
Dengan pengertian,
apakah para pemakai
komputer sudah
melakukan
penginstalan patch
yang telah
diberitahukan dan
diberikan oleh
Microsoft jauh-jauh
hari sebelum hal ini
tejadi. Kalau belum

dengan mudahnya virus ini masuk
ke dalam komputer yang belum di-
patch. Jika virus ini sudah masuk ke
dalam komputer Anda, maka ada
kejadian-kejadian yang tidak
menyenangkan akan Anda alami.
Ketika Anda sedang mengetik

sesuatu komputer Anda tiba-tiba
akan meminta untuk di-restart atau
me-restart dirinya sendiri. Cukup
menjengkelkan bukan. Kejadian ini
banyak sekali terjadi dan hampir
seluruh para pengguna komputer
dengan menggunakan sistem
operasi windows NT4, 2K, XP dan
2K3 dan terhubung dengan sebuah
jaringan Internet.

LEM TIKUS CAP GAJAH
Kalau ditanya, virus apa yang di

tahun 2003 mampu menjerat
komputer Anda seperti lem tikus,
jawabannya adalah Swen. Jika
komputer Anda terinfeksi oleh
Swen, Anda tidak akan mudah
membersihkannya karena setiap kali
Anda ingin menjalankan regedit
untuk membersihkan Swen, yang
Anda jalankan adalah Swen sendiri
karena ia mendaftarkan dirinya
sebagai semua file executable.

VIRUS PATAH HATI SESUDAH
LINONG

Virus lokal (asli Indonesia) yang
membuat pusing banyak pengguna
warnet adalah W32.Pesin, Virus
patah hati made in Indonesia. Virus
yang diklaim dibuat oleh seorang
programer dari daratan Sumatera
ini berhasil menginfeksi warnet-
warnet dan pengguna disket di
seluruh Indonesia dan sempat
memusingkan pengguna warnet
untuk waktu yang cukup lama, dari
bulan September sampai dengan
November 2003.

Jika Anda termasuk sering

Virus
3

menggunakan disket dan termasuk
pelanggan setia warnet atau sering
bertukar data dengan rekan
pengguna warnet, coba teliti
apakah disket Anda mengandung
salah satu dari file berikut ini: My
Love.exe; Kenangan.exe; Hallo.exe;
Puisi Cinta.exel; My Heart.exe;
Jangan Dibuka.exe; Mistery.exe. Bila
ya, artinya komputer Anda sudah
terinfeksi Pesin. Dan salah satu
kemampuan yang dimiliki oleh
Pesin adalah memblok akses ke
regisrty editor dengan

melumpuhkan keyboard dan mouse
Anda setiap kali membuka regedit.

VETERAN
Jangan lupakan juga Funlove,

Redlof dan JS/KAK@m yang
beberapa kali konsisten menduduki
peringkat 5 besar sebagai virus yang
paling banyak terdeteksi. Ketiga
virus ini memiliki kemampuan
duplikasi yang sangat tinggi dan
sangat bandel sehingga tidak dapat

Tanda dari virus
patah hati yang
tengah menginfeksi
komputer Anda.
Virus ini adalah
produksi lokal dan
sangat cepat
menyebar di
lingkungan warnet
di kota-kota besar
di Indonesia.

dengan mudah dibersihkan dari
komputer, khususnya komputer
yang terhubung ke jaringan.
Walaupun Anda sudah memfor-
mat komputer yang terinfeksi,
sekali Anda menghubungkan
kembali komputer ke jaringan,
dalam waktu singkat komputer
Anda akan kembali terinfeksi.

Apa yang harus Anda
lakukan adalah melakukan
update atas celah keamanan yang
tepat. Dan jika Anda merasa hal
ini terlalu berat karena setiap hari

selalu ditemukan celah keamanan
baru untuk semua software,
pertimbangkan untuk menggu-
nakan software pendeteksi celah
keamanan seperti Retina dari
Eeye atau outsource masalah
antivirus Anda dan serahkan
kepada ahlinya. Kecuali Anda
merasa beban pekerjaan Anda
masih kurang dan Anda siap
untuk menghadapi semua
serangan virus sendirian. PC+

Tanda bahwa komputer Anda telah terserang virus Pesin. Pesin
mengeblok akses ke regisrty editor dengan melumpuhkan keyboard
dan mouse Anda setiap kali membuka regedit.



Celah pada Yahoo Messenger. Yahoo
Messenger merupakan salah satu aplikasi instant messaging paling
populer di dunia – di samping MSN Messenger (Microsoft) dan AOL
Instant Messenger (America Online) – yang memungkinkan user
saling berkomunikasi langsung dengan pesan teks melalui Internet.
Melalui aplikasi tersebut, user juga bisa saling berkirim file dan link
halaman Web.

Para peneliti keamanan telah memberi peringatan mengenai
celah yang ditemukan pada Yahoo Messenger. Tri Huynh, salah
seorang peneliti, telah menemukan kelemahan tersebut pada file
yang bernama “yauto.dll”, yaitu komponen ActiveX pada software
Yahoo Messenger sampai pada versi 5.6.0.1347. Lubang ini
memungkinkan para cracker untuk menjalankan kode-kode mereka
di komputer, menggunakan program instant messaging. Peringatan
tersebut disampaikan melalui e-mail, namun pihak Yahoo tak segera
menanggapinya.

ActiveX adalah sebuah teknologi Microsoft yang membantu para
developer untuk menciptakan bit-bit kode sebagai kontrol yang
memungkinkan program saling berbagi informasi pada komputer-
komputer yang terhubung dengan jaringan dan Internet. Cracker
bisa memicu terjadinya banjir data pada buffer di mesin yang menjalankan Yahoo Messenger dengan
mengirim sederet data berbentuk URL ke celah dalam file yauto.dll, meletakkan kode jahatnya pada
mesin dan menyebabkan beberapa aplikasi mengalami crash.

Untuk melakukan serangannya, cracker mengeset sebuah halaman Web, kemudian memikat para
pengguna Yahoo Messenger untuk mengunjungi halaman tersebut dengan menglik link yang
diberikan. Cracker mengincar celah pada kode-kode dasar program dan meng-overwrite sebagian
memori komputer, mengganti beberapa instruksi komputer dengan instruksi atau data yang lain.
Kelemahan ini dianggap memiliki tingkat kritis yang tinggi. Para peneliti telah melakukan tes pada
celah tersebut, dan dengan sukses berhasil mengeksploitasinya dengan men-download dan
menjalankan program Trojan horse. Mereka menganjurkan para pengguna Yahoo Messenger sampai
pada versi 5.6.0.1347 untuk membuang file yauto.dll dari hard drive komputernya. (raa)

Microsoft Membuka
Situs dengan Layanan
Blogging. Layanan blogging atau
Web logging ini dinamakan TheSpoke, dan
dibangun atas inisiatif dari Academic Devel-
oper Microsoft. Situs untuk layanan ini
(TheSpoke.net) dibangun oleh Earth9, sebuah
perusahaan layanan pemasaran yang berbasis
di Singapura.

Walaupun dilengkapi dengan komponen
blogging, TheSpoke bukan merupakan sebuah
situs blogging. TheSpoke tidak sama seperti
layanan blogging lainnya, tetapi lebih merupakan sebuah tool bagi Microsoft untuk mendapatkan
dukungan dari para pengembang software yang mungkin memiliki potensi sebagai pesaing Microsoft.

TheSpoke menyediakan tool bagi penggunanya untuk berkolaborasi, berdiskusi bahkan berdebat
mengenai teknologi-teknologi masa depan. Target penggunanya adalah orang-orang yang ingin
melakukan blog mengenai teknologi dan gaming. Saat ini TheSpoke sedang memasuki tahap tes dan
akan dilengkapi dengan beberapa fitur tambahan. (raa)

Para Spammer Selalu Bisa Mengantisipasi
Teknologi Antispam. Betapa pun tingginya sebuah teknologi antispam, spammer
ternyata masih bisa menghindarinya. Menurut Sue Larsen, vice president SurfControl, dalam waktu
enam bulan terakhir, spam berbasis HTML mulai menggantikan spam berbasis teks. Dan spam bisa jadi
hanyalah sebuah gambar yang diambil dari sebuah server.

Dalam melakukan serangannya, spammer memiliki beberapa teknik. Teknik pertama, disebut
“hidden agenda” atau agenda tersembunyi, dilakukan dengan menggabungkan teks ASCII dan HTML
untuk membuat kode-kodenya tak terbaca dan tak bisa dikenali. Teknik lain, disebut “treacherous
tracks” atau cara curang, memungkinkan spammer untuk meng-capture alamat e-mail korban, pada
saat ia menglik sebuah gambar yang melekat pada pesan teks.

Teknik yang sering dipakai adalah teknik “dodgy domain” atau domain samaran, spammer
mengarahkan user ke sebuah alamat Web palsu, link yang diberikan biasanya menggunakan nama
sebuah institusi, padahal alamat tersebut adalah samaran yang dibuat untuk mengecoh user. Alamat
yang sering disodorkan pada user adalah alamat situs e-commerce dan bank, termasuk Citibank dan
EBay.

Penerima e-mail yang tidak mengenali bahwa alamat tersebut adalah palsu mungkin saja menglik
link yang ada pada pesan. Link tersebut akan membawa user ke sebuah alamat palsu yang memintanya
memasukkan informasi-informasi pribadi dan keuangan, seperti nomor KTP atau rekening bank. Dari
situ, spammer bisa mencuri identitas user. (raa)

Indonesia Meraih Merit
Award. Gladhi Guarddin, Abadi
Kurniawan dan Fajar Muharisan dari Fakultas
Ilmu Komputer, Universitas Indonesia, meraih
Merit Award, pada kompetisi software APICTA
2003 di Bangkok (6-8 Desember 2003). Software
“pengontrol peralatan elektronik rumah dari
jarak jauh” tersebut merupakan salah satu dari
21 software Indonesia yang diusung ke APICTA
2003. Terdapat 127 software yang dilombakan
kali ini dari sepuluh negara Asia Pasifik. Dari 14
kategori software, Malaysia berhasil
mengantongi 5 Winner Award, Hongkong 4,
Vietnam 3, Macau 1, dan Thailand 1. (jull)

Motion Lakukan
Upgrade
Prosesor untuk
M1300 Tablet PC.
Dalam rilisnya, Motion Computing
menyampaikan bahwa mereka telah
meng-upgrade prosesor untuk
meningkatkan performa Tablet PC-nya.
Sebagai tambahan, M1300 Tablet PC
dilengkapi dengan prosesor Intel
Ultra Low Voltage Mobile
Celeron 800MHz, DDR
SDRAM 256MB, sebuah
hard drive 20GB, layar
display seluas 12,1 inchi,
dan chip Intel Pro/Wireless 2100 untuk konek ke jaringan 802.11b.
M1300 akan menggantikan M1200, Tablet PC orisinal keluaran
Motion yang yang mengusung prosesor Intel Ultra Low Voltage
Mobile Pentium III-M. (raa)

Sony Ciptakan Terobosan Baru
untuk Pasar Peralatan
Elektronik. Peralatan yang ditawarkan antara lain DVR
(Digital Video recorder), DVD Recorder dan konsol game PS2.
Perusahaan ini merasa akan lebih baik jika ketiga peralatan ini
diusung dalam satu produk saja. Karena itulah mereka
menciptakan PSX. Mesin PSX baru hadir di Jepang. Sony
membuatnya seperti konsol game PS2, hanya saja dilengkapi
dengan sebuah DVD recording drive, TV tuner, MPEG2 digital video
recording software, dan hard drive yang luas untuk merekam dan
menyimpan program TV serta file-file lainnya.

PSX juga dilengkapi dengan port Ethernet built-in untuk
mengakses jaringan rumah atau Internet. Alat ini memiliki 6 level
kualitas video yang berbeda untuk merekam. Dengan kemampuan
scan output yang telah ditingkatkan, PSX seharusnya dilengkapi
dengan DVD player yang lebih baik. Harganya berkisar antara
US$700 dan US$900, tergantung pada besar kapasitas hard drive
yang ditawarkan (160GB hingga 250GB). (raa)

VisualTxt, Teknologi Baru untuk
Text Messaging. Pengguna yang sering
menggunakan layanan mesaging pada ponsel mungkin akan
tertarik dengan layanan ini. VisualTxt merupakan teknologi baru
yang bisa mengonversi SMS (Short Message Service) ke dalam
pesan yang mengandung gambar atau animasi bersuara. Teknologi
ini dikembangkan oleh ConVisual, sebuah perusahaan Jerman,
dan telah siap untuk menarik perhatian pasar Asia yang sedang
tergila-gila dengan layanan messaging. Saat ini VisualTxt baru
beredar di Thailand dan Filipina.

Meskipun terintegrasi dengan semua ponsel GSM generasi
kedua, teknologi text messaging dianggap kurang menarik lagi,
apalagi sekarang mulai bermunculan layanan selular digital yang
baru. Text messaging merupakan bentuk komunikasi non realtime
yang relatif lebih cepat dan mudah, tetapi dianggap kurang funky
bila dibandingkan dengan e-mail yang ditunjang oleh berbagai
fitur seperti warna, suara, dan animasi. Ponsel-ponsel yang telah
dilengkapi dengan layar berwarna memang sudah menunjang fitur
MMS (Multimedia Messaging Service), fitur yang memungkinkan
user untuk berkirim pesan bergambar. Tetapi hal ini juga masih
dianggap kurang memuaskan banyak pengguna.

VisualTxt, yang merupakan layanan pertama yang bisa
mengonversi teks SMS biasa menjadi sebuah pesan multimedia,
menawarkan kemudahan bagi para penggunanya. Bagaimana cara
kerjanya? Pertama ketikkan SMS pada ponsel, tambahkan nomor
penerima dalam pesan tersebut. Jika kita ingin memilih animasi
atau grafik dari daftar, kita harus menambah dua huruf singkatan
dari nama karakter kartun yang ingin ditampilkan. Kita juga bisa
memilih message preview untuk melihat gambar dan memilih
mana yang kita sukai dari content dalam database. Jika kita tidak
memasukkan kode karakter kartun apa pun, komputer akan
menganalisa pesan kita dan mencari kata kunci yang sesuai untuk
memilih animasi atau grafik untuk pesan kita. Karakter kartun
yang disediakan antara lain Garfield, Kandy Kool, Nappy Nick, dan
Snufflebears.

Setelah selesai mengetik pesan, kita harus memutar sebuah
nomor premium – yang tentu saja tidak murah. Perusahaan ponsel
umumnya memasang harga tiga hingga lima kali lipat dari harga
layanan SMS biasa untuk layanan grafis saja (tanpa animasi dan
suara). Sedangkan untuk layanan dengan fitur lengkap, harganya
bisa empat hingga enam kali lipat dari layanan SMS biasa. Jadi,
misalkan kita harus merogoh kocek sebesar Rp 350,- untuk SMS
biasa, untuk layanan ini kita harus mengeluarkan biaya sebesar Rp
2.100,-. Tentunya untuk menikmati layanan ini, kita harus memiliki
handset yang mendukung MMS. Jika tidak, kita hanya akan
menerima gambar hitam putih biasa – tanpa animasi atau suara –
dan pesan SMS biasa. (raa)
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IIX-1 Terancam Tutup. Hal tersebut
disampaikan oleh Heru Nugroho, Sekjen APJII (Asosiasi
Penyelenggara Jasa Internet Indonesia), melalui e-mail-nya kepada
PCplus. IIX-1 (Indonesia Internet Xchange-1) merupakan cikal bakal
dari  pertumbuhan Internet di Indonesia. Latar belakang dari
masalah ini adalah adanya permintaan dari pemilik Gedung
Telkom (Jl. Gatot Subroto, Jakarta) supaya beberapa ISP yang
berlokasi di gedung itu tidak memperpanjang kontrak sewa
gedung dan segera pindah dari sana, padahal IIX-1 berlokasi di
salah satu ISP tersebut.

Beberapa ISP yang diminta untuk ‘angkat kaki’, kira-kira
terhubung dengan 8 NOC (Network Operation Center) dan 2
sambungan LC (Link Control). Wajar jika ISP yang NOC-nya terletak
di gedung tersebut menjadi resah karena memindahkan NOC
bukanlah suatu hal yang mudah untuk dilakukan, butuh banyak
waktu dan biaya yang mahal. Menurut Heru, fasilitas IIX juga
merupakan tanggung jawab APJII selaku wadah kumpulnya para
penyelenggara jasa Internet, apalagi karena IIX sudah menjadi
kebutuhan publik untuk ber-Internet.

APJII memang masih memiliki satu node IIX lagi, IIX-2, dan
sedang membangun IIX-3, tetapi letak IIX-2 tidak sestrategis letak
IIX-1 untuk bisa mengamankan peering antar trafik Internet
nasional, sedangkan IIX-3 masih membutuhkan proses yang
panjang untuk selesai. Sepertinya pihak gedung kurang memahami
pentingnya fungsi IIX, karena itu APJII masih mencoba untuk
berdialog dengan pihak pemilik gedung dan harus tetap
memikirkan alternatif solusi terbaik. (raa)

Masyarakat Indonesia Butuh
Transparansi Informasi. Setidaknya hal ini
yang ingin disampaikan oleh ICT Wacth melalui situsnya, http://
lapor.ictwatch.com. Situs ini dibuat sebagai sebuah sarana
berbagi informasi mengenai hal-hal yang berkaitan dengan
transparansi, KKN dan perlindungan hak konsumen yang berkaitan
dengan industri TI di
Indonesia.

Saat ini, situs tersebut
masih sedang dalam
percobaan, waktu rilisnya
sendiri masih belum bisa
dipastikan. Kita sudah bisa
mencoba mengirim
informasi via SMS atau e-
mail dan informasi akan
secara otomatis di-upload di
Web. Caranya mudah,
tinggal kirim info melalui
SMS ke nomor 0856 - 9 –
061606 atau e-mail ke lapor@ictwatch.com. Nomor SMS
tersebut nantinya akan diganti dengan 0855 - 88 - watch (92824),
tetapi untuk saat ini belum ada kepastian waktunya.

Situs ini di-develop oleh Anton Rahardja (CTO Telematics
Indonesia), Sindu Irawan (Network Engineer wan-tangerang.net)
dan Donny B.U. (Koordinator ICT Watch). Mereka bertiga ingin
membuat suatu saluran komunikasi untuk publik supaya bisa
menyampaikan informasi kepada pihak-pihak yang berkompeten
dan memang membutuhkan informasi tersebut, seperti contohnya
YLKI, Panwaslu, Cetro dan ICW.

 “Rencananya proyek ini akan dikembangkan sebagai proyek
opensource, jadi siapapun boleh ikut ngoprek dan
mengembangkannya untuk keperluan apapun dan untuk
siapapun”, begitu kata Donny. (raa)
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Microsoft Hanya akan Mendukung OS Windows
2000/XP ke Atas. Hal tersebut disampaikan oleh Tony Chen, President Director
Microsoft Indonesia, pada acara peluncuran Microsoft Office System 2003. Acara ini juga dihadiri
oleh Jason BT Lim (PT
Acer Indonesia), Oliver
Roll (Microsoft Asia
Pasific and Greater
China Region), dan Budi
Wahyu Jati (Intel
Indonesia Corp.).
Microsoft Office System
2003, seperti yang telah
dibahas pada plusFokus
edisi 155, memiliki dua
fitur baru yaitu
OneNote dan
InfoPath.

Spesifikasi hard-
ware minimum yang
bisa menunjang Office
System 2003 adalah PC
dengan prosesor Intel
Pentium 233MHz
(dianjurkan Pentium III),
RAM 128MB, ruang
harddisk 400MB, dan monitor beresolusi 800x600 ke atas. Office System 2003 bisa berjalan di atas
platform Windows 2000/XP ke atas, karena sekarang Microsoft hanya akan memberi support untuk OS
tersebut. “Bahkan Windows NT akan kami tinggalkan”, begitu kata Tony Chen.

Dalam acara tersebut Tony juga menyampaikan bahwa kemungkinan Microsoft akan meluncurkan
Office berbahasa Indonesia pada bulan Februari mendatang. Aplikasi-aplikasi yang terdapat pada
Office Indonesia memiliki konsep serta isi yang sama dengan Office System 2003. Belum ada pernyataan
resmi mengenai harga aplikasi Office Indonesia dari pihak Microsoft. (raa)

Mundurnya Toemin A. Masoem dari Tim Pakar TI
KPU merupakan Indikasi Kekurangsiapan SDM di
KPU. Hal tersebut disampaikan oleh ICT Watch dalam siaran persnya, tertanggal 4 Desember 2003.
ICT Watch juga menyampaikan pendapatnya mengenai perkembangan terkini dari implementasi
proyek Teknologi Informasi (TI) Pemilu 2004.

Sejak awal, ICT Watch telah menyampaikan adanya kejanggalan dalam pelaksanaan proses lelang
tender TI KPU, yang khususnya terdapat pada isi materi dokumen resmi petunjuk lelang tender TI
mereka keluarkan. Padahal, sebagai sebuah proyek yang berskala nasional, proyek TI Pemilu 2004
seharusnya dilaksanakan secara profesional dan transparan.

Menurut ICT Watch, ada tiga hal penting yang dapat menjadi tolok ukur profesionalitas
pelaksanaan proyek ini – kelengkapan data penunjang, koordinasi antarlini, dan kesiapan sumber daya
manusianya (SDM). Sedangkan pada saat berjalannya, proyek menjadi tersendat-sendat – dengan dalih
bahwa data alamat kecamatan tidak lengkap, Hal ini menunjukkan bahwa pemrakarsa mau pun
pelaksana proyek ini belum memiliki persiapan dan antisipasi yang cukup. Jika memang benar kondisi
di lapangan tidak sesuai dengan data yang ada, berarti ada ketidak-akuratan dalam kuantitas
pengadaan hardware dan software yang ditenderkan. Seharusnya, pihak KPU sebagai pemrakarsa
proyek dan  PT Integrasi Teknologi sebagai pelaksananya menyampaikan secara transparan mengenai
kenyataan tersebut kepada publik.

Mundurnya Prof. Dr. Toemin A. Masoem sebagai Ketua Tim Pakar TI KPU bisa dinilai sebagai salah
satu tanda kekurangsiapan SDM KPU untuk bekerja tuntas. Memang, Prof. Toemin memiliki hak pribadi
sepenuhnya untuk mundur, tetapi momennya dianggap kurang tepat, yaitu pada saat tim proyek
dikejar tenggat waktu penyelesaian proyek TI tersebut. Mundurnya Prof. Toemin berpengaruh pada
manajemen dan koordinasi antarlini, baik di internal KPU maupun dengan pihak di luar KPU. Yang
patut menjadi perhatian KPU saat ini adalah untuk segera menunjuk pengganti Prof. Toemin.
Sedangkan Prof. Toemin sendiri, sebagai salah satu tim pemrakarsa dan penyusun proyek ini, tidak
boleh melepaskan diri dari konsekuensi logis atas tingkat keberhasilan proyek TI ini nantinya.

Ada informasi simpang siur yang menyampaikan bahwa pihak PT Integrasi memperoleh diskon dari
Microsoft untuk lisensi software mereka. Kesimpangsiuran tersebut, Menurut ICT Watch, bisa
mengindikasikan  adanya kemungkinan telah terjadi ketidaktransparanan dalam proses lelang tender.
Seharusnya, setiap penawaran harga dari para peserta tender telah memperhitungkan detil komponen
biaya pengadaan produk. Agak janggal rasanya bila besar diskon yang diterima PT Integrasi baru
dikomentari oleh pihak-pihak tertentu pada saat proyek implementasi sedang berjalan.

ICT Watch juga menegaskan perlunya masyarakat mengetahui bagaimana transparansi dalam
software aplikasi penghitungan dan penyampaian data jumlah suara pemilih dalam Pemilu 2004, baik
software yang dipasang pada tiap komputer di tingkat kecamatan hingga pusat. Yang terjadi adalah,
software aplikasi tersebut tidak dimasukkan dalam salah satu modul yang ditenderkan KPU sejak awal
pelaksanaan tender. Masyarakat belum mengetahui siapa yang mengerjakan aplikasi tersebut,
bagaimana bentuk aplikasinya, bagaimana mekanisme penyampaian data, dan bagaimana proses
penghitungan datanya nanti.

Tentu saja pengadaan software aplikasi untuk Pemilu 2004 perlu disampaikan secara transparan
kepada masyarakat. Tujuannya agar masyarakat dapat melakukan audit atas isi dan program aplikasi
tersebut. Seharusnya Tim Pakar TI KPU mengerti bahwa kesahan jumlah suara pemilih yang akan
dikalkulasikan di pusat, sangat dipengaruhi oleh keakurasian aplikasi yang digunakan. (raa)

Philips Luncurkan Generasi Baru Nexperia MPEG-2
Codec untuk DVD Recorder. Awal bulan Desember ini, Philip meluncurkan
Nexperia PNX7200, sebuah chip tunggal MPEG-2 codec untuk aplikasi DVD recording, yang dibuat
dengan teknologi 0.12 mikron. Royal Philips Electronics telah meningkatkan fitur audio dan video
dalam PNX7200 – termasuk ketajaman gambar untuk menghadirkan pengalaman audio dan video yang
bisa dinikmati oleh para pelanggannya.

Philips juga meluncurkan desain generasi keempat dari Nexperia yang akan ditargetkan untuk
DVD+R/+RW. DVD Recorder diramalkan akan menarik banyak perhatian konsumen elektronik, dan
akan menggantikan pasar VCR (Video Cassette Recorder) di tahun 2004. (raa)

ALEX/PCplus

11 Desember 2003, Hotel Shangri-La, Peluncuran Oracle 10g dan
Grid Computing. “10g bisa berjalan di atas platform apa pun dengan
hardware yang telah ada, kecuali untuk server harus menggunakan
prosesor minimum Pentium III,” begitu kata Adi Rusli, Deputy
Managing Director Oracle Indonesia. Oracle berharap, hingga akhir ta-
hun 2005 nanti, 50 persen dari pelanggan 9i-nya akan beralih ke 10g.

ARE/PCplus
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Cakrawala Gintings
cakra@e-pcplus.com Bagaimana Sesungguhnya

Kamera Digital
Bekerja?

B

Kamera bisa
dikatakan sudah

menjadi peranti yang
jamak digunakan

dalam kehidupan kita
sehari-hari. Sudah

lumrah
mengabadikan

sesuatu momen yang
penting

menggunakan
kamera. Secara umum

kamera yang banyak
digunakan adalah

kamera yang
menggunakan film
sebagai salah satu

komponen utamanya.
Orang sering

menyebutnya kamera
analog atau

konvensional. Kamera
seperti ini memang

sudah lama
dikembangkan

sehingga dari sisi
harga, khususnya

untuk kelas value,
sudah bisa dikatakan

terjangkau.

elakangan,
seiring
berkem-
bangnya

teknologi digital, kamera digital
juga terus bermunculan, bahkan

diperkirakan dalam beberapa
tahun akan menggeser populasi
dan popularitas kamera analog.
Sejalan dengan teknologinya yang
belum selama kamera yang
menggunakan film, kamera
digital ini masih memiliki harga
yang relatif jauh lebih mahal
untuk kamera yang sekelas.
Seiring dengan perjalanan waktu
harga ini memang mulai
berkurang, meskipun masih belum
bisa dikatakan terjangkau bila
dibandingkan dengan yang
menggunakan film.

PERBEDAAN UTAMA
Perbedaan utama antara

kamera yang menggunakan film
dengan kamera digital adalah
pada “alat” yang berfungsi untuk
menangkap cahaya yang diterima.
Pada kamera yang menggunakan
film, film tersebutlah yang
menjadi alat penerima cahaya.
Pada kamera digital, alat
penerima cahaya yang digunakan
adalah suatu komponen yang

peka cahaya dan memiliki properti
kelistrikan yang berubah akibat
cahaya yang diterimanya tersebut.

Karena properti kelistrikannya
berubah sesuai dengan cahaya yang
diterima, intensitas cahaya yang
diterima bisa direpresentasikan.
Pada kamera digital, komponen
peka cahaya yang umum digunakan
adalah CCD (Charge Coupled
Device) dan CMOS (Complementary
Metal Oxide Semiconductor). Baik
CCD maupun CMOS ini sama-sama
akan menghasilkan elektron
sebanding dengan cahaya yang
diterimanya. Semakin tinggi
intensitas cahaya yang mengenai
mereka, semakin banyak pula
elektron yang tersedia. Banyaknya
elektron yang terjadi kemudian
akan dirubah menjadi data digital

oleh Analog to Digital
Converter untuk kemudian
pada akhirnya disimpan pada
tempat penyimpanan.

MENANGKAP GAMBAR
DAN WARNA

Baik CCD maupun CMOS ini
terdiri dari banyak bagian yang
berukuran kecil. Bagian-bagian ini
masing-masing peka cahaya dan
akan menghasilkan elektron sesuai
dengan intensitas cahaya yang dite-
rimanya. Cahaya yang diterima CCD
ataupun CMOS akan sesuai dengan
cahaya dari objek yang ditangkap.
Oleh karena itu, intensitas cahaya
yang diterima oleh masing-masing
bagian yang berukuran kecil itu
akan berbeda, sesuai dengan
cahaya dari objek tersebut. Hal ini
yang membuat objek tersebut bisa
ditangkap, ada kemiripan akan
halnya pixel pada monitor.

Dengan cara seperti di atas,
warna belum bisa ditangkap

dengan baik, baru intensitas
cahaya saja. Bila ingin warna
juga bisa ditangkap dengan
baik, salah satu cara yang bisa
dilakukan adalah dengan
menggunakan tiga buah CCD
ataupun CMOS.

Masing-masing CCD dan
CMOS bertanggung jawab untuk
menangkap intensitas dari
sebuah warna dasar. Warna
dasar dari warna cahaya adalah
merah, hijau, dan biru (populer
dengan istilah RGB). Cahaya
yang datang akan dibagi secara
merata pada ketiga CCD
ataupun CMOS tersebut.
Berhubung CCD ataupun CMOS
tersebut diberikan filter yang
hanya akan melewatkan salah
satu warna dasar saja, setiap
CCD ataupun CMOS hanya akan
menangkap sebuah warna dasar
saja. Informasi mengenai
intensitas dari masing-masing
ketiga warna dasar tersebut bisa
digunakan untuk menyusun
ulang warna sebenarnya dari
objek yang ditangkap.

Sayangnya cara seperti di
atas kurang praktis/ekonomis
untuk banyak hal. Cara yang
lebih praktis dan ekonomis
adalah dengan mengatur
menurut pola tertentu warna
dasar yang diterima masing-
masing bagian berukuran kecil
dari CCD ataupun CMOS.
Dengan teknik ini dimungkinkan
untuk memperkirakan warna
sebenarnya. PC+
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F.X. Bambang Irawan
fbi@e-pcplus.com Ponsel Garansi,

Black Market,
dan Grey Market

B

Ketika harus beli
ponsel (dan barang

elektronik umumnya),
sudah jamak bagi kita

di negeri ini untuk
bisa memilih antara

yang “ori” atau yang
“be’em”. Yang asli

atau yang “black
market” (BM). Barang

BM ini bisa lebih
murah ratusan ribu,
meski harus ditukar

dengan
ketidakjelasan

layanan purnajual.

arang BM
bisa lebih
murah karena
diimpor secara paralel

tanpa melalui prinsipal atau ATPM
(Agen Tunggal Pemegang Merek)
yang ditunjuk secara resmi. Mere-
ka ini tidak perlu lagi mengeluar-
kan dana untuk menyediakan
infrastruktur dagang seperti iklan
dan promosi. Apalagi, workshop
untuk teknisi guna layanan servis.

Padahal untuk bisa memasuk-
kan sebuah tipe ponsel, ATPM jauh
hari sebelumnya sudah harus
meminta dan harus mengantongi
TA (Type Approval) dari Ditjen
Postel. Mereka harus memberikan
jaminan akan layanan purnajual
dan keaslian suku cadang.

Namun, dewasa ini pembeli
barang BM makin dimanjakan
berkat “janji surga” para pedagang
yang menawarkan “garansi” yang
dibuktikan dengan keluarnya kartu
garansi. Bahkan juga mereka
melengkapinya dengan manual
untuk tiap jenis produknya.
Mengapa begitu? Ini disebabkan
oleh peraturan pemerintah yang
memperlonggar keran impor ponsel
dengan mensyaratkan penyediaan
garansi dan buku manual berbahasa
Indonesia bagi pembeli.

GARANSI DAN MANUAL
Menurut Ina Hutasoit,

Sekretaris Asosiasi Ponsel Seluruh
Indonesia (APSI) yang juga General
Manager Philips Indonesia, dalam
peraturan pemerintah inilah
terletak lobangnya, padahal
peraturan untuk memberi kartu
garansi dan manual itu sendiri
bagus. Namun, di sisi lain peraturan
ini membolehkan siapa saja
mengimpor barang, termasuk
ponsel, dengan mudah.

Maka jadilah sekarang ada
ponsel BM yang bergaransi dan
berbuku manual, sehingga
statusnya tak “segelap” dulu.
Mestinya golongan ini bisa disebut
ponsel GM alias “grey market”.
Menurut Ina ini makin
mengacaukan pasar. “Dulu kan
ponsel BM tidak bersurat garansi
sama sekali. Nah, sekarang
bagaimana? Mereka seolah-olah
merupakan agen resmi yang
memberi garansi, meski berupa
garansi toko saja,” ujarnya.

Karena tidak mempunyai hak
menggunakan logo dan trademark
maka semua logo dan trademark
yang dicantumkan dalam kartu
garansi dan manual tersebut bukan
merupakan logo yang serupa
dengan aslinya. Kalau berani
menggunakan logo asli, mereka
akan harus menghadapi tuntutan
hukum.

Padahal, mereka hampir pasti
tak memiliki dukungan teknis dan
servis yang memadai. Kalau ada
kerusakan, mereka hanya akan

menganibalnya
(mengganti part-nya)
dengan ponsel sejenis.
“Mungkin mereka sudah ngitung.
Ponsel yang rusak tidak bakal sam-
pai sepuluh persen. Jadi mereka ha-
nya menanggung risiko yang sepu-
luh persen tersebut, yang bisa diata-
si dengan dikanibal,” tambah Ina.

TRADING HOUSE
Lalu dari mana impor tersebut

berasal? Mengapa mereka bisa
impor produk tersebut? Bukannya
barang-barang yang diimpor juga
merupakan barang bikinan pabrik
yang sama?

Menurut Direktur Penjualan
dan Pemasaran Samsung Electronics
Indonesia, Lee Kang Hyun,
umumnya ponsel-ponsel tersebut
berasal dari prinsipal Singapura dan
Hongkong. “Mungkin pemegang
merek di Singapura yang
memandang Indonesia sebagai
bagian dari pasarnya sehingga
memasukkan produk ke sini,"
paparnya. Padahal, produk-produk

tersebut dibuat bukan untuk
pasar Indonesia, tidak melalui
proses TA, sehingga bisa terjadi
masalah saat dioperasikan
di sini.

Ponsel-ponsel BM dan GM
juga bisa datang dari Eropa.
Menurut Robby Dharmasetiawan,
ketua Asosiasi Ponsel Seluruh
Indonesia (APSI) yang juga
Managing Director PT Dian Graha
Elektrika (pemegang merek
Siemens Mobile), di Eropa
distribusi ponsel umumnya
dipaket oleh operator bersama
dengan kartu SIM-nya. Operator
ini membeli ponsel dalam jumlah
besar sehingga kalau tidak laku
mereka akan menjualnya ke
trading house yang banyak
bertebaran di benua ini. Nah,
trading house itulah yang
menyebarkan ponsel ini ke
negara-negara yang merupakan
pasar empuk. PC+
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Menjelajah Kota
Melalui Peta Virtual

Alex Pangestu
alex@e-pcplus.com

P

Peta yang dikenal
banyak orang berupa

buku atau selembar
kertas berukuran

besar. Untuk mencari
jalan atau daerah

tertentu, biasanya
nama jalan atau

daerah itu dicari di
daftar indeks lebih

dulu untuk
mengetahui

koordinatnya di peta.
Setelah koordinatnya

ditemukan, baru
mengacu ke peta

untuk mengetahui
lokasi jalan atau

daerah itu.

erkembangan
sistem
informasi
memungkinkan

pembuatan peta yang lebih
canggih. Contohnya, peta yang
interaktif yang dikemas dalam
bentuk CD serta peta yang di-
upload di sebuah Web site.
Yang akan dibahas di rubrik
plusSurfing adalah peta yang
dikemas di sebuah Web site
(sebut saja cybermap).

APA YANG BISA
DILAKUKAN?

Banyak fitur yang bisa
dibuat untuk mendukung
cybermap sehingga peta di
Internet ini tidak hanya
menampilkan peta saja.
Kalau demikian, apa
bedanya dengan peta biasa?

Fitur-fitur yang menggunakan
kelebihan Internet tentu saja
harus ada.

Interaksi adalah salah satu
fitur yang dapat disajikan.
Walaupun tidak seinteraktif jika
dikemas dalam CD, cybermap
tetap dapat berinteraksi dengan
penggunanya. Contoh interaksi
yang bisa terjadi adalah
pembesaran (zoom-in) dan
pengecilan (zoom-out)  peta.
Setelah tombol untuk
membesarkan peta ditekan,
peta akan menampilkan lokasi
yang dimaksud lebih detail.
Misalnya, dengan menampilkan
jalan-jalan tikus.

Contoh lain, yang
berhubungan dengan interaksi,
adalah navigasi dalam peta.

Layar monitor berukuran terbatas
untuk menampilkan peta seluruh
kota sekaligus. Untuk itu, ada
paling tidak 4 sampai 8 tombol
navigasi di peta. Tombol-tombol
itu berfungsi untuk bergerak di
dalam peta ke berbagai arah.

Tombol-
tombol
navigasi ini
dapat
melengkapi
fitur zoom-in
dan zoom-
out pada
cybermap.
Bahkan
navigasi bisa
lebih canggih
lagi dengan
menggunakan
drag.

Kerja
sama dengan
berbagai
perusahaan
bisa
menambah

kelengkapan peta. Contohnya,
dengan bekerja sama dengan
suatu bank, cybermap bisa
menampilkan lokasi ATM
maupun kantor cabang milik
bank tersebut. Tempat-tempat
vital seperti rumah sakit, kantor
polisi, dan kantor pos juga dapat
ditampilkan.

Lebih enak lagi, cybermap
bisa dibuat agar hanya
menampilkan informasi yang
diinginkan oleh penggunanya.
Dengan demikian, peta menjadi
tidak ribet dan mudah dilihat.
Bayangkan jika ikon ATM sebuah
bank bertumpuk dengan ikon
ATM bank lain, dan bertumpuk
lagi dengan ikon mal, rumah
sakit, kantor polisi, restoran dan
ikon-ikon lain.

Kelebihan Internet yang
paling utama adalah penyajian
informasi yang terkini. Web site
yang menyajikan cybermap bisa
pula menyajikan berita mengenai
keadaan suatu jalan. Radio
biasanya menyajikan informasi
seperti ini. Situs peta bisa
memperoleh informasi mengenai
keadaan suatu jalan atau daerah
dengan menyebar reporternya
atau berdasarkan laporan orang-
orang yang berada di lokasi, yang
menghubungi Web site melalui
telepon, pesan SMS, e-mail, dan
melalui Web site itu sendiri.

Adanya fitur untuk
mencetak juga bisa menjadi
penting. Setelah pengguna
cybermap mengetahui letak
suatu jalan atau daerah, ia dapat
mencetak peta itu dan
menggunakannya sebagai
penunjuk.

APA YANG TIDAK BISA
DILAKUKAN?

Peta yang dikemas di dalam
CD bisa dibuat lebih interaktif
daripada cybermap. Peta dalam
CD bisa didukung oleh animasi
serta suara yang memukau.
Bahkan, bisa saja peta itu tidak
hanya tersedia dalam bentuk dua
dimensi, melainkan dalam bentuk
tiga dimensi.

Kelemahan utama Internet,
apalagi di Indonesia, adalah
koneksi dengan kecepatan yang
terbatas, sehingga kelebihan-
kelebihan yang diperoleh dari
CD, agak sulit untuk diperoleh di
cybermap. Dengan koneksi
Internet, apalagi koneksi dial-up,
yang bandwidth-nya terbatas,
agak sulit menampilkan animasi
serta suara yang memukau.
Bayangkan saja berapa lama
waktu untuk men-download peta

tersebut sebelum ditampilkan di
browser.

Namun fitur-fitur ini
bukannya tidak mungkin.
Dengan teknologi Internet yang
terus berkembang, bisa saja Web
site menampilkan multimedia
dengan lancar, yang mendukung
cybermap yang lebih interaktif.

ADAKAH DI INDONESIA?
Jawabnya adalah ada. Coba

saja buka web site
Cybermap.co.id
(www.cybermap.co.id),
Supermaps (http://
www.geocities.com/
yogyacities/), Street Directory
(www.streetdirectory.com)
atau Kadin Surabaya
(www.kadinsurabaya.or.id/
infokota/peta.htm). Situs-situs
itu menawarkan cybermap
dengan fasilitas-fasilitas lain yang
sangat berguna.

Cybermap.co.id, misalnya,
menyajikan informasi terkini dari
keadaan jalan atau daerah yang
informasinya diperoleh dari
laporan orang yang
menghubungi Web site yang
menyajikan peta Jakarta ini
melalui telepon maupun Web
site. Selain itu, Cybermap.co.id
menyajikan lokasi-lokasi berbagai
fasilitas seperti ATM, rumah sakit,
museum, dan mal. Penyajiannya
tergantung dari apa yang dipilih
oleh pengunjungnya. Ini
membuat pengunjung benar-
benar hanya memperoleh apa
yang mereka inginkan.

Jika Cybermap.co.id
menampilkan informasi paling
lengkap, maka Supermaps
memiliki animasi yang bagus
untuk menampilkan peta. Web
site yang menampilkan peta

Yogyakarta ini menggunakan
efek zoom-in dan zoom-out
untuk menampilkan jalan,
gedung, atau tempat yang dicari
oleh pengunjungnya. Sesaat

setelah pengunjung memasuk-
kan nama jalan, gedung, atau
tempat yang dicari, Supermaps
akan melakukan scan. Setelah
yang dimaksud ditemukan, peta
akan bergerak ke lokasi yang
dimaksud dan melakukan zoom-
in ke jalan, gedung, atau tempat
itu. Supermaps terasa lebih
interaktif dibandingkan dengan
Cybermap.co.id karena navigasi
tidak hanya bisa dilakukan
dengan tombol, tapi juga
dengan drag.

Sedang Street Directory
merupakan situs yang berbasis
di Singapura dan menyediakan
peta kota-kota Singapura,
Jakarta, Kuala Lumpur, Bangkok,
dan Taiwan. Untuk kota Jakarta,
kita bisa mencari lokasi
berdasarkan nama jalan. Bahkan
kita bisa mencari letak gedung-
gedung penting atau properti
lain di sini.

AKSES MELALUI GADGET
Ponsel dengan GPRS bisa

digunakan untuk mengakses
situs yang sudah memiliki
protokol WAP. Misalnya, situs
Cybermap dapat diakses dari
http://wap.cbn.net.id. Jadi di
manapun seseorang berada, ia
bisa mengakses peta kota
Jakarta dari ponselnya. Posisi di
mana sekarang si pengakses
berada pun sebenarnya bisa
dilacak dari BTS mana yang dia
gunakan.

Gadget lain yang bisa
digunakan adalah PDA yang
didukung oleh GPS. Dengan
GPS, posisi seseorang bisa lebih
diketahui lebih tepat
dibandingkan dengan BTS. Peta
pun bisa ditampilkan lebih baik
di layar PDA daripada di layar

ponsel, karena biasanya resolusi
layar PDA lebih baik.

Mau jalan-jalan? Cari dulu
lokasi tempat yang dituju di
cyber map, cetak, lalu jalan. PC+

Cybermap.co.id (www.cybermap.co.id) menyediakan fasilitas yang
sangat lengkap untuk mendukung cyber map yang disediakan mereka.
Saat ini, Cybermap.co.id hanya menyediakan peta Jakarta.

Bentuk peta interaktif yang dimiliki oleh
Cybermap.co.id. Di sini berbagai macam fasilitas
yang ada di kota Jakarta bisa ditampilkan,
tergantung kepada pilihan penggunanya.

Supermaps yang menampilkan kota Yogyakarta memiliki animasi
yang bagus untuk sebuah cybermap. Fasilitas pencarian yang
disediakan mampu dengan cepat menemukan jalan, gedung, atau
daerah.
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Mengirimkan
Fax dari
Komputer
via
Internet

Y.J. Thurana
thurana@e-pcplus.com

K

Bahkan dengan
perkembangan dunia

Internet yang sudah
mampu

menghubungkan
komputer di seluruh
dunia, di mana tren

sudah bergeser ke
digital dan buku

hanya berupa
dokumen digital di

layar monitor, kertas
tidak pernah

menunjukkan tanda-
tanda akan pensiun

dari dunianya.

ita akan
mengalami
kesulitan untuk
mengirimkan kertas

lewat e-mail (walaupun bisa
dibantu dengan scanner), tetapi
untungnya hal tersebut tidak
terjadi pada fax. Fax akan
memungkinkan penggunannya
untuk mengirimkan dokumen
dari kertas dengan kecepatan
Internet.

Fax bukanlah barang baru
lagi, malahan bisa dibilang
termasuk angkatan yang sangat
tua. Teknologi fax sudah ada
dan dikembangkan lebih dari
100 tahun sebelum orang-orang
berpikir untuk menciptakan
Internet.

PUNYA FAX MODEM?
Jika Anda memiliki modem

dengan kemampuan
mengirimkan fax –-sebagian
besar modem analog yang
dijual di pasaran memiliki
kemampuan ini— maka yang
Anda butuhkan untuk
mengubah komputer Anda
menjadi mesin fax modern
(yang mampu mengirimkan
dokumen apa saja sebagai fax)
hanyalah sebuah software
untuk fax. Biasanya sebuah
program fax sederhana akan
disertakan pada CD installer jika
Anda membeli sebuah fax
modem.

Kekurangannya adalah:
karena menggunakan koneksi
telepon biasa, pengiriman fax
ke luar daerah akan di-charge

sebagai sambungan jarak jauh.
Begitu juga dengan pengiriman
fax ke luar negeri. Anda juga
tidak bisa menggunakan
Internet dan fax secara bersa-
maan karena keduanya bergan-
tung pada alat yang sama.
Untuk menerima fax, komputer
harus menyala dan saluran
telepon tidak sedang dipakai.

FaxWizard 2000, sebuah
program shareware untuk fax
seharga $49,95, adalah salah
satu pilihan yang populer. Ia
menginstal driver printer yang

akan “menipu” komputer Anda
sehingga sang komputer
menganggap bahwa modem
Anda adalah sebuah printer.
Dengan begini, untuk
mengirimkan sebuah dokumen
sebagai fax, yang harus dilakukan
adalah “mencetak” dokumen
tersebut menggunakan printer
palsu dengan nama Fax Driver
yang sebetulnya adalah modem.

Jendela FaxWizard akan
muncul. Klik tombol [Sender] dan
masukkan informasi pengirim.
Klik tombol [Recepient] dan
masukkan informasi penerima.
Setelah itu pilih
[Send Fax] dari
menu [Fax]. Selesai.

Program ini akan
meminta beberapa
informasi tambahan
seperti kode area
dan detail mengenai
konfigurasi modem
pada saat pertama
kali digunakan.

Selain fungsi
dasarnya yang cukup
gamblang, ada fitur-
fitur lain yang
ditawarkan. Misalnya
untuk mengkonfigurasi header
atau kepala surat dari setiap fax
yang dikirim, pilihlah
[Options]>[Preferences].

Jika yang diinginkan adalah
mengirim fax dari dokumen yang
tidak ada di komputer, misalnya
dari buku, Anda memerlukan

bantuan sebuah
scanner. Pilih menu
[File]>[Scan]. Maka
program akan
membuat sebuah
image dari scanner
Anda dan
mengirimkan image
tersebut.

Jika tidak
sedang digunakan, selalu set
program ini dalam mode
menerima sehingga setiap kali
ada fax yang masuk akan secara
otomatis di-save sebagai file di
komputer Anda. Caranya adalah
dengan memilih menu
[Fax]>[Receive Fax].

PILIHAN YANG LEBIH
MUDAH

Jika kebutuhan fax Anda
lebih sederhana, coba aplikasi
dengan nama Fax Machine.
Shareware seharga US$25 ini

memiliki tampilan yang sama
sekali tidak rumit. Pilihan
pengiriman fax adalah lewat
“pencetakan” palsu seperti pada
Fax Wizard atau lewat scanning
image. Jika scanner Anda
memiliki fasilitas Automatic
document feeder, program ini
akan mengirimkan semua
halaman dan membuat
multipage fax.

Klik tombol [Settings],
gunakan tampilan Scanner and
Fax untuk mengatur hardware
Anda. Pada tampilan General
Options, pilih cover page yang

diinginkan. Bisa juga cover page
tersebut dinon-aktifkan untuk
menghemat waktu transmisi.
Untuk mengatur tampilan cover
page, gunakan Cover page
editor. Program ini kompatibel
dengan format CPE untuk cover
page yang digunakan pada
Windows 95 tetapi tidak
mendukung format cover page
COV yang digunakan pada
Windows 2000 dan XP. Sedikit
ketinggalan jaman, ya?

Yang harus diperhatikan
pada program ini adalah format
penulisan nomor fax. Pastikan
Anda sudah membaca halaman
dokumentasi yang menjelaskan
format yang digunakan sebelum
mencoba mengirimkan fax.

Sedangkan untuk
penerimaan fax, pilihannya
adalah langsung dicetak begitu
diterima atau dilihat dulu pada
layar monitor.

LEBIH LENGKAP
Jika sekiranya Anda akan

membiarkan komputer Anda
menyala 24 jam sehari untuk
menerima fax yang kemungkinan
datang di malam hari, kenapa
tidak sekalian menjadikan

komputer Anda sebagai operator
telepon yang selalu siaga?
Lengkap dengan voicemailbox,
fax, dan caller ID sekaligus.

Aplikasi yang bisa dijadikan
pilihan untuk tugas yang cukup
berat tersebut adalah
CallAttendant Pro, sebuah
shareware seharga US$129,95. Ia
juga mendukung kombinasi dua
saluran telepon, fax, dan voice
message secara bersamaan.

Program berjalan tanpa
masalah dibawah Windows 95
dan 98 tetapi belum mendukung
Windows NT, 2000, ataupun Me.
Meskipun demikian bisa
digunakan Compatibility
Wizard bawaan Windows.
Hardware yang dibutuhkan
adalah sebuah voice modem yang
kompatibel dengan TAPI (Tele-
phony Application Program Inter-
face). Sebetulnya diperlukan dua
buah jika Anda ingin menangani
dua saluran telepon sekaligus.

Catatan:
• Voice modem sebetulnya

adalah modem biasa yang
memiliki kemampuan untuk
merekam suara yang muncul
di saluran telepon. Fitur ini
sudah dimiliki oleh hampir
semua modem mulai dari
kelas yang paling murah.

• Anda harus mengaktifkan
fitur caller ID dari Telkom jika
ingin menggunakan fasilitas
caller ID.

Secara umum program ini
akan menyortir seluruh pesan
yang masuk berdasarkan waktu
dan caller ID dan bertindak sesuai
perintah yang sudah ditetapkan.
Misalnya: semua telepon yang
masuk di antara jam 9 pagi
sampai dengan jam 5 sore akan
di-forward ke handphone Anda,
panggilan dengan caller ID dari
sahabat Anda yang ”bawel” dan
tidak henti-hentinya menelepon
dapat selalu dimasukkan ke voice
mail.

Program ini amat powerful
tetapi perlu perhatian khusus
pada saat pengaturan pertama.
Selalu lihat Help dan tutorialnya
untuk bantuan lebih lanjut.

TIDAK PUNYA FAX
MODEM?

Alternatifnya adalah
menggunakan layanan fax dari

Internet. Karena fax akan
diterima lewat e-mail atau Web,
komputer tidak harus selalu
bekerja 24 jam sehari. Tetapi
pengiriman fax akan dikenakan
biaya, walaupun tujuannya
hanya nomor dalam satu daerah
yang sama.

eFax Messenger Plus
adalah software yang bekerja
sama dengan layanan eFax
yang populer. Layanan ini akan
memberikan nomor telepon
lokal pribadi (bukan di daerah
Anda) di mana Anda bisa
menerima fax dan voice mail.
eFax akan mengirimkan semua
pesan yang masuk ke Mailbox
Anda. Buka attachment-nya dan
eFax Messenger Plus akan
terbuka dan menampilkan fax
yang Anda terima ataupun
memainkan file audionya.

Kabar baiknya, eFax akan
memberikan kesempatan  untuk
mengirimkan 2 fax dengan
gratis, setelah itu bayar. Jika
Anda mendaftar sebagai
anggota eFaxPlus, Anda akan
mendapatkan nomor telepon di
US atau UK dan bisa memilih
kota yang diinginkan. Selain itu
Anda boleh menggunakan
fasilitas untuk mengirimkan fax
dengan biaya 10 sen dolar per
halaman yang dikirim dan biaya
bulanan sebesar US$9,95.

Aplikasi ini menambahkan
menu Send pada banyak
program. Pilih As A Fax dari
menu tersebut untuk
mengirimkan dokumen sebagai
fax. Ketika jendela Document
Delivery muncul, tekan tombol
Advanced untuk mengatur
tampilan cover page. Ada lagi
tombol Annotate yang akan
memberikan kemampuan untuk
memberi tanda pada dokumen,
mencorat-coret, menambahkan
komentar berupa teks dan
bahkan suara pada dokumen
tersebut sebelum dikirim lewat
fax.

Jika sang penerima juga
memiliki software yang sama
pada komputernya, tekan saja
tab E-mail pada jendela
Document Delivery, dan
dokumen tersebut akan
dikirimkan sebagai e-mail
attachment dan bukan fax,
gratis. Anda tidak perlu menjadi
anggota eFax untuk bisa
menggunakan fungsi ini. PC+

Fax Machine: mengirim dengan “pencetakan”
palsu.

FaxWizard: menganggap modem sebagai
printer.

ISTIMEWA
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Billy
bill_computer2003@yahoo.com

Komputer yang sering
kita gunakan sehari-

hari banyak sekali
memberikan kode
error. Namun dari

sekian banyak kode
error yang

ditampilkan, tidak
sedikit yang dapat

diketahui
penyebabnya.

Beberapa di
antaranya adalah

sebagai berikut.

Code 1: “This device
is not configurate correctly”.

Hal ini dikarenakan driver
yang digunakan tidak cocok.
Coba update atau install ulang
driver untuk perangkat
tersebut. Cara lain, coba buang
device dari Device Manager.
Tetapi, dengan membuang
device berarti Anda men-
disable penggunaan device
tersebut.

Code 2: Jika kode
error ini muncul, artinya device
loader tidak bisa
membangunkan device yang
bersangkutan. Ada dua macam
pesan, tergantung dari device
apa yang gagal. Jika device
yang gagal adalah kelas Root

Bus DevLoader seperti ISAPNP,
PCI atau BIOS pesan yang
muncul adalah “Windows could
not load the driver for this
device because the computer is
reporting two (nama_device)”.
Coba update BIOS.

Jika device tersebut
bukanlah Root Bus DevLoader,
maka pesan yang ditampilkan
“The (nama_device) device
loader for this device could not
load the device driver”. Coba
update driver.

Code 3: “The driver
for this device may be bad, or
your system may be running low
on memory or order resources”.
Coba buang device dan jalankan
Add New Hardware.

Code 4:  “This device is
not working properly because
one of its drivers may be bad or
your registry may be bad”. File
*.inf untuk device ini tidak benar

atau registri rusak. Update driver
atau kembalikan registry ke
keadaan sebelumnya dengan
menjalankan scanreg.exe.

Code 5:  “The driver
for this device requested a

resource that windows does not
know how to handle”. Update-
lah driver anda.

Code 6: “Another
device is using resources this
device needs”. Ada konflik yang

terjadi karena salah satu
resource digunakan bersama
oleh dua buah device. Jalankan
Device Manager dan ubahlah
setting resource untuk device
tersebut dengan mengubah
automatic setting menjadi
manual. Atau bebaskan resource
dari device yang tidak
digunakan.

Code 7: “The drivers
for this device need to be
reinstalled”. Buang device dari
Device Manager dan jalankan
Add New Hardware.

Code 8: “This device is
not working properly because
windows cannot load the file

(nama_file) that loads the driver
for the device”. Kode ini
disebabkan device loader tidak
ada. Jalankan Windows Setup
menggunakan CD-ROM Windows
Anda.

“This device is not working

Kenali Kode Error
pada PC

Restart komputer Anda setelah mengubah setting atau
menginstal driver.
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properly because Windows
cannot find the file (nama_file)
that load the drivers for the
device”. Klik [Reinstall Device]
untuk meng-install ulang device.

“This device is not working
properly because the file
(nama_file) that load the drivers
for this device is bad. Device
failure : Try changing the driver
for this device. If that doesn’t
work see your hardware docu-
mentation”. Cobalah update
driver.

Code 9: “This device is
not working properly because the
BIOS in your computer is report-
ing the resources for the device
incorrectly”. Atau “This device is
not working properly because the
BIOS in the device is reporting
the resources for the device
incorrectly”. Cobalah update
BIOS untuk mengatasi kode ini.

Code 10: “This device
is either not present, not working
properly or does not have all the
drivers installed”. Atau “This
device cannot start”. Cobalah
update driver atau cek device,
apakah sudah terhubung dengan
benar, kabel-kabel dan card
sudah dipasang dengan benar.
Jika sudah yakin benar, buanglah
device dari Device Manager,
restart, lalu coba jalankan Add
New Hardware.

Code 11: “Windows
stopped responding while
attempting to start this device
and therefore will never attempt
to start this device again”. Coba
jalankan Automatic skip driver

agent dari System Information.
[Start] > [Program] > [Accesso-
ries] > [System Tools] > [System
Information] > [Tools] > [Auto-
matic skip driver agent].

Code 12: “This device
cannot find any free
(tipe_resource) resources to use”.
Cobalah bebaskan resource
seperti IRQ, DMA, I/O agar dapat
digunakan oleh device tersebut.

Code 13: “This device
is either not present, not working
properly, or does not have all the
drivers installed”. Buang device
dari Device Manager lalu
jalankan Add New Hardware.

Code 14: “This device
cannot work properly until you
restart your computer”. Restart
komputer Anda, maka device
yang baru di-install akan aktif.

Code 15: “This device
is causing a resource conflict”.
Bebaskan resource agar dapat
digunakan oleh device yang
konflik.

Code 16: “Windows
could not identify all the re-
sources this device uses”. Device
tidak terdeteksi secara penuh.
Pada Device Manager, klik tab
[Resource] untuk memasukkan
setting secara manual. Lihat
manual hardware Anda untuk ini.

Code 17: “The driver
information file (nama_file_.inf)
is telling this child device to use a

resource that the parent device
does not have or recognize”.
Buang device dari Device Man-
ager dan jalankan Add New
Hardware.

Code 18: “The driver
for this device need to be
reinstalled”. Instal ulang driver
atau buang device dari Device
Manager dan jalankan Add New
Hardware.

Code 19: “Your
registry may be bad”. Jalankan
Scanreg.exe untuk
mengembalikan kondisi registri
kepada keadaan yang
sebelumnya.

Code 20: “Windows
could not load one of the driver
for this device”. Update driver,
atau buang device dari Device
Manager dan Jalankan Add New
Hardware.

Code 21: “Windows
is removing this device”. Restart
komputer Anda.

Code 22: “This device
is disabled”. Enable device dari
Device Manager. “This device is
not started”. Pada tombol solusi
akan muncul tombol [Start
Device]. Klik tombol ini untuk
menjalankan device. “This device
is disabled. You can’t enable this
device because it has been
disabled by a windows driver”.
Coba buang device dan jalankan
Add New Hardware.

Code 23: “This
display adapter is functioning
correctly”. Masalah ada pada
display adapter utama. Perbaiki
device ini. “The loaders for this
device cannot load the required
drivers”. Coba cek setting primary
display adapter pada Display
Properties di Control Panel.
Buanglah primary dan secondary
display adapter dari Device
Manager lalu restart komputer.

Code 24: “This device
is either not present, not working
properly, or does not have all the
drivers installed. To have
windows detect whether this
device is present or not, click
Detect Hardware”. Jika device-
nya sudah plug and play coba
update driver.

Code 25: “Windows
is in the process of setting up this
device”. Coba restart komputer.
Biasanya problem ini terjadi pada
saat boot pertama dan kedua
setelah Windows Setup mengopi
semua file.

Code 26: “Windows
is in the process of setting up this
device”. Restart komputer. Jika
tidak membantu, buanglah
device dari Device Manager dan
jalankan Add New Hardware.

Code 27: “Windows
can’t specify the resources for this
device”. Buang device dari Device
Manager dan jalankan Add New
Hardware. Bebaskan resources

Yang Perlu
Diperhatikan

•  Interrupt Request (IRQ):
Permintaan interrupt. Interrupt merupakan layanan yang

menyela suatu proses lain yang sedang berlangsung.

•  Cara me-remove device melalui Device Manager:
Klik [Start] > [Setting] > [Control Panel] > [System] > [Device

Manager].
Pilih device yang akan dibuang yang terdapat tanda seru (!)

berwarna kuning atau tanda (X) berwarna merah. Biasanya device
inilah yang mengalami gangguan atau tidak terpakai. Klik [Re-
move] > [OK]. Setelah me-remove device itu cobalah untuk meng-
install lagi driver dari device yang Anda gunakan.

•  Cara meng-install driver:
Klik [Start] > [Setting] > [Control Panel] > [Add New Hard-

ware] > [New] > [No, I want to select the hardware form a list] >
[Next]. Pilih device yang ingin di-install lalu ikuti petunjuk yang
ada.

•  Cara update BIOS:
Update BIOS merupakan hal yang cukup berbahaya karena

dapat mengakibatkan chip BIOS Anda justru menjadi rusak. Berikut
ini adalah cara meng-update BIOS yang umum. (Beberapa
motherboard memiliki cara yang berbeda untuk meng-update
BIOS-nya).

Sebelum melakukan update BIOS, Anda disarankan untuk
men-download file BIOS terbaru beserta program flasher-nya
(Awdflash untuk Award BIOS, Amiflash untuk Ami BIOS) kedalam
disket yang telah diformat sistem.

Boot ulang dengan disket tadi lalu masuk BIOS dan catat
semua konfigurasinya sehingga Anda dapat mengembalikannya
seperti semula. Jika selesai melakukan boot dari disket, maka akan
tampil konfigurasi tanpa driver.

Jalankan program flasher. Kemudian masukkan file BIOS
image. Setelah itu akan muncul pertanyaan apakah Anda ingin
mem-back-up BIOS yang lama. Untuk pertanyaan ini disarankan
untuk menjawab “yes”. Jika telah selesai restart komputer Anda,
masuk ke BIOS dan load-lah BIOS Setup Default.

Jika update gagal dan tidak ada fitur BIOS cadangan pada
motherboard, Anda harus melepas chip BIOS dan membawa ke
toko yang bisa melakukan pengisian EEPROM. Jika telah selesai
pasang kembali BIOS tersebut ke mainboard Anda. (Ingat posisi
chip sebelum Anda melepasnya). PC+

yang tidak digunakan agar dapat
digunakan oleh device yang lain.

Code 28: “The drivers
for this device are not installed”.
Device tidak terpasang secara
komplit. Install ulang driver. Jika
tidak membantu coba buang
driver dari Device Manager dan
jalankan Add New Hardware.

Code 29: “This device
is disable because the BIOS for
the device did not give it any
resources”. Dapat disebabkan
oleh device yang tidak bekerja
dengan benar atau di-disable
oleh BIOS. Coba enable device
tersebut dari BIOS.

Code 30: “This device
is using an Interrupt Request
(IRQ) resource that is in use by
another device and cannot be
shared. You must change the
conflicting setting or remove the
real-mode driver causing the
conflict”. Kode ini berarti bahwa
IRQ tidak bisa dibagi (share).
Buang real-mode driver yang
menggunakan IRQ yang sama
dengan device ini. Real mode
driver dapat dijalankan pada
Config.sys atau Autoexec.bat.
Anda harus berhati-hati dan teliti
mengeset IRQ bila melakukannya
manual.

Code 31: (Pada
Windows 98) “This device is not
working properly because
(nama_device) is not working
properly”. Coba klik [Proper-
ties] untuk device tersebut.
Ikuti solusi yang diberikan. Jika
tidak bisa, buang dari Device
Manager dan jalankan Add
New Hardware.

Code 32: (Pada
Windows 98) “Windows cannot
install the drivers for this device
because it cannot access the
driver or network location that
has the setup files on it”. CD-
ROM instalasi tidak dapat
ditemukan untuk menginstal
driver. Restart komputer.

Code 33: (Pada
Windows 98) “This device isn’t
responding to its drive”.
Cobalah update driver. Jika
tidak berhasil, buang device
dari Device Manager dan
jalankan Add New Hardware.
(Lihat cara update driver).

Dengan mengetahui arti
kode-kode error tersebut di
atas, tentunya kita dapat
mengatasi masalah yang terjadi
pada komputer kita dengan
lebih mudah. PC+

Dengan me-remove hardware dan me-restart
komputer biasanya masalah dapat teratasi.

Masalah ini dapat diatasi hanya dengan
mengklik tombol enable.
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Mudah, Menambah dan
Menghapus Status

Yahoo! Messenger Status Manager

Mengubah Ukuran Gambar
dalam Satu Folder

PicSizer

STATUS DI YAHOO
MESSENGER berguna
untuk memberi informasi
mengenai apa yang sedang
kita lakukan, rasakan, atau
kegiatan lain. Yahoo
Messenger sendiri sudah
menyediakan berbagai status
yang dapat digunakan.
Namun demikian, status itu
bisa ditambah dengan teks
yang sesuai dengan

keinginan penggunanya.
Penambahan status baru
dapat dilakukan dengan mudah.
Akan tetapi, Yahoo Messenger
tidak dilengkapi dengan
fungsi untuk menghapus
status yang sudah pernah
dibuat.

Yahoo! Messenger Status
Manager dibuat untuk
me-manage status-status
yang dibuat sendiri oleh

pengguna Yahoo! Messenger.
Tidak hanya menambah, aplikasi
gratis ini dapat juga digunakan
untuk menghapus dan
mengganti urutan status.
Seperti halnya Yahoo
Messenger, status baru yang
dibuat bisa ditampilkan dengan
busy icon.

Agar hasilnya terlihat di
Yahoo Messenger, Yahoo!
Messenger Status Manager harus

ditutup dulu dengan mengklik
tombol [OK].

Yahoo! Messenger Status
Manager dapat di-download dari
www.heuristicresearch.com.

Alex Pangestu
alex@e-pcplus.com

UKURAN GAMBAR
SERING DIUBAH dari
ukuran aslinya untuk berbagai
keperluan. Salah satu
contohnya adalah pengiriman
gambar melalui e-mail. Ukuran
gambar harus kecil. Selain
bertujuan agar waktu meng-
attach gambar tidak lama, juga
bertujuan agar inbox e-mail si
penerima gambar tidak penuh.

Contoh lainnya adalah
pembuatan thumbnail yang
ingin ditempatkan di suatu
halaman website. Biasanya,
dalam membuat website galeri,
gambar yang dibuat ukuran
thumbnail sangat banyak. Satu
per satu gambar harus diubah
ukurannya dengan
menggunakan software
pengolah gambar seperti
Adobe Photoshop.

Daripada menggunakan
Adobe Photoshop untuk
mengubah ukuran gambar
yang sangat banyak, lebih baik

menggunakan software yang
khusus untuk mengubah ukuran
gambar seperti PicSizer. PicSizer
dapat mengubah ukuran gambar
yang ada di dalam sebuah folder
yang ditentukan oleh pengguna
PicSizer.

Untuk mengubah gambar,
PicSizer menyediakan 3 buah
pilihan. Pilihan-pilihan itu adalah
mengubah seluruh gambar
menjadi satu ukuran, mengubah
gambar yang ukurannya lebih
besar dari ukuran yang
ditentukan, dan mengubah
gambar yang ukurannya lebih
kecil dari ukuran yang
ditentukan.

PicSizer mendukung file
gambar berformat JPG, GIF, BMP,
PNG, TIF, dan TGA. Untuk output
berformat JPG dan PNG, PicSizer
menyediakan kontrol kualitas
yang bisa diatur. Skalanya adalah
0—100 untuk JPG dan 0—10
untuk PNG.

Selain mengubah ukuran,

PicSizer dapat digunakan untuk
memutar gambar. Sayangnya,
gambar yang diputar tidak dapat
dipilih. Jadi, seluruh gambar yang
terletak di dalam sebuah folder
diputar. Pemutaran yang dapat
dilakukan adalah flip horisontal,
flip vertikal, 90, 180, dan 270
derajat.

Penamaan file ditentukan
oleh pengguna PicSizer. Ada 4
buah jenis penamaan yang bisa
dipilih yaitu sama dengan
nama file asli, menambah teks
(bisa ditentukan oleh
pengguna PicSizer) di depan
nama file asli, menambah teks
di belakang nama file asli, dan
nama file baru.

Folder untuk menyimpan
output juga ditentukan oleh
pengguna PicSizer. Hati-hati
dalam memberikan folder
penyimpan output. Apabila
nama file output sama dengan
file asli dan folder yang dipilih
sama dengan folder tempat
file asli, maka file asli akan
hilang dan digantikan oleh file
baru. Hal ini tidak masalah jika
memang file asli sudah tidak
dibutuhkan.

PicSizer adalah shareware
tanpa masa percobaan. Akan
tetapi, jika belum diregister,
PicSizer akan memberikan
watermark alias cap pada
output. PicSizer dapat di-
download dari
www.axiomx.com dengan
ukuran 3.24MB.

Alex Pangestu
alex@e-pcplus.com

Ukuran file instalasinya adalah
782KB.
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Merampingkan
File HTML

HTML Optimizer

Perbandingan Dua File
atau Folder

WinMerge

Emoticon untuk E-mail
EmmoMail

UKURAN FILE
MENJADI amat penting
jika dihubungkan dengan
website. Ukuran file HTML serta
file-file pendukung lain seperti
gambar, animasi, bahkan suara,
mempengaruhi lama tidaknya
suatu halaman ditampilkan di
browser.

Ukuran file untuk gambar,
animasi, dan suara bisa

dikurangi dengan mengurangi
kualitas atau ukuran,
tergantung kebutuhan.
Sedangkan file HTML bisa
dikurangi dengan menghapus
teks atau tag-tag yang tidak
berguna. Software HTML
Optimizer bisa digunakan untuk
menganalisa sebuah file HTML
untuk penghapusan isi yang tidak
berguna.

Alex Pangestu
alex@e-pcplus.com

Penggunaan HTML
Optimizer ini sangat mudah.
Cuma perlu menentukan file
HTML asli dan file HTML output.
Setelah itu klik tombol [Go!].
Selesai sudah. PCplus mencoba
mengoptimalkan sebuah file
HTML berukuran 960B. Setelah
dioptimalkan menggunakan
HTML Optimizer, ukuran file
HTML itu berubah menjadi 864B.

Software yang dipaket
dalam bentuk ZIP berukuran
156KB ini, dapat di-download
dari http://meesoft.cjb.net
secara gratis.

DUA BUAH FILE
PEMROGRAMAN
kadang-kadang perlu
dibandingkan untuk
mengetahui di mana
perbedaannya. Perbedaan satu
karakter saja, bisa
menghasilkan output yang
berbeda. Daripada mencek per
karakter, mendingan
menggunakan software yang

bisa melakukan pembandingan
seperti WinMerge.

WinMerge tidak hanya dapat
membandingkan file-file berisi
pemrograman, tetapi juga file-
file teks lainnya. Namun tidak
semua file teks bisa dibuka
menggunakan WinMerge, ada
file-file tertentu yang tidak
kompatibel, apalagi file-file teks
yang berisi karakter yang tidak

dikenal oleh WinMerge.
Perbedaan antara dua

dokumen ditandai dengan
higlight berwarna kuning.
Sedangkan bagian yang sama
akan dibiarkan. Ini memudahkan
pengguna mengetahui letak
perbedaan.

Selain dapat digunakan
untuk membandingkan file teks,
WinMerge dapat digunakan

Alex Pangestu
alex@e-pcplus.com

untuk membandingkan isi dua
folder. Tapi perbandingan tidak
dilakukan dengan cara
membagi layar menjadi dua
secara vertikal, melainkan
dengan ikon-ikon tertentu.
Misalnya, ada ikon yang
menandakan bahwa file
tersebut hanya ada di folder A,
namun tidak ada di folder B.
Contoh lain adalah file tersebut
ada di folder A dan folder B.
Akan tetapi hanya nama file-
nya saja yang sama. Isinya
berbeda.

Ada pilihan [Recursive]
untuk perbandingan folder.
Pilihan ini berguna apabila sub-
folder di dalam folder juga
turut dibandingkan. Tentu saja
ini akan mengakibatkan proses
perbandingan lebih lama
daripada perbandingan yang
tidak mengaktifkan recursive.

WinMerge dapat diperoleh
dari http://
winmerge.sourceforge.net/.
File instalasi WinMerge
memiliki ukuran sebesar
1.85MB.

KITA SERING
MENJUMPAI email yang
di dalamnya terdapat gambar
yang menyerupai kepala
dengan ekspresi yang beragam,
yang lucu-lucu. Itulah yang
disebut dengan emoticon.

Bagaimana sebenarnya
emoticon ini disertakan di
dalam e-mail, sementara
Outlook maupun Outlook
Express tidak menyediakannya?
Jika Anda sering surfing di
Internet, mungkin Anda sering
diganggu oleh iklan-iklan pop-
up yang menawarkan
emoticon. Anda harus berhati-
hati, karena iklan tersebut

kebanyakan hanya
tipuan untuk
melakukan maksud
tersembunyi si
pemasang iklan.
Misalnya, memasang
spyware untuk
memantau kegiatan
kita berkomputer.
Akan lebih baik jika
Anda menggunakan
“yang sudah pasti-
pasti saja” seperti
EmmoMail yang dapat
diperoleh dari
www.maxplugs.com atau
www.download.com dengan
lisensi shareware.

Software ini membagi
koleksi emoticon-nya menjadi
beberapa kategori seperti
General, Action, Love, Sad,
Goodies, dan Japanese.

Rizki Kurniawan
rizki.kurniawan.132@students.itb.ac.id

Sebagian besar emoticon dapat
beranimasi, sebagian lainnya
tidak.

Emoticon-emoticon ini
dapat digunakan untuk
Microsoft Outlook 2000/2002/
XP dan Outlook Express 5.x/6.x.
Sedangkan sistem operasi yang
kompatibel dengan EmmoMail
minimal Windows 95.

Software ini menawarkan
lebih dari 500 emoticon. Nah,
kapan lagi kita mengirim e-mail
dengan menunjukkan emosi
kita sebenarnya. Jangan
berharap orang yang kita kirimi
email selalu dapat mengerti
secara langsung maksud dari isi
e-mail  kita. Selamat mencoba.
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Sistem Operasi
Menjadi Beku

Deep Freeze

Pencari File Ganda
yang Andal

CloneMaster

CLONEMASTER
MEMBERSIHKAN
harddisk dari file-file ganda
yang menghabiskan tempat.
Software ini mencari file ganda
yang sama ukuran dan nama
yang sama, serta file dengan
ukuran nol alias file kosong.

CloneMaster juga
menyediakan [Smart Delete],

[Rename], [Save as], dan
berbagai fungsi lain. Software
yang bisa di-download dari
www.softbytelabs.com ini
mengidentifikasi file-file
berdasarkan nama, ukuran,
data dan lainnya. Ada juga

SETIAP PEMILIK PC
pasti akan selalu menjaga
kesehatan PC-nya, baik dari
segi hardware maupun
software. Hal itu tidak mudah
kalau PC-nya digunakan oleh
banyak orang alias PC umum.
PC anda menjadi sering hang
yang mungkin disebabkan oleh
penginstalan berbagai soft-
ware, pengutak-atikan registry,
hadirnya virus di dalam sistem,
dan yang paling parah ialah
penghapusan data penting.

Semua itu tidak perlu
dikhawatirkan apabila sudah
Deep Freeze sudah diinstal.

Shareware ini dapat
mengembalikan konfigurasi
Windows dan data yang disimpan
ke kondisi yang sudah ditentukan
setiap kali PC di-restart.

Sekilas fungsi Deep Freeze
serupa dengan fungsi recovery
milik Windows. Akan tetapi,
Deep Freeze hanya membekukan
data di dalam harddisk dan
kemudian mengembalikannya ke
kondisi semula setiap PC di-
restart. Selama data dibekukan,
PC dapat digunakan seperti biasa.
Penulis menyarankan agar
harddisk dipartisi untuk
menyimpan data yang baru

dibuat agar tidak hilang ketika
di-restart.

Cara pengguna Deep Freeze
dijelaskan di poin-poin yang
disebutkan di bawah.
a. Pertama kali Deep Freeze

diinstal, Deep Freeze akan
meminta partisi yang akan di-
freeze. Penulis menyarankan
agar partisi yang berisi sistem
operasi saja yang di-freeze,
sedangkan yang lain di-thaw.
Artinya, hanya partisi berisi
sistem operasi saja yang tidak
berubah, partisi lain tetap
bisa digunakan untuk
menyimpan data.

b. Setelah restart anda diminta
untuk membuat password,
lalu memilih option:

1. [Boot Frozen], PC di-
freeze setiap kali PC
dinyalakan,

2. [Boot Thawedon next x

restart],  PC akan di-
thawed hingga beberapa
kali restart, setelah itu
akan di-freeze lagi, dan

3. [Boot Thawed], PC akan
di-thawed setiap kali
dinyalakan.

c. Untuk masuk ke menu login,
anda bisa menggunakan
[Ctrl]+[Alt]+[Shift]+[F6] atau
bisa juga dengan menahan
[Shift] lalu mengklik ikon

Pudyatmoko
selo_oe@plasa.com

Deep Freeze sebanyak dua
kali di system tray.

Shareware ini bisa
didapatkan di
www.deepfreezeusa.com.
Deep Freeze bisa dinikmati
gratis selama 2 bulan. Selamat
mencoba.

fasilitas keamanan yang tidak
mencari di direktori Windows.

Tampilan utama CloneMaster
tampak pada Gambar 1. Di sini
drive dan path yang akan dicari
CloneMaster dipilih. Ada 3 cara
untuk melakukan pencarian file.
Pertama adalah menampilkan
semua file duplikat. Maksudnya
adalah menampilkan semua file

dengan isi yang sama, tapi tidak
selalu mempunyai nama yang
sama. Kedua adalah
menampilkan semua file yang
memiliki nama yang sama. Ini
tidak berarti mereka memiliki
data yang sama. Jika file tersebut

memiliki data yang sama, maka
akan ditandai pada daftar. Cara
yang ketiga adalah menampilkan
semua file yang memiliki ukuran
nol. File-file ini tidak berisi data
sama sekali.

Contoh daftar file duplikat
ditampilkan seperti Gambar 2.
Jendela ini menampilkan
kategori file duplikat
berdasarkan ukuran, dimulai dari
yang paling kecil ke yang paling
besar. Anda dapat memberi
tanda berbentuk api pada file
yang ingin dihapus. Semua file
yang dihapus akan dimasukkan
dalam Recycle Bin sehingga
pembatalan masih bisa
dilakukan. Dengan opsi [Save
List As...] daftar file duplikat
dapat disimpan untuk keperluan
yang akan datang. Daftar
tersebut dapat diedit dengan
pengolah kata seperti Notepad,
Wordpad dan Microsoft Word,
yang dapat membaca file teks.

Fasilitas Smart Delete yang
tampak seperti pada Gambar 3,
menyediakan dua cara untuk
menghapus file yaitu:
1. Menyuruh Clone Master

untuk tidak memberi tanda
pada file yang terletak pada
folder yang tidak sedang
dibuka, dan

2. Menandai hanya file duplikat
yang paling lama atau yang
paling baru. Anda bisa
menggunakan opsi untuk
tidak memberi tanda file pada
direktori Windows.

Gambar 4 menampilkan
jendela Clone Master – Same
Name Files yang menampilkan
semua file yang memiliki nama
yang sama. Jika file tersebut
adalah file duplikat, maka akan
muncul ikon berupa kertas dobel

Andhi Irawan
andhiirawan@hotmail.com

di sampingnya. Sebaiknya jangan
menghapus file dari daftar ini.
Hal ini bisa berbahaya karena
data yang ditampilkan di sini
bukan data yang sama. Ini hanya

untuk proteksi saja.
Terakhir adalah Zero Length

Files yang memiliki tampilan
seperti Gambar 5. Jendela ini
menampilkan daftar file yang
sama sekali tidak berisi data. File-
file ini bisa dihapus semuanya
atau hanya yang terpilih. Jika ada
file yang tidak dapat dihapus,

Clone Master akan
memberikan informasi. Hal ini
mungkin disebabkan file
tersebut sedang digunakan
software yang belum

memasukkan data ke dalam
file tersebut. Hanya file yang
tidak sedang digunakan yang
dapat dihapus. Lagipula Anda
tidak akan kehilangan apapun
karena file tersebut kosong.

Gambar 1

Gambar 2

Gambar 3

Gambar 4

Gambar 5
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Ketika kita
memback-up data
atau menyalin isi sebuah CD
atau DVD, kita akan memberi-
kan label pada kepingan CD/
DVD tersebut maupun pada
kotaknya. Label ini biasanya
menerangkan isi dari CD yang
baru Anda burn. Jika Anda
membuat CD back-up maka la-
bel yang dibuat adalah isi data
CD tersebut, atau apabila CD
yang Anda buat adalah CD Au-
dio Anda akan menuliskan daf-
tar lagu yang terdapat pada CD.

Untuk lebih mudahnya,
biasanya kita menuliskan label
dengan menggunakan spidol
seadanya atau dengan stiker
yang ditempelkan pada

kepingan CD/DVD. Walaupun
sudah diberi label, apabila Anda
memiliki banyak CD semacam ini,
dengan pemberian “tanda”
dengan coretan tangan, Anda
akan mengalami kesulitan dalam
mencari disc yang Anda inginkan.

Bagi Anda yang memiliki
sedikit kreativitas dan ingin agar
koleksi CD dan DVD-nya tampak
lebih “indah” dan unik,
manfaatkan fitur pembuatan
label CD/DVD yang sudah
tersedia di Publisher 2003. Ini
adalah cara pembuatannya:
1. Klik [Start]>[All Programs]>

[Microsoft Office]>[Microsoft
Office Publisher 2003] untuk
membuka program Publisher
2003.

2. Setelah aplikasi ini terbuka,
klik [Publications for Print]
yang terdapat di Task Pane.

3. Pilih sub menu [Label]>[CD/
DVD Labels].

4. Begitu Anda mengklik CD/
DVD Labels, dibagian kanan
window akan muncul
beberapa template yang
sudah disediakan untuk label
disc. Pilih salah satu template
yang Anda sukai.

5. Ubah Performer’s Name
dengan nama yang Anda
inginkan, misalnya dengan
nama pemeran atau penyanyi
CD/DVD Anda.

6. Isikan judul, pada CD/DVD
Title.

7. Jika label yang Anda buat

adalah untuk CD Audio, Anda
bisa menambahkan daftar

Membuat Label CD/DVD
dengan Publisher 2003

lagu pada tempat yang
sudah disediakan.

8. Ubah Organization dengan
logo yang Anda inginkan.

9. Klik [File]>[Print…] untuk
mencetak hasil kreasi Anda.

Steven Andy Pascal
steven@e-pcplus.com

Pada Microsoft
Word 2003 terdapat
sebuah fitur baru yang tidak
terdapat di versi-versi
sebelumnya. Fitur ini
memungkinkan Anda untuk
mengunci pemberian format
pada sebuah dokumen. Artinya,
jika Anda mengaktifkan fitur ini
pada dokumen milik Anda
maka siapapun tidak akan
dapat memberikan format baik
itu bold, italic, underline, atau
mengubah jenis dan ukuran
huruf jika tidak mengetahui
passwordnya.

Penguncian formatting ini
juga berlaku agar "pembaca"
tidak dapat menambahkan style
apapun pada dokumen serta
tidak dapat mengubah

warnanya. Demikian pula dengan
shortcut keyboard untuk
melakukan pemformatan seperti
tombol [Ctrl]+[b], [Ctrl]+[i] dan
sejenisnya juga ikut
dinonaktifkan.

Tertarik untuk
mengaplikasikan trik ini pada PC
Anda? Ikuti langkah-langkah di
bawah ini:
1. Buka Microsoft Word 2003

dengan mengklik [Start]>[All
Programs]>[Microsoft
Office]>[Microsoft Office
Word 2003].

2. Klik [File]>[Open], kemudian
buka dokumen yang ingin
Anda proteksi formatnya.

3. Setelah dokumen terbuka klik
[Tools]>[Protect Docu-
ment…].

4. Dibagian kanan window akan
muncul Task Pane Protect
Document. Tandai checkbox
di bagian Limit formatting
a selection of styles.
Dengan begini maka tidak
akan ada orang yang dapat
mengubah setting format di
dokumen Anda.

5. Untuk meng-apply perubahan
yang telah Anda lakukan klik
tombol [Yes, Start Enforcing
Protection].

6. Setelah Anda mengklik
tombol tersebut akan muncul
sebuah kotak dialog yang
akan meminta Anda untuk
memasukkan password.
Password tersebut nantinya
dapat digunakan untuk
menonaktifkan kembali

penguncian formatting.
Nah, sekarang dokumen

Anda telah aman dari tangan-
tangan jail yang merusak format

Mengunci Pemberian Format
di Dokumen Word

dokumen yang telah Anda buat.
Untuk mengaktifkan kembali
proteksi ini, klik
[Tools]>[Unprotect Document]
kemudian masukkan password
yang sudah Anda tentukan tadi.
Selamat mencoba.

Steven Andy Pascal
steven@e-pcplus.com

Mengakses Server FTP
dengan Word 2003

Jika Anda memiliki
situs Web atau terbiasa
mendownload file dari jagat
maya, Anda tentu tidak asing
lagi dengan istilah FTP. Sesuai
dengan namanya File Transfer
Protokol ini memang sering
digunakan untuk upload atau
download file di Internet.
Proses pengiriman atau
penerimaan file dengan
protokol FTP ini seringkali te-
rasa lebih kencang dibanding-
kan melalui HTTP, karena me-
mang untuk tujuan pengiriman
file-lah protokol ini dibuat.

Bagi Anda lebih sering
memanfaatkan koneksi FTP
untuk mengupdate situs, kini
Anda boleh bernafas lega karena
Microsoft Word terbaru sudah
mendukung akses server FTP
layaknya program FTP biasa.
Anda dapat membuka atau
menyimpan dokumen baik itu
dokumen standar Word maupun
file html dengan nyaman. Jadi,
sekarang Anda tidak memerlukan
software FTP tambahan untuk
memperbarui situs Web Anda.

Untuk melakukan
pengaksesan server FTP:

1. Buka program Microsoft
Office Word Anda.

2. Klik [File]>[Open…] untuk
membuka jendela Open.

3. Pilih [Add/Modify FTP
locations] yang terdapat di
menu drop down Look in:.

4. Sebuah window baru akan
muncul. Isikan alamat situs
FTPAnda pada bagian Name
of FTP site:

5. Jika koneksi server FTP Anda
merupakan server publik
Anda dapat memilih [Anony-
mous], namun apabila server
FTP Anda tersebut terbatas

untuk user tertentu pilih opsi
[User] pada bagian Log on
as: dan isikan User ID Anda
pada menu drop down
disebelah kanan.

6. Isikan juga passwordnya jika
koneksi ke server FTP Anda
membutuhkan password.

7. Apabila Anda ingin setting
alamat FTP, user name dan
password Anda disimpan, klik
tombol [Add].

8. Ulangi langkah 4 sampai 7

jika Anda memiliki lebih dari
satu server FTP.

9. Terakhir, klik [OK].
Mulai saat ini, apabila Anda
ingin mengakses file-file di
server FTP, Anda tinggal klik
[File]>[Open…] lalu arahkan
ke FTP Locations yang
Anda inginkan, maka secara
otomatis semua file-file
Anda tersebut dapat diakses.

Steven Andy Pascal
steven@e-pcplus.com
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Hal apa yang
tampak paling baru
dari Outlook 2003 selain fitur-
fiturnya? Ya Anda benar,
tampilannya. Tampilan pada
klien e-mail terbaru milik
Microsoft ini nampak berbeda
dibandingkan dengan versi
terdahulu. Dengan desain baru
yang lebih “enak” dibaca dan
daftar e-mail yang ditampilkan
lebih banyak.

Meskipun begitu, tidak
semua orang senang dengan
tampilan baru ini. Mungkin
karena Anda tidak terbiasa
dengan tampilan baru, Anda
jadi merasa tidak nyaman lagi
dalam ber-e-mail. Tetapi jika
Anda kembali ke versi lama

Wajah Outlook XP dengan
“Mesin” Outlook 2003

hanya karena tampilan, tentu
lebih banyak lagi kerugiannya.
Anda rugi karena tidak dapat
menggunakan fitur-fitur baru
Outlook dan rugi atas dana yang
Anda keluarkan untuk membeli
produk buatan Microsoft ini.

Solusi atas permasalahan
seperti ini dapat Anda pecahkan
dengan sedikit mengutak-atik
Outlook. Karena, sebenarnya
piranti lunak ini telah menyedia-
kan opsi untuk mengembalikan
tampilan Outlook 2003 sehingga
mirip seperti Outlook XP yang
memisahkan daftar e-mail dan
reading pane secara horisontal.
Berikut ini cara agar Outlook
2003 Anda memiliki wajah
Outlook XP:

1. Klik [Start]>[All
programs]>[Microsoft
Office]>[Microsoft Office
Outlook 2003].

2. Setelah aplikasi terbuka klik
[View]>[Reading
Pane]>[Bottom] untuk
memindahkan reading pane
ke bawah, sehingga layar
bagian kanan dibagi dua
secara horisontal.

3. Sekarang hilangkan
pengelompokan dengan
menonaktifkan menu Show
in Groups, caranya klik
[View]>[Arrange By]>[Show
in Groups].
Apabila Anda telah

melakukan langkah-langkah
diatas dengan benar, tidak

hanya lokasi reading pane saja
yang berubah, tapi
pengelompokan yang
memang tidak terdapat di

Outlook XP juga ikut
menghilang.

Steven Andy Pascal
steven@e-pcplus.com

Mempercepat Proses
Penyimpanan File

di Word
Pernahkah Anda
mempunyai atau membuat
sebuah dokumen yang isinya
mencapai ratusan atau bahkan
ribuan halaman? Jika Anda
memilikinya, coba Anda buka
dokumen tersebut. Kemudian
lakukan beberapa penambahan
dan perubahan pada bagian
dokumen. Setelah itu, klik
tombol [File]>[Save] untuk
menyimpannya. Perhatikan,
proses penyimpanan dilakukan
begitu lama. Apalagi jika file
tersebut diletakkan pada media
yang akses datanya lambat.

Sebenarnya Microsoft Word
telah menyediakan solusi untuk
mengatasi masalah lambatnya
proses penyimpanan file.
Kemampuan untuk menyimpan
cepat ini dapat Anda temukan di
menu Options. Untuk lebih
lengkapnya, ikuti cara berikut:
1. Jalankan Microsoft Word.
2. Pada aplikasi tersebut klik

menu [Tools]>[Options].
3. Akan muncul sebuah window

baru dengan nama Options.
Klik tab [Save] yang terdapat
pada jendela tersebut.

4. Berikan tanda centang pada

checkbox [Allow fast saves].
5. Klik [OK] untuk menyimpan pe-

rubahan yang telah dilakukan.
Untuk menguji efektivitas

dari perubahan tersebut, lakukan
hal yang sama dengan diatas.
Buka dokumen dengan jumlah
halaman banyak. Kemudian
lakukan perubahan pada doku-
men yang Anda buka tadi, dan
terakhir simpan dokumen terse-
but. Lihat, proses penyimpanan
menjadi lebih cepat bukan?

Steven Andy Pascal
steven@e-pcplus.com
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Membuat Efek Flip-Flop
dengan Microsoft Power Point

Ketika melakukan
presentasi biasanya kita
ingin menekankan pada point-
point tertentu, kata kunci
tertentu, atau pun angka-angka
tertentu. Ada banyak cara
untuk melakukannya, antara
lain: menunjuknya dengan laser
pointer, dengan memperbesar
ukuran huruf, atau memberi
warna mencolok. Ada satu cara
lagi yang lebih keren dan lebih
menarik perhatian orang, yaitu
dengan memberi efek flip-flop
atau tulisan yang berkedap-
kedip. Dengan sedikit trik, efek
ini bisa kita buat dengan
menggunakan Microsoft Power
Point. Caranya sebagai berikut:

1. Buka program Power Point.
Buat dan susun presentasi
Anda sesuai dengan selera.

2. Pilih point/kata/angka yang
ingin ditonjolkan. Pada tab

menu pilih [Slide Show] dan
pilih [Custom Animation].
Maka akan muncul jendela
[Custom Animation] pada sisi
kanan layar monitor.

3. Klik tombol [Add Effect] dan
pilih efek [Fade]. Apabila efek

Fade tidak muncul pada
jendela popup menu, pilih
[More Effects]  dan akan
muncul dialog Add Entrence
Effect seperti yang
ditunjukkan pada Gambar 1.

4. Sekarang kita atur tampilan
dengan memodifikasi
tampilannya. Klik panah kecil

yang ada diujung kanan
animasi yang akan kita atur
waktunya dan pada menu
drop down yang muncul
pilih Timing (Gambar 2).

5. Akan muncul jendela Fade
seperti terlihat pada Gambar
3. Pada dialog Start ada tiga
pilihan: On Click (animasi
dimulai setelah di-klik), With
Previous (sesaat setelah
presentasi dibuka), dan After
Previous (setelah beberapa
waktu yang ditentukan). Pilih
sesuka Anda. Pada dialog
Delay = 0. Atur kecepatan
kedip pada kotak dialog
Speed: very slow, slow,
medium, fast, very fast.
Pada dialog Repeate pilih
Until End of Slide.  Klik
[OK].

6. Nah efek sudah selesai,
sekarang kita cek dengan
menggunakan Slide Show.
Bagaimana, keren tidak?

Isroi
isroi@ipard.comGambar 1 Gambar 2 Gambar 3

Ketika membuat
presentasi tentunya kita
harus memperhatikan apa saja
content yang harus disediakan
pada presentasi tersebut. Selain
itu untuk memperjelas apa yang
akan kita sampaikan, kita harus
menambahkan beberapa media
tambahan. Media tersebut bisa
berupa suara, film, atau animasi.

Untuk memainkan musik
atau video saat presentasi Anda
bisa menyiapkan file yang akan
digunakan, kemudian
menjalankannya secara terpisah
ketika kita menyajikan
presentasi. Cara lain yang bisa
Anda lakukan, Anda bisa
menambahkan file video yang
akan digunakan kedalam slide

Memainkan File Video
Full Screen dalam Presentasi

presentasi. Di versi XP atau versi
sebelumnya, kelemahan justru
terletak disini. Video pada
PowerPoint versi lama hanya
dapat menampilkan video dalam
ukuran kecil.

Kini dengan munculnya
PowerPoint 2003 kegiatan
presentasi Anda dengan bantuan
video akan sedikit terbantu,
karena pada versi 2003 ini Anda
dapat memainkan film dalam
mode full screen ketika
menjalankan file presentasi. Ikuti
langkah-langkah PCplus berikut
ini dalam menambahkan video
full screen pada slide presentasi.
1. Jalankan Microsoft Office

PowerPoint 2003 dengan
cara mengklik [Start]>[All

Programs]>[Microsoft Office
PowerPoint 2003].

2. Klik [File]>[Open…] kemudian
buka file presentasi yang
ingin Anda tambahkan video.

3. Setelah file terbuka pilih slide di
mana video akan ditampilkan.

4. Klik [Insert]>[Movies and
Sounds]>[Movie from file…]
untuk memasukkan movie.

5. Tentukan file movie yang
Anda ingin gunakan,
kemudian klik [OK].

6. Obyek movie akan
ditambahkan pada slide. Klik
kanan obyek tersebut lalu
pilih [Edit Movie Object].

7. Berikan tanda centang pada
checkbox [Zoom to full
screen] yang terdapat di

bagian Display
Options.

8. Tandai juga
checkbox [Hide
while not pla-
ying], jika Anda
ingin agar obyek
movie tidak
muncul setelah
file tersebut
dimainkan.

9. Jika sudah, klik
[OK].

10. Tekan [F5] untuk
menguji perubahan yang
telah Anda lakukan.
Sekedar tambahan, player

yang digunakan oleh PowerPoint
saat memainkan file movie
adalah Windows Media Player.
Jadi kemampuannya untuk
membaca berbagai macam
format media sangat tergantung
pada player ini. Jika Anda
menggunakan Media Player
standar Windows XP, maka Anda
sudah dapat menggunakan

media dengan format ASX,
WMX, M3U, WVX, WAX, dan
WMA untuk digunakan dalam
presentasi Anda. Sedikit
kelebihan yang terdapat disini,
jika Anda mencoba membuka
media yang belum dikenali oleh
Media Player, secara otomatis
Power-Point 2003 akan men-
download codec yang sesuai.

Steven Andy Pascal
steven@e-pcplus.com
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Pengguna
komputer yang memiliki
banyak file gambar dalam
harddisk-nya biasa
menggunakan aplikasi khusus
yang mampu untuk
menampilkan banyak file
sekaligus mengelola file-file
gambar tersebut. Aplikasi yang
paling populer untuk urusan
yang satu ini adalah ACDSee.
Dengan bantuan software
buatan ACD Systems ini, file-file
gambar tidak hanya
ditampilkan, tetapi juga dapat
dikelola dengan baik.

Aplikasi yang mirip dengan
ACDSee, kini digabungkan
dengan paket Microsoft Office.
Memang, dari segi
kemampuannya belumlah
sehebat ACDSee 6, namun
paling tidak piranti lunak ini
cukup ringan dan simpel untuk
digunakan serta membaru
pekerjaan ringan. Didalamnya
juga disertakan kemampuan
untuk mengedit dan

Mengelola Gambar dengan
Microsoft Office Picture Manager

mengompres gambar.
Berikut langkah-langkah

untuk memanfaatkan aplikasi
yang termasuk baru di paket
Microsoft Office ini.
1. Jalankan Microsoft Office

Picture Manager dengan
mengklik [Start]>[All
Programs]>[Microsoft
Office]>[Microsoft Office
Tools]>[Microsoft Office
Picture Manager].

2. Jika Anda pertama kalinya
menjalankan aplikasi ini,
maka akan muncul kotak
dialog File Type. Dengan
memberi centang pada
checkbox jenis format gambar
dan kemudian Anda mengklik
[OK] pada kotak ini, secara
otomatis Windows akan
menjadikan Microsoft Office
Picture Manager sebagai
viewer default yang akan
selalu dijalankan jika Anda
membuka file yang format
file-nya diberi tanda check.

3. Lokasi folder standar ketika

Anda membuka program ini
akan berada di My Pictures.

4. Untuk menambahkan
shortcut gambar ke folder
yang sesuai dengan lokasi
Anda menyimpan file image,
klik [File]>[Locate Pic-
tures…].

5. Pilih drive dimana Anda
menyimpan file gambar,
kemudian klik [OK]. Program
akan melakukan pencarian
terhadap gambar-gambar
yang terdapat di dalam drive
tersebut. Proses pencarian ini
akan memakan waktu yang
cukup lama apabila jumlah
file yang terdapat di drive
tersebut sangat banyak.

6. Untuk melakukan pengeditan
gambar, pilih tombol [Edit
Pictures…] yang yang
terdapat di toolbar. Task
Pane akan muncul dan disana
terdapat pilihan untuk
mengatur Brightness and
Contrast, Color, Crop,
Rotate and Filp serta

kemampuan untuk
menghilangkan efek red eye.

7. Yang paling menarik adalah
fitur yang muncul jika Anda
mengklik [Picture]> [Com-
press Pictures…]. Dibagian
kanan window akan muncul
Task Pane yang memungkin-
kan pengoptimalan tingkat
kompresi. Di sana terdapat
beberapa opsi yang dapat

Anda pilih, yaitu kompresi
gambar untuk dokumen,
halaman web dan pesan e-
mail. Semakin tinggi tingkat
kompresi yang Anda pilih
maka semakin cepat juga
proses pemanggilan file.
Tapi ini bukan tidak ada
kelemahannya, jika Anda
memilih tingkat kompresi
tinggi maka kualitas gambar
juga ikut menurun. Setelah
menentukan pilihan tekan
[OK].

Steven Andy Pascal
steven@e-pcplus.com

Menggunakan Fungsi Bookmark
Pada Microsoft Word

Microsoft Word
diciptakan tidak hanya sebagai
pengganti mesin tik manual
yang dahulu sering kita
gunakan untuk membuat suatu
naskah. Ketika itu ketikan yang
diperlukan hanya dalam bentuk
tulisan di selembar kertas. Lebih
dari itu Microsoft Word juga
diciptakan untuk menghasilkan
data-data digital yang mudah
diakses, user friendly, dan yang
terakhir enak dipandang.

Salah satu fungsi yang
disediakan oleh Word untuk
kemudahan dalam mengakses
data adalah Bookmark.
Sebagian dari kita mungkin
masih belum mengetahui fungsi
dari submenu Bookmark yang
terdapat pada MS Word ini.

Bookmark sebenarnya
merupakan fasilitas yang
disediakan oleh MS Word untuk
mengidentifikasi /melacak letak
dari kata – kata atau bagian-
bagian tertentu yang Anda
seleksi dengan bookmark
tersebut. Bookmark hanya
dapat dipergunakan untuk
pelacakan di dalam satu
dokumen ketikan dan tidak
dapat digunakan antar
dokumen. Fasilitas ini terasa
kurang begitu berguna dan
bahkan tidak berguna jika
naskah yang Anda ketik tidak
begitu banyak, apalagi jika

hanya satu halaman dan hanya
diperlukan dalam bentuk output
cetakan. Tetapi, jika ketikan
Anda sudah mencapai ratusan
halaman dan terdiri dari
beberapa bab atau bagian serta
diperlukan dalam bentuk digital,
fasilitas ini akan sangat berguna
dan sangat efektif dalam
pengaksesan data untuk
kepentingan re-editing, re-
formatting atau hanya sekedar
membaca saja. Dengan begini
Anda tidak perlu lagi melakukan
scrolling pada dokumen Word
Anda untuk melakukan
pencarian tersebut.

Berikut ini akan dijelaskan
cara penggunaan dari fungsi
submenu bookmark. Tetapi agar
penjelasan ini efektif dan Anda
juga dapat memahaminya
dengan baik, Anda terlebih
dahulu harus memilki sebuah
naskah ketikan yang cukup
panjang dan akan lebih baik jika
ketikan tersebut memilki
beberapa bagian atau bab.
• Langkah pertama yang harus

Anda lakukan adalah
menentukan kata, bagian
atau bab mana yang akan
Anda beri bookmark,
misalkan saja Anda ingin
memberi bookmark pada
BAB V yang terletak di
halaman ke-100. Sorot
dengan mouse kata BAB V

pada halaman tersebut.
• Klik [Insert]>[Bookmark].

Selanjutnya akan mucul kotak
dialog Bookmark Ketikkan
nama bookmark yang Anda
inginkan. Pada textbox
Bookmark name:, samakan
saja antara nama bookmark
dengan kata yang diseleksi,
sehingga dapat memudahkan
kita. Dalam kasus ini nama
bookmark yang Anda isikan ke
dalam textbox Bookmark
name: adalah BAB_V. Yang
perlu diperhatikan disini yaitu
penamaan bookmark tidak
boleh menggunakan spasi. Jika
hal ini dilakukan maka tombol
[Add] pada kotak dialog book-
mark tidak akan aktif.
Sehingga pemisahan kata per
kata dalam penamaan book-
mark dilakukan dengan tanda _

• Klik tombol [Add]
Setelah Anda melakukan
langkah di atas kata BAB V
pada halam ke- 100 tersebut
akan menampilkan tanda
bookmark, sehingga menjadi
[ BAB V ]. Jika Anda tidak
menginginkan tanda ini,
Anda dapat
menghilangkannya melalui
[Tools]>[Option]>[Tab View],
kemudian hilangkan tanda
centang pada checkbox
[Bookmarks]. Untuk
memangil bookmark tersebut,
letakkan pointer mouse Anda
pada halaman 1 atau halaman
berapa saja selain halaman
100 pada naskah ketikan. Klik
[Insert]>[Bookmark]>[BAB
V]>[Go To]. Dengan seketika
kini dokumen Word Anda
berada kembali pada BAB V di
halaman ke-100. Bagi Anda
yang selalu ingin cara yang
praktis, proses pemanggilan
bookmark ini mungkin
kurang praktis, karena ada
empat item yang harus Anda
klik dengan mouse. Agar

pemanggilan bookmark ini
jauh lebih praktis Anda
dapat mengintegrasikan
fungsi ini dengan fungsi
Hyperlink. Caranya yaitu:

• Ketikan kata BAB V pada
halaman 1 naskah ketikan
Anda, setelah itu sorot kata
tersebut dengan mouse.

• Klik [Insert]>[Hyperlink]>
[Bookmark…], Kemudian
akan muncul kotak dialog
Select Place in Document,
selanjutnya klik BAB_V (jika
BAB_V tidak muncul, klik
[Bookmarks]).

• Klik [OK]>[OK].

Sekarang kata BAB V yang
Anda ketikan pada halaman 1
telah menjadi link menuju BAB
V pada halaman 100. Untuk
memanggil bookmark tersebut,
Anda kini cukup mengklik
mouse atau dengan kombinasi
[CTRL] sambil mengklik mouse
pada BAB V tersebut. Selamat
Mencoba.

Arif Perdana
mail_id_2001@yahoo.com

Gambar 1
Gambar 2
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Sering Anda
mengetik teks yang
banyak dan panjang dengan
menggunakan Microsoft Word,
dan Anda ingin selesai dengan
waktu yang cepat dan hasil
yang baik (tidak melakukan
banyak kesalahan).

Seringkali juga Anda
menjumpai banyak kata ulang
yang harus Anda ketik, untuk
mengetik kata ulang Anda harus
mengetik dua kali kata tersebut
dan menambahkan tanda strip ‘-‘
(misal makan-makan, kupu-
kupu, dan sebagainya) atau juga
kata ulang yang berubah bentuk
seperti (tersipu-sipu, bersama-
sama, terbahak-bahak, dan
sebagainya).

Kata ulang jenis kedua ini
yaitu kata awal dengan
imbuhan awal ter-,ber- (3 huruf
imbuhan awal) yang kemudian
diulang hanya kata dasarnya
saja. Mungkin tips ini dapat
membantu Anda dalam
menyelesaikan tugas Anda
dengan cepat, khususnya untuk
mengetik kata ulang. Masalah
ini dibantu dengan
memanfaatkan fasilitas Record
macro pada Microsoft Word.
Caranya sebagai berikut:

Untuk Kata Ulang Murni
(misal kupu-kupu, makan-
makan)
1. Ketik contoh kata yang akan

dibuat kata ulangnya,
dengan huruf pertama
kapital, misal Bapak.

Menulis Kata Ulang
dengan Cepat

2. Pilih menu [Tools], lalu pilih
[Macro] kemudian [Record
New Macro], lalu akan mun-
cul jendela Record Macro.

3. Pada jendela makro tersebut,
Anda dapat memberi nama
makro dengan mengisi pada
Macro Name dan
memberikan penjelasan atau
deskripsi makro yang Anda
buat dengan mengisi pada
Description, lalu ikon
[Keyboard].

4. Kemudian akan muncul
jendela Customize Key-
board, pada jendela tersebut
isikan tombol yang akan
menjadi shortcut dengan
menekan tombol tersebut
pada isian Press New
Shortcut Keys secara
bersamaan (misalnya [Alt]-[Y],
yaitu tekan [Alt] dan tombol
[Y] bersamaan pada key-
board). Kemudian tekan
[Assign], lalu tombol perintah
akan muncul di kotak
Current Key. Kemudian pilih
[Close].

5. Sekarang siap untuk merekam
makro untuk kata ulang,
tempatkan pointer berada
disebelah huruf k dari kata
Bapak, kemudian blok kata
Bapak tersebut dengan
menekan [Shift]+[Ctrl]+ [?]
(tanda panah sebelah kiri).
Lalu tekan [Ctrl]+[C] untuk
mengcopy kata tersebut,
kemudian tekan [?] (tanda
panah kanan),sekarang
pointer berada di sebelah

huruf k, kemudian
tambahkan tanda - (strip), lalu
tekan [Ctrl]+[V] (kata Bapak
telah ter-copy disebelah tanda
-). Sekarang untuk membuat
huruf ‘B’ pada kata Bapak
setelah tanda strip menjadi
huruf kecil. Posisi pointer
tepat sebelah kiri huruf B,
kemudian tekan
[Shift]+[Ctrl]+[?] (tanda
panah kanan), sekarang kata
Bapak setelah tanda strip
telah diblok, kemudian pilih
menu [Format], kemudian
pilih [Change Case]. Jendela
Change Case akan muncul,
lalu pilihlah lowercase
kemudian tekan [OK]
(sekarang huruf ‘B’ pada kata
bapak setelah kata strip telah
huruf kecil). Tekan [Ctrl]+[?] ,
lalu spasi (untuk
mengembalikan pointer
dibelakang kata ulang Bapak-
bapak dan memberi spasi
setelah kata Bapak-bapak).

6. Lalu tekan ikon [Stop] pada
ikon-ikon Record macro,
atau pilih menu
[Tools]>[Macro]>[Stop
Recording Macro].

7. Sekarang untuk membuat
kata ulang Anda tinggal
menegtikkan kata dasar
kemudian tekan Alt+Y, Anda
langsung mendapatkan kata
ulang murni dengan tanda
strip setelah kata awal.

Untuk Kata Ulang berubah
bentuk (tiga huruf awal hilang

pada saat diulang, misal
Bersama-sama, Tersipu-sipu)
Langkahnya yaitu langkah 1
sampai 4 sama seperti pada
saat membuat kata ulang
murni, untuk langkah 1 ketik
kata ulang berubah bentuk,
misal Tersipu. Pada langkah 4
untuk shortcut key dibedakan
dengan kata ulang murni,
misalkan dengan [Alt]+[ /]
atau yang lainnya.

5.   Sekarang siap untuk merekam
makro kata ulang berubah
bentuk, tempatkan pointer
berada disebelah huruf u dari
kata Tersipu, kemudian blok
kata Tersipu tersebut dengan
menekan [Shift]+[Ctrl]+[?]
(tanda panah sebelah kiri). Lalu
tekan [Ctrl]+[C] untuk meng-
copy kata tersebut, kemudian
tekan [?] (tanda panah kanan),
sekarang pointer berada di
sebelah huruf u, kemudian
tambahkan tanda - (strip), lalu
tekan [Ctrl]+[V] (kata Bapak
telah terkopi di sebelah tanda
‘-‘), rapihkan kata Tersipu yang
telah tercopy disebelah tanda
strip untuk mendekatkan ke
tanda strip (karena sebelumnya
terdapat spasi) dengan
menekan tombol [BackSpace]

(dengan pointer tepat
sebelah huruf T). Kemudian
blok 3 huruf pertama pada
kata Tersipu setelah tanda - ,
dengan menempatkan
pointer tepat pada huruf  ‘T’
pada kata Tersipu setelah
tanda ‘-‘ tersebut, kemudian
tekan [Shift]+[?] (sampai
huruf Ter diblok), lalu tekan
[Delete]. Sekarang kata
Tersipu telah setelah tanda ‘-‘
sudah berubah menjadi sipu.
Kemudian tekan [Ctrl]+[?] ,
lalu spasi (untuk mengem-
balikan pointer dibelakang
kata ulang Tersipu-sipu dan
memberi spasi setelah kata
Tersipu-sipu).

6. Lalu tekan ikon [Stop] pada
ikon-ikon Record macro, atau
pilih menu [Tools]> [Macro]>
[Stop Recording Macro].

7. Sekarang untuk membuat
kata ulang berubah bentuk
Anda tinggal mengetikkan
kata dasar kemudian tekan
[Alt]+[/], Anda langsung
mendapatkan kata ulang
berubah bentuk. Selamat
Mencoba.

Tommy Hendriansyah
ty_syah@yahoo.com

Naskah Dengan Format Penomoran
Halaman Yang Berbeda

Menulis naskah
panjang seperti makalah
atau bahkan sebuah buku su-
dah merupakan hal yang sering
dilakukan seiring semakin fami-
liarnya penggunaan komputer
untuk tugas sekolah, kampus
ataupun kantor. Untuk naskah
panjang tersebut, pemberian
nomor halaman menjadi hal
yang sangat penting.

Dengan MS Word,
umumnya pemberian nomor
halaman dapat dengan mudah
dengan fasilitas [Insert]>[Page
Number], maka naskah akan
memiliki nomor halaman secara
berurut dari halaman awal
hingga akhir (misalnya i, ii, iii
dan seterusnya atau 1,2,3 dan
seterusnya). Namun bagaimana
halnya dengan naskah yang
membutuhkan format halaman
yang berlainan? Misalnya
halaman-halaman awal dengan

format i, ii… dan seterusnya
kemudian halaman utama dengan
format 1, 2, 3… dan seterusnya.

Untuk ini perlu dimanfaatkan
fasilitas pemisah bagian (break
section) naskah. Caranya:

Naskah diketik seperti biasa,
kemudian disisipi nomor
halaman:
• Pilih menu [Insert]>[Page

numbers…].
• Atur posisi dan perataan

sesuai keinginan.
• Pilih Format number yang

diinginkan, misalnya i, ii, iii,…
(Gambar 1).

• Klik [OK] untuk keluar dari
Page number format dan
Page numbers.
Pada bagian awal naskah

utama (untuk penomoran 1, 2, 3
dan seterusnya):
• Pilih menu [Insert]>[Break].
• Klik pada [Next page] di

Section break types

(Gambar 2). Pada Status bar
(bar terbawah pada window
word) akan tampak sec 2)

• Kemudian pada halaman
tersebut dapat dilakukan
format penomoran halaman
dengan doubleklik pada area
nomor halaman.

• Akan nampak bar Header
and Footer pilih icon Format
Page number (Gambar 3).

• Pilih Number format 1,2,3,
… , isi Start at dengan 1, lalu
klik [OK].
Catatan kaki yang berbeda

untuk setiap section, dapat juga
dilakukan dengan cara ini.
Syaratnya, ikon Show as
preivious dinonaktifkan dengan
cara klik pada icon yang
dimaksud Gambar 4.

Selamat Mencoba!

Nasrul Ihsan
n.ihsan@myquran.com

Gambar 1

Gambar 2

Gambar 3

Gambar 4
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Sepanjang tahun 2003
ini perkembangan

hardware perangkat
komputer tergolong
cukup cepat. Ibarat

motor, tahun 2003 ini
adalah tahun “tancap

gas” buat beberapa
perangkat.

asalnya,
beberapa komponen
yang tahun sebelum-
nya sudah dimuncul-

kan mengalami booming di
pasaran dan semakin luas
dipakai. Tahun ini juga ditandai
dengan kemunculan beberapa
inovasi baru yang memperkaya
pilihan pengguna PC.
Paling menarik diperhatikan
adalah kemunculan sejumlah
chipset-chipset baru untuk
motherboard dan
perkembangan kecepatan
prosesor yang makin menggila.

Untuk motherboard, selain
fitur dual channel yang dipakai
pada hampir semua
motherboard, front side bus
yang didukung juga sudah
sampai 800MHz pada semua
produk berbasis Intel, dan
400MHz untuk yang berbasis
AMD, yang dirilis pada tahun

2003 ini. Ini tentu saja memang
disengaja oleh para pembuatnya
agar mampu mendukung
penggunaan prosesor yang sudah
menggunakan FSB secepat itu.

Juga menarik disimak di ta-
hun 2003 ini  adalah kecenderu-
ngan para produsen mother-
board yang sesuai dengan kan-
tong kebanyakan pembeli, meski
mereka sangat menggebu-gebu
mengeluarkan chipset kelas high
end dengan performa tinggi.

Memang semua produsen
mengeluarkan produk-produk
unggulannya yang menggunakan
chipset tercanggih dan punya
performa yang ciamik. Namun,
karena tuntutan pasar yang besar
untuk pasar kelas menengah dan
bawah, mereka juga tetap menge-
luarkan produk untuk dua kelas
ini. Untuk kelas ini, tetap muncul
produk integrated solution yang
mengusung begitu banyak fitur
onboard dan sebagian menggu-
nakan form factor micro ATX.

Hal ini cukup menarik
mengingat dengan sistem
semacam ini, dengan harga yang
relatif terjangkau, banyak fitur
terkini bisa didapatkan. Sebut
saja kartu grafis onboard yang
umumnya jadi suguhan utama
untuk kelas all in one ini. Belum
lagi fitur standar dan baru yang
sudah mulai terintegrasi di
motherboard. lainnya semisal
LAN onboard, kartu suara
onboard, hingga dukungan
terhadap serial ATA termasuk
sistem SATA RAID. Sepanjang
tahun 2003 ini, pembuat chipset-
chipset ternama semisal Intel, SiS,
nVidia juga menelurkan sejumlah
chipset yang memungkinkan
produsen motherboard membuat
produk model all in one ini.
Hanya VIA yang sepanjang tahun
ini tidak mengeluarkan chipset
baru untuk tipe integrated
solution ini.

Intel misalnya mengeluarkan
chipset i865GV dan i865G yang

mengusung pula fitur VGA
onboard dari kelas Intel Extreme
Graphics 2. Sementara, nVidia
mengeluarkan pula seri nForce 2
dengan controller VGA onboard-
nya yang sempat menghebohkan
jagad motherboard berbasis AMD
pada paruh pertama tahun 2003
ini dengan sistem dual channel
dan performa yang tinggi. Di lain
pihak, SiS yang belakangan
muncul kembali sebagai
produsen chipset motherboard,
mengusung pula jenis SiS 661FX
untuk yang berbasis Intel.
Terakhir, ATI yang baru muncul
belakangan  meramaikan pasaran
motherboard desktop juga
membuat produk yang sejenis. Tak
tanggung-tanggung, dengan ke-
ahlian dan pengalamannya mem-
buat chip kartu grafis, ATI menge-
luarkan chipset 9100IGP yang
mengusung pula ATI Radeon 9200
sebagai jago VGA onboard-nya.

Menariknya, meski chipset-
chipset di atas sudah mengusung

VGA onboard, para
produsennya juga tetap
memberikan opsi penggunaan
kartu grafis add on dengan
dihadirkannya port AGP 8X
pada seri motherboard yang
memanfaatkan chipset-chipset
ini. Adanya fitur semacam ini
sangat menguntungkan yang
memungkinkan penggunanya
mengganti dengan VGA add on
yang punya kualitas lebih baik.

Perkembangan lainnya
adalah sudah mulai maraknya
penggunaan Gigabit Ethernet
yang diintegrasikan pada sistem
motherboard. Meski fitur ini
umumnya baru diterapkan pada
motherboard kelas high end,
lambat tapi pasti, Gigabit Ether-
net yang memiliki kemampuan
transfer data sebesar 1GB/s ini
menggusur penggunaan Fast
Ethernet 10/100 MB/s untuk
kemungkinan sistem terhubung
dengan jaringan tanpa perlu
kartu tambahan apapun.

Dari sini bisa dilihat, tahun
2003 merupakan tahun yang
cukup menarik dari sisi
perkembangan hardware PC.
Selain makin berkembangnya
teknologi, fitur-fitur baru pun
semakin berkembang maupun
muncul ke permukaan sehingga
memungkinkan terus
berkembangnya sistem all in
one yang notabene murah-
meriah ini. PC+
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Pada edisi kali ini
PCplus mengajak

Anda untuk sedikit
melihat ke belakang,

tepatnya untuk
melihat komponen PC

yang diluncurkan
pada tahun 2003 yang

sebentar lagi akan
kita lewati ini.

da banyak
komponen
PC yang
diluncurkan pada

tahun 2003 ini, namun PCplus
memutuskan hanya akan
membahas mengenai prosesor,
chipset mainboard, dan chip
utama dari kartu grafis. Tidak
semua prosesor, chipset, dan
chip kartu grafis akan dibahas,
hanya yang menonjol saja,
baik dari segi komponennya
maupun dari segi produsen
yang meluncurkannya. Adapun
produsen yang masuk dalam
tulisan kali ini adalah Intel,
AMD, VIA, SiS, nVidia, dan ATI.
Prosesor akan diwakili oleh
Intel dan AMD, chipset
mainboard diwakili oleh Intel,
VIA, SiS, dan nVidia, sementara
chip utama dari kartu grafis akan
diwakili oleh nVidia, ATI dan SiS.

PROSESOR INTEL
Pada tahun 2003 ini Intel

telah mengeluarkan Pentium-4
terbarunya berupa Pentium-4
Northwood dengan FSB
200MHz dan Pentium-4 EE
(Extreme Edition). Pentium-4 EE
yang berharga sangat tinggi ini
bisa dikatakan sebagai prosesor
yang ditujukan untuk kalangan
khusus sehingga tidak akan
dibahas lebih lanjut.

Pentium-4 pertama kali
diperkenalkan oleh Intel pada
akhir 2000 dan hingga kini telah
mengalami beberapa
peningkatan. Pentium-4
Willamette yang merupakan

Cakrawala Gintings
cakra@e-pcplus.com

Pentium-4 generasi pertama
masih menggunakan proses
produksi sebesar 0,18 micron
dengan FSB (Front Side Bus)

sebesar 100MHz. Adapun L2
cache yang dimiliki adalah
sebesar 256kB.

Peningkatan pertama yang
dilakukan oleh Intel adalah
dengan menggunakan proses
produksi sebesar 0,13 micron
yang juga memungkinkan L2
cache yang digunakan menjadi
sebesar 512kB. Pentium-4 yang
menggunakan proses produksi
sebesar 0,13 micron ini diberi
nama Northwood. Peningkatan
berikutnya adalah pada FSB yang
digunakan menjadi 133MHz.
Setelah menaikkan FSB yang
digunakan, Intel kemudian
memutuskan untuk
mengaktifkan teknologi Hyper-
Threading pada Pentium-4-nya.

Pada tahun 2003 ini Intel
kembali meningkatkan FSB dari
Pentium-4-nya menjadi 200MHz.

Pentium-4 dengan FSB 200MHz
dan sering disebut dengan kode
C ini tersedia dengan kecepatan
2400MHz, 2600MHz, 2800MHz,

3000MHz, dan 3200MHz. Pada
tahun 2004 bisa saja Intel akan
mengeluarkan
Pentium-4
dengan FSB
200MHz yang
memiliki clock
speed yang lebih
tinggi lagi.

Dengan
menggunakan
FSB sebesar
200MHz,
bandwidth
teoritis maksimal
yang tersedia
antara prosesor
dengan
northbridge
menjadi sebesar
6400MB/s. Angka
sebesar ini
diperoleh sesuai

dengan 4 buah data 64 bit (8
Byte) yang bisa ditransfer untuk
setiap clock-nya. Dengan FSB
sebesar 200MHz, maksimal ada

sebanyak 200 juta
transfer terjadi setiap
detiknya. Oleh karena
itu besarnya band-
width menjadi 200M/s
x 8 Byte x 4 alias
sebesar 6400MB/s
tersebut.

Pada saat
diluncurkannya
Pentium-4 dengan FSB
200MHz tersebut, DDR-
SDRAM secara resmi baru
mencapai kecepatan
200MHz dengan lebar
data 64 bit. Karena
memori utama yang
digunakan memang
adalah DDR-SDRAM dan

bukan lagi RDRAM, Pentium-4
dengan FSB 200MHz ini hanya

bisa diimbangi dengan
menggunakan solusi dual kanal
DDR-SDRAM 64 bit dengan
clock sebesar 200MHz.

Mainboard yang mampu
menerima dengan baik
Pentium-4 dengan FSB 200MHz
ini pada mulanya adalah
mainboard yang menggunakan
chipset Intel yang memang
dirancang untuk itu.
Belakangan produsen chipset
lain juga telah mengeluarkan
chipset yang mampu menerima
dengan baik Pentium-4 dengan
FSB 200MHz tersebut.

PROSESOR AMD
Pesaing Intel di dunia

mikroprosesor ini di awal tahun
2003 me-release prosesor yang
sudah di-update teknologi
pembuatannya yaitu Athlon XP
seri Barton dengan FSB 166MHz.
Salah satu jenisnya adalah

Athlon XP 3000+ yang
clock frequency-nya
tercatat pada 2166MHz.
Dari sisi teknologi
untuk prosesor
desktop tersebut,
perbaikan yang
sudah dibuat oleh
AMD dibanding
seri
pendahulunya
adalah
penambahan
jumlah L2
cache dan
FSB
prosesor.

Mile-
stone perpindahan

dari proses teknologi 0,18 ke
proses teknologi 0,13 micron
sendiri sudah dilakukan sejak

Tahun ini Update dari Intel untuk
Prosesornya adalah FSB 800MHZ

Prosesor 64 bit dari AMD tidak terlihat seperti Athlon
XP ini karena telah menggunakan heat spreader
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pembuatan prosesor Athlon XP
dengan core Thoroughbred
dimulai. Saat Athlon XP dirilis
pada semester kedua tahun
2001, yaitu yang dikenal
dengan core Palomino, proses
teknologi 0,18 micron masih
digunakan untuk membuat
prosesor saat itu.

Untuk seri prosesor Athlon
XP generasi berikutnya yang
dikenal dengan kode Thorough-
bred (baik Thoroughbred A dan
Thoroughbred B), meskipun ada
perubahan proses pembuatan
dari 0,18 micron (Palomino) ke
0,13 micron, tetapi L2 cache-nya
masih tetap. Tidak ada yang
ditambahkan dari 256KB yang
sejak jaman Athlon Thunderbird
sudah disediakan.

Untuk perbaikan yang
dilakukan dari Thoroughbred A
ke Thoroughbred B sendiri,
AMD menambahkan jumlah
layer dalam pembuatan
prosesor tersebut. Dari sejumlah
8 layer yang digunakan pada
Thoroughbred A menjadi 9
layer pada Thoroughbred B.

Perpindahan teknologi
proses pembuatan yang lebih
dulu dilakukan sebenarnya
adalah sebagai persiapan AMD
ke pembuatan prosesor
Athlon XP dengan core
Barton. Di prosesor
dengan core Barton,
FSB prosesor Athlon XP
mulai dinaikkan
menjadi 166MHz.
Meskipun demikian,
pada saat-saat terakhir,
prosesor Athlon XP
Thorougbred versi B
yaitu Athlon XP 2800+
yang kecepatan aslinya
2166MHz juga sudah
menggunakan FSB
166MHz.

Pada pertengahan
tahun 2003, AMD
meluncurkan kembali
prosesor Athlon XP
versi Barton terbaru.
Seri prosesor Athlon XP
Barton terakhir yang
menggunakan FSB
200MHz ini memiliki kode
rating 3000+ (2100MHz) dan
3200+ (2200MHz). Untuk L2
cache-nya masih tetap 512KB.
Jumlah transistor yang
digunakan pada prosesor juga
masih tetap seperti
pendahulunya Barton FSB
166MHz yaitu 54,3 juta buah.

Prosesor seri ini bisa
dikatakan sebagai generasi
penutup dari jajaran AMD K7,
karena berikutnya AMD sudah
mulai beralih untuk
mengembangkan generasi
prosesor AMD K8 yang sudah
menggunakan teknologi 64-bit.

Fenomena yang terjadi
pada prosesor Athlon XP yang
satu ini adalah langkanya
produk untuk ditemukan di
pasaran. Tampaknya AMD tidak
terlalu banyak memproduksi
Athlon XP 3000+ dan 3200+
yang hanya dibuat sebagai batu
loncatan untuk peluncuran
prosesor berikutnya.

Hal ini cukup disayangkan
karena prosesor Athlon XP FSB

200MHz mendapat dukungan
yang cukup besar dari para
vendor chipset dan produsen
motherboard. Untuk
motherboard-nya sendiri, produk
yang dapat menampung prosesor
ini adalah yang menggunakan
chipset nForce-2 Ultra 400 milik
nVidia, SiS748 milik SiS, dan
KT600 milik VIA.

CHIPSET INTEL
Intel, selain merupakan

produsen prosesor juga
merupakan produsen chipset
untuk mainboard yang terkenal
andal. Tentunya chipset yang
diproduksinya adalah chipset
yang ditujukan untuk barisan
prosesornya. Untuk Intel
Pentium-4 dengan FSB 200MHz
yang baru diluncurkannya, pada
awalnya Intel menawarkan dua
jenis chipset, yaitu Canterwood
alias i875P dan Springdale alias
i865.

Springdale memiliki
beberapa varian yaitu i865PE,
i865G, dan i865P. Perbedaan
antara i865PE dan i865G adalah
pada fasilitas kartu grafis

terintegrasi yang hanya tersedia
pada i865G. Sementara itu i865P
memiliki perbedaan dengan
i865PE pada dukungan resmi
terhadap FSB, yaitu hanya hingga
133MHz.

Keseluruhan chipset ini baik
Canterwood maupun Springdale
telah mendukung penggunaan
dual kanal DDR-SDRAM, Hyper-
Threading, dan AGP 8x.
Perbedaan utama antara
Canterwood dengan Springdale
adalah pada fitur PAT (Perfor-
mance Acceleration Technology)
dan dukungan terhadap ECC
(Error Correction Code) untuk
memori utama. Untuk kondisi
tertentu, PAT bisa membuat delay
pada pengaksesan memori utama
menjadi berkurang. Hal ini
membuat beberapa aplikasi bisa
berjalan dengan lebih cepat.

Hal ini seharusnya membuat
mainboard yang menggunakan
chipset Canterwood bisa berjalan
lebih cepat dibandingkan
mainboard yang menggunakan
chipset Springdale dengan

komponen pendukung yang
sama. Belakangan, beberapa
produsen pembuat mainboard
bisa “memaksa” mainboard
mereka yang menggunakan
chipset Springdale untuk memiliki
fitur PAT atau setidak-
nya mirip PAT. Memang
nama yang diberikan
bukanlah PAT dan nama
ini berbedabeda untuk
setiap produsen main-
board. Hal ini membuat
selisih kinerja antara
Canterwood dengan
Springdale menjadi se-
makin tipis. Untuk ma-
salah ECC sendiri, bagi
pengguna biasa fitur ini
tidaklah penting ditam-
bah lagi harga keping
memorinya sendiri
memang lebih mahal.

Fitur lain yang
tersedia pada
Canterwood maupun
Springdale ini adalah CSA
(Communication Streaming
Architecture) yang
memungkinkan solusi Gigabit
Ethernet untuk terkoneksi secara

langsung dengan northbridge.
Alasan Intel untuk melakukan ini
adalah karena keterbatasan
bandwidth dari PCI yang hanya
sebesar 133MB/s dan harus
dibagi-bagi dengan peripheral
yang lain. CSA ini akan membuat
Gigabit Ethernet yang digunakan
bekerja secara lebih optimal
khususnya lebih bisa mendekati
bandwidth teoritis maksimalnya.

Setelah bertahan beberapa
lama dengan hanya menyediakan
chipset yang mendukung dual
kanal memori utama untuk
Pentium-4 dengan FSB 200MHz-
nya, Intel akhirnya meluncurkan
juga chipset yang memiliki kode
i848P. Chipset i848P ini hanya
mendukung satu kanal memori
utama, namun sudah mendukung
penggunaan Pentium-4 dengan
FSB 200MHz.

Dari segi southbridge yang
digunakan, Intel menawarkan ICH5
dan ICH5R. Kedua southbridge ini
telah memiliki dukungan terhadap
dua kanal Serial ATA secara
terintegrasi. ICH5R memiliki

tambahan fitur berupa RAID pada
Serial ATA-nya dibandingkan ICH5.
Satu hal yang menarik adalah Intel
hanya menawarkan software Intel
Application Accelerator untuk
penggunaan Serial ATA RAID.

CHIPSET VIA
Dengan dikeluarkannya

prosesor-prosesor jenis baru, VIA
sebagai salah satu produsen
chipset mainboard terkemuka di
dunia juga menawarkan
beberapa chipset terbarunya
yang telah mendukung prosesor-
prosesor tersebut. VIA
menawarkan chipset yang
mampu menerima prosesor dari
Intel dan juga menawarkan
chipset yang mampu menerima
prosesor dari AMD.

Untuk Pentium-4 dengan FSB
200MHz, VIA menawarkan PT800
dan PT880. Perbedaan utama dari
keduanya adalah pada dukungan
dual kanal DDR-SDRAM. PT880
sudah mendukung penggunaan
dual kanal DDR-SDRAM
sementara PT800 hanya
mendukung satu kanal DDR-
SDRAM. Selain dukungan
terhadap FSB 200MHz, dukungan
terhadap Hyper-Threading dan
AGP 8x juga tersedia. Salah satu
hal yang menarik adalah
tersedianya dukungan terhadap
penggunaan memori utama
dengan ECC.

Adapun southbridge yang
digunakan adalah VT8237 yang
telah mendukung dua kanal
Serial ATA. VT8237 ini juga telah
mendukung RAID pada Serial
ATA-nya.

Untuk AMD AthlonXP,
tawaran terbaru VIA adalah
KT600. KT600 ini telah
mendukung secara resmi
penggunaan FSB 200MHz. Versi
sebelumnya yaitu KT400A belum
memiliki dukungan resmi
terhadap FSB 200MHz. VIA
memutuskan untuk tetap
menggunakan satu kanal memori
utama saja, tidak seperti nVidia
yang telah menawarkan dual
kanal memori utama.

Pilihan tidak menggunakan
dual kanal memori utama
kelihatannya disebabkan biaya
yang lebih tinggi sementara
bandwidth teoritis maksimal
antara prosesor dengan
northbridge adalah 3200MB/s.
Bandwidth sebesar ini masih
dapat dipenuhi oleh satu kanal
DDR-SDRAM PC-3200. VIA juga
lebih mengotimalkan lagi kinerja

dari memory controller yang
digunakan sehingga semakin
mendekati bandwidth teoritis
maksimal. AGP 8x tentunya juga
sudah didukung oleh KT600 ini.
Adapun southbridge yang

digunakan adalah VT8237
seperti halnya PT800 dan
PT880 ini.

Belum lama ini AMD juga
meluncurkan prosesor 64 bit-
nya. Tidak ketinggalan VIA juga
menawarkan chipset yang telah
mendukung prosesor AMD 64
bit ini. Adapun chipset yang
diluncurkan adalah K8T800.
K8T800 ini mampu mendukung
AMD Athlon 64 maupun AMD
Athlon 64 FX. Berhubung
Athlon 64 dan Athlon 64 FX ini
memiliki memory controller
yang terintegrasi, dukungan
dual kanal maupun satu kanal
DDR-SDRAM ditentukan oleh
prosesor itu sendiri. K8T800 ini
tentunya juga sudah
mendukung AGP 8x. Adapun
southbridge yang digunakan
juga adalah VT8237.

CHIPSET SIS
Silicon Integrated Systems

cukup banyak meluncurkan
produk untuk sistem berbasis
AMD ataupun Intel di tahun
2003 ini. Untuk produk berbasis
AMD Athlon XP yang
diluncurkan pada semester
pertama 2003, chipset yang
dirilis antara lain adalah SiS
746FX dan SiS748.

Saat itu, chipset SiS746FX
merupakan produk pertama
yang mendukung prosesor
Athlon XP dengan bus 333
(166MHz), DDR400, dan
dukungan AGP8x. Berpasangan
dengan southbridge SiS963L,
chipset ini mendukung hingga
enam port USB 2.0, ATA 133, 5.1
Channel AC’97 Audio, dan 10/
100Mb Ethernet and Home
PNA2.0.

Pada pertengahan Maret
2003, chipset SiS746FX berhasil
disempurnakan dan kemudian
dirilis kembali. Spesifikasi teknis
yang diintegrasikan pada
chipset tersebut masih sama
dengan pendahulunya. Produk
yang telah mengalami
perbaikan tersebut dinamai
SiS748. Mengikuti
perkembangan prosesor, dua
bulan setelah rilis pertamanya
chipset ini diberikan dukungan
terhadap Athlon XP 3200+ yang

Motherboard yang menggunakan chipset
canterwood lebih ditujukan untuk kelas performa

Sampai saat ini VIA masih menggunakan satu kanal
memori utama pada chipset terbarunya untuk Athlon XP
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sudah menggunakan FSB400 (2
x  200MHz).

Pada awal semester kedua
2003, SiS merilis chipset yang
disiapkan untuk mengantisipasi
prosesor AMD yang akan
datang yaitu Athlon64. Chipset
yang dirilis saat itu adalah
SiS755. Selang dua bulan
berikutnya, SiS kemudian
meluncurkan SiS760 yang
mendukung prosesor yang
sama, namun dengan solusi
grafis terintegrasi.

Bukan SiS namanya kalau
lagi-lagi tidak memproduksi
chipset dengan versi yang
menyediakan grafis terintegrasi.
Chipset berikutnya yang dirilis
untuk sistem AMD (kini giliran
untuk Athlon XP) adalah SiS741
yang sejenis dengan 746FX dan
748 namun tentunya dilengkapi
VGA onboard.

Chipset terakhir yang
dikeluarkan oleh SiS untuk
sistem berbasis AMD pada
tahun 2003 adalah SiS755FX.
Produk yang satu ini dibuat

untuk dapat menangani
prosesor Athlon64 FX.

Untuk prosesor Intel, tahun
2003 ini SiS juga cukup aktif
memperkenalkan produk
terbarunya ke pasaran. Chipset
untuk Pentium-4 keluaran SiS
ini ada dua jenis. Pertama versi
yang mendukung memori jenis
RDRAM dan yang kedua adalah
versi yang mendukung memori
DDR.

Untuk yang menggunakan
memori RDRAM, pada bulan
pertama tahun ini SiS
meluncurkan chipset SiSR658.
SiS bekerjasama dengan
Rambus, Samsung, dan Abit saat
merilis chipset ini. Namun
sayangnya, chipset yang
mendukung RDRAM PC1066
yang saat itu merupakan sistem
terkuat datang terlambat.
Memori RDRAM tidak lagi
menarik untuk kebanyakan
pengguna sistem Pentium-4.

Mendekati akhir tahun
2003, SiS kembali merilis chipset
untuk Pentium-4 dengan
RDRAM. Kini vendor
motherboard yang diajak
bekerjasama adalah Asus.
Chipset ini sudah mendukung
prosesor Pentium-4 terbaru

dengan FSB800 dan memiliki fitur
four channel memory dan
mendukung RDRAM PC1200 dan
PC1333.

Meskipun cukup banyak
menarik perhatian dengan
kontroler memori yang inovatif,
namun tampaknya chipset ini
nasibnya tidak akan jauh lebih
baik dari SiSR658 sehubungan
dengan tidak banyak user yang
menggunakan RDRAM untuk PC
desktop.

Tiga chipset SiS untuk
Pentium-4 dengan DDR-SDRAM
yang diluncurkan pada tahun
2003 ini adalah SiS655FX,
SiS655TX, dan SiS661FX. Chipset
yang terakhir merupakan solusi
terintegrasi. Pada PCplus edisi
yang lalu, kita pernah membahas
chipset SiS655FX dan SiS655TX
ini. Kinerjanya cukup baik
dengan stabilitas yang juga
cukup baik.

Dua chipset tadi merupakan
chipset alternatif yang dibuat
oleh SiS untuk mengantisipasi
chipset Canterwood dan

Springdale milik Intel. Demikian
pula untuk SiS661FX. Grafis
terintegrasi yang digunakan pada
chipset ini sudah mendukung
AGP 8x dan DirectX 9. Meskipun
tidak menyediakan fitur dual
channel memory, chipset

SiS661FX ditujukan sebagai
produk pilihan selain chipset
Springdale dengan grafis
terintegrasi.

CHIPSET NVIDIA
Pada tahun 2003 nVidia

hanya merilis dua chipset
motherboard. Kedua chipset
tersebut disediakan untuk
mendukung prosesor AMD.
Chipset pertama adalah nForce-2
yang dirilis pada awal tahun.
Terpacu oleh kegagalan nForce
yang jauh lebih dahulu dirilis,

chipset nForce-2 nVidia
ber-hasil menggebrak pasar.

Dengan nForce-2, nVidia
berhasil mencuri perhatian
yang sangat luas dari para
pengguna sistem berbasis
AMD. Pangsa pasar yang
mereka rebut dari produsen
yang telah lama berke-
cimpung dalam produksi
chipset untuk AMD seperti
VIA dan SiS terutama
adalah high-end user.

Dukungan dual
channel memory DDR400
yang ditawarkan oleh
chipset nForce-2 sampai
saat inipun tidak ada
pesaingnya. VIA dan SiS
hanya mengembang-
kan chipset model
dengan single channel
memory controller.

Ditambah dengan versi yang
menyediakan integrated graphics
sekelas GeForce-4 MX, grafis
terintegrasi milik nVidia nForce
merupakan yang terkuat di

kelasnya. Cukup jauh di atas
integrated graphic yang tersedia
pada VIA KM400 dan SiS741.

Selang tiga bulan setelah rilis

nForce-2, nVidia melakukan
update terhadap chipset nForce-2
tersebut. Hal ini dilakukan sehu-
bungan diluncurkannya prosesor
AMD yang menggunakan FSB400.
Chipset yang telah di-update ini
dirilis kembali dengan nama
nForce-2 400 dan nForce-2 Ultra
400. nForce-2 400 adalah versi
yang tidak menyediakan fitur

dual channel memory, sedangkan
versi top of the line-nya adalah
nForce-2 Ultra 400 yang
menyediakan kontroler dual
channel memory.

Di antara peluncuran chipset
untuk AMD K7 tersebut, tepatnya
pada medio April 2003, nVidia
juga merilis produk yang dapat
menampung generasi prosesor
AMD K8 yaitu Athlon 64 dengan
chipset nForce-3. Dengan fitur-
fiturnya, chipset ini diprediksi
juga akan mampu mengambil
sebagian besar pangsa pasar user
di kelas AMD K8.

CHIP GRAFIS NVIDIA
Kalangan pemerhati grafis

3D tentunya masih ingat dengan
kejadian di bulan Maret 2003.
Pada bulan ini nVidia
meluncurkan produk GeForce
FX5200. Setelah sekian lama
menunggu, akhirnya nVidia
merilis chip grafis kelas value
pertama yang mendukung
DirectX 9 dan AGP 8x. Chip grafis
yang saat dirilis market suggested
retail price (MSRP)-nya tidak
sampai 80 US $ ini diyakini akan
segera mengambil pasaran
entry level yang masih dikuasai
oleh jajaran GeForce MX.

Pada waktu bersamaan,
nVidia juga meluncurkan chip
GeForce FX5600 yang lebih
tinggi lagi kinerjanya
(nVidia mengklaim bahwa
kinerja chip ini sekitar 30%
di atas GeForce-4 Ti4600)
serta ditujukan untuk
pasaran mainstream.
Kedua chip tersebut
melengkapi jajaran
grafis nVidia setelah
produk top of the line
mereka yaitu FX5800
dirilis pada tahun
sebelumnya.

Perkembangan
selanjutnya, FX5800
gagal mengambil alih

pimpinan pasar chip grafis.
Kinerjanya kembali terhantam
oleh produk keluaran
kompetitornya. Pada bulan Mei

2003, chip grafis high perfor-
mance penerusnya yaitu FX5900
diluncurkan. Menggunakan
interface memori 256-bit, kartu
VGA yang chip grafis-nya dibuat
dengan teknologi 0,13 micron
ini sudah dapat dimiliki satu
bulan berikutnya.

Lantaran ketatnya
persaingan dengan kompetitor

untuk dapat menduduki kursi
nomor satu di bidang chip
grafis, Oktober lalu nVidia
kembali melakukan peluncuran
chip grafisnya yang lebih cepat
lagi yaitu GeForce FX5950. Di
sektor mainstream, nVidia juga
melakukan update. Untuk
market ini, produk yang dirilis
adalah GeForce FX5700. Chip
grafis ini tampaknya dibuat
untuk menghadang laju Radeon
9600 keluaran ATi.

CHIP GRAFIS ATI
Setelah cukup lama

didominasi oleh nVidia, dunia
chip grafis untuk PC mulai
memiliki alternatif yang bisa
menyaingi. Dimulai dari Radeon
8500, ATI sudah menjadi
pesaing nVidia dalam hal
kinerja dan teknologi. Tahun ini
ATI mengeluarkan Radeon seri
9800, Radeon seri 9600, dan
Radeon seri 9200. Yang
merupakan kartu grafis DirectX
9 adalah yang 9800 dan 9600.
Adapun Radeon seri 9800 dan
9600 yang terakhir kali
diluncurkan adalah Radeon
9800 XT dan 9600 XT.

Perbedaan yang cukup
menonjol antara Radeon 9800
XT dengan Radeon 9800 PRO
yang terlebih dahulu
diluncurkan adalah pada clock
dari core dan memori yang
digunakan. Sementara itu
perbedaan yang menonjol
antara Radeon 9600 XT dengan
Radeon 9600 PRO adalah pada
clock dari core-nya, memorinya
tidak. Versi XT memiliki nilai
yang lebih tinggi dibandingkan
versi PRO. Radeon 9800 XT
ditujukan untuk kelas atas
sementara Radeon 9600 XT
ditujukan untuk kelas
menengah.

Radeon 9800 XT memiliki
core clock sebesar 412MHz dan
memory clock sebesar 365MHz.
Radeon 9800 XT ini
menggunakan memory bus 256
bit dan memiliki memori
dengan kapasitas 256MB.

Tahun ini Mainboard Pentium-4 yang menggunakan chipset SiS banyak dilirik
orang sebagai alternatif dari Intel

Geforce FX5950 dirilis untuk meningkatkan kinerja dari flagship nVidia

Mainboard yang menggunakan chipset nForce - 2 lebih fleksibel dalam
menangani dua kanal memori
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Radeon 9800 XT ini
memiliki 4 Vertex Shader dan 8
Pixel Pipeline. Sementara itu
Radeon 9600 XT memiliki core
clock sebesar 500MHZ dan
memory clock sebesar 300MHz.
Radeon 9600 XT ini
menggunakan memory bus 128
bit dan memiliki memori
dengan kapasitas 128MB.
Radeon 9600 XT ini memiliki 4
Vertex Shader dan 4 Pixel
Pipeline. Baik Radeon 9800 XT
maupun 9600 XT tentunya
sudah mendukung AGP 8x.
Radeon 9800 XT membutuhkan
tambahan daya yang umumnya
diambil secara langsung dari
power supply, sementara
Radeon 9600 XT tetap tidak

membutuhkan tambahan daya.
Berhubung perbedaan yang

menonjol antara versi XT dengan
versi PRO terletak pada clock,
secara kinerja kelihatannya
perbedaan antara versi XT dan
versi PRO ini tidaklah banyak.
Dalam kasus tertentu perbedaan
yang terjadi sangat minimal. Oleh
karena itu versi XT ini bisa
dianggap merupakan versi
pemaksimalan clock.

KARTU GRAFIS SIS
Untuk chip grafis, tahun

2003 ini SiS melakukan
penambahan fungsionalitas pada
kartu grafis yang menggunakan
chipset Xabre 600 yang dirilis
pada akhir 2002. Perbaikan yang

dibuat adalah dengan
menambahkan chip Bt835
buatan Conexant Systems,
Inc. yang memungkinkan
chip grafis Xabre 600
untuk memiliki
kemampuan Video-In.
Kartu grafis yang sudah
dilengkapi oleh chip
Xabre dan Bt835 dirilis
dengan nama Xabre
600 VIVO.

Meskipun sudah
di-upgrade
kemampuannya, kartu

grafis SiS ini tetap kurang
mampu menarik perhatian para
pengguna gamers. Meskipun
merupakan kartu grafis pertama
yang memiliki kemampuan
DirectX 8.1 dan AGP 8x, kualitas
gambar kartu grafis yang
menggunakan chip ini tidaklah
sebaik kompetitornya yang
memanfaatkan chip

ATi ataupun nVidia. Hal ini
disebabkan karena SiS sengaja
menurunkan kualitas gambar
untuk mengoptimalkan kinerja
chip grafis untuk dapat bersaing
dengan kompetitor mereka dari
segi performa.

Pada tahun 2003 ini,
mungkin Anda kurang
mendengar mengenai chip grafis
dari SiS. Ini wajar berhubung
divisi grafis dari SiS pada tahun
ini telah bergabung dengan
perusahaan lain dan kemudian
membentuk XGI. XGI ini sesuai
dengan perusahaan ataupun
divisi yang membentuknya juga
bergerak di bidang chip grafis.
Memang rasanya belum ada
kartu grafis yang menggunakan

chip XGI ini tersedia di pasaran.
Kelihatannya chip dan driver
XGI memang belum dalam
kondisi final. Adapun chip grafis
XGI yang ditujukan untuk
desktop mencakup Volari V3,
Volari V5/V5 Ultra, dan Volari
V8/V8 Ultra. Yang menarik
adalah Volari V5 Ultra dan
Volari V8 Ultra bisa digunakan
secara berpasangan. Kartu
grafis yang menggunakan dua
buah Volari V5 Ultra ataupun
dua buah Volari V8 Ultra
seharusnya akan memiliki
kinerja yang lebih tinggi. Volari
Duo inilah yang diharapkan
oleh XGI dapat bersaing dengan
chip grafis kelas atas dan
menengah dari ATI maupun
nVidia. Volari seri V5 dan seri V8
sudah merupakan chip grafis
DirectX 9. Volari V8 Ultra
memiliki 2 Vertex Shader dan 8
Pixel Pipeline dengan core clock
sebesar 350MHz dan memory
clock untuk DDR sebesar
375MHz (V8 Ultra mendukung
DDR2 dengan clock berbeda).
Untuk Volari V5 Ultra core clock
yang digunakan juga sebesar
350MHz dan memory clock
untuk DDR juga sebesar
375MHz (V5 Ultra juga
mendukung DDR2 dengan clock
berbeda), hanya saja Volari V5
Ultra ini hanya memiliki 2
Vertex Shader dan 4 Pixel
Pipeline. PC+

ISTIM
EWA

Radeon 9800XT bisa dikatakan sebagai Radeon
9800 Pro dengan ekstra clock

Tahun ini kartu grafis
menggunakan chipset SiS
tidak mendapatkan tambahan
varian yang banyak
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Manuver “Mobile”
untuk Menemukan
Jalan Tol ke Internet

L
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F.X. Bambang Irawan
fbi@e-pcplus.com

Rakyat Indonesia
memang sudah

menikmati akses
Internet. Namun

dianalogikan dengan
kereta api yang sering

banget anjlok itu,
Internet kita

kebanyakan masih
kelas ekonomi.

elet dan
sering sekali
berhenti (di
stasiun-stasiun kecil).

Kapan kita menikmati kelas
Argo-nya, yang agak lebih cepat
dan nyaman (meski anjlok tidak
ditanggung dan kalau anjlok
tidak tanggung-tanggung)?

Sepanjang tahun ini isu
tentang Internet kiranya “nyaris
tak terdengar”. Setidaknya tak
ada fenomena-fenomena yang
layak dicatat sebagai poin
kulminasi baru teknologi yang
telah mengubah dunia secara
radikal ini.

Tak ada berita tentang
munculnya dotcom baru yang
mengundang klik sampai
miliaran dalam beberapa hari
kemunculan perdananya. Tak
ada situs baru yang pemiliknya
tinggal membuka jendela di
pagi hari dan serta merta jutaan
dollar mengalir ke rekeningnya.
Tak ada cara bisnis baru lewat
Internet yang meraup duit
bergudang-gudang yang dapat
dilakukan dari garasi, kecuali
dengan melakukan penipuan.
Tak ada cara akses massal baru
yang dapat meningkatkan
kecepatan akses sampai
bergigabit-gigabit. Tak ada
teknologi baru berbasis Internet
yang memurahkan ongkos
hidup manusia seperti yang bisa
dilakukan misalnya oleh VoIP.
Tak banyak lagi seminar-seminar
yang menggunakan tema
Internet sebagai penarik minat
peserta untuk merogoh kocek
ratusan ribu rupiah.

Kabar yang ingin didengar
oleh seluruh masyarakat dan
calon pengguna Internet di
Indonesia akan cepat dan
murahnya akses Internet belum
juga terdengar. Salah satu
keputusan yang ditunggu-
tunggu, yaitu pembebasan
penggunaan frekuensi 2,4GHz
untuk kepentingan proliferasi
node Internet melalui media
wireless masih mengambang
tak jelas di udara (lihat boks
“Bebaskan Frekuensi 2,4GHz,
Angkat Harkat Hidup Rakyat”).

Internet terasa adem ayem
saja.

INTERNALISASI
Adakah ia memang sudah

mati? Jelas tidak. Internet tetap
menjadi tempat bergantung
jutaan umat manusia di dunia,
tak luput pula di Indonesia.
Sudah banyak orang yang
menjadikan Internet sebagai
makanan sehari-hari. Bahkan

ada yang menganggapnya nadi
kehidupannya. Can’t live without.

Begitu menghidupkan
komputer di kantor, maka icon
yang diklik pertama kali adalah
e-mail client. Sembari menunggu
e-mail client-nya di-load, dan e-
mail yang ngendon semalem di
server di-download, mereka akan
menyiapkan kopi atau memesan
sarapan ke office boy. Nah,
appetizer untuk sarapan pagi
mereka adalah e-mail yang bisa
berupa kabar atau informasi
bisnis yang penting. Atau bisa
jadi pemancing anak tekak ini
sekadar tumpukan e-mail dari
berbagai milis yang
dilanggannya, yang berisi mulai
dari joke, informasi demo, sampai
jualan barang seken.

Ada yang bahkan melakukan
rutinitas seperti itu kala matanya
saja belum benar-benar melek
sehabis bangun tidur!

Alamat e-mail sudah
merupakan kewajiban tercantum
pada kartu nama. Account e-mail
tambahan dari Yahoo! atau
Softhome “is a must” untuk
dimiliki. Outlook Express atau
Eudora merupakan aplikasi yang
dikuasai secara fasih, malah
mungkin lebih familiar
ketimbang Excel atau bahkan
Word. Paling tidak satu milis dari
Yahoo!Groups hampir pasti
dilanggan untuk stay connected
dengan batih atau komunitasnya.

Satu kenyamanan lagi yang
diciptakan oleh Internet adalah
manakala tiba saatnya untuk
mencari sebuah informasi.
Perpustakaan umum tidak
menjamin akan menyediakan
informasi yang kita butuhkan,
apalagi kalau terlalu spesifik dan
merupakan informasi yang
berasal dari mancanegara. Belum
lagi untuk menuju ke sana butuh
ekstra waktu, tenaga, dan biaya.
Melalui situs-situs yang dibangun
oleh hampir semua pihak yang
mempunyai informasi di seluruh
kolong jagad ini, Internet
merupakan perpustakaan raksasa
yang fully searchable.

Akibat proses internalisasi ke
dalam darah daging seperti itu,
maka kemudian orang jadi baru
sadar bahwa dia ditopang habis-
habisan oleh Internet hanya ke-
tika jaringan, server, atau ISP, yang
merupakan jalan tol kita ke Inter-
net mengalami gangguan. Pada
saat itulah kita serasa ingin me-
manggil ambulan untuk menye-
lamatkan hidup dan bisnis kita.

AKSES ALTERNATIF
Internet memang

memaparkan orang kepada

segala macam informasi kapan
pun kita butuh. Tak ada dikenal
kata tutup bak layanan
perpustakaan umum dengan
petugas yang terkantuk-kantuk.
Dini hari pada saat mimpi
menjelma wangsit untuk
mengerjakan sesuatu, Internet
siap sedia merayapi sepi dan
dinginnya malam untuk me-
routing data.

Namun soal “kapan pun” itu
pun tidak dihiraukan orang lagi
sebagai sebuah keajaiban
peradaban. Mereka pikir sudah
layak dan sepantasnyalah,
conditio sine qua non bagi
kehidupan moderen yang sudah
harus demikian adanya,
sebagaimana udara berada di
atmosfer, atau burung-burung di
udara dan ikan-ikan di lautan,
Internet menjadi alat yang given
untuk komunikasi umat manusia.
Yang sedang “in” saat ini bukan
lagi masalah ketersediaan
Internet yang 24x7x365 jam itu,
melainkan soal “di mana pun”-
nya.

Internet sudah merupakan
muara dari semua hulu
infrastruktur komunikasi saat ini.
Semua teknologi telekomunikasi
diarahkan untuk “nyantol” ke
sana. Tak heran karena selain
merupakan jaringan yang paling
mondial (mendunia), di dalam
jaringan Internet sudah
terkandung tambang emas
berupa data, informasi, dan file
digital yang nilainya tak
terhingga.

Memang masih jauh dari
gambaran ideal yang suka
digembar-gemborkan ketika
mereka berbicara tentang peranti
rumah tangga yang ditanami IP
address sehingga alat-alat
tersebut bisa mengakses dan
diakses lewat Internet. Namun
“jalan tikus” untuk mengakses ke
jaringan Internet sekarang mulai
bermunculan ketika berbagai
peranti komunikasi di luar
telepon PSTN menyediakan
teknologi jaringan yang bisa
mengenali dan nyambung ke
protokol Internet.

Mempunyai cara alternatif
untuk menyambungkan diri ke
Internet akhirnya merupakan
kebutuhan dan gaya hidup baru.
Mereka yang bisa mengejar
Internet seraya bergerak sampai
ke café atau tempat-tempat yang
(dulunya) tak lazim buat
mengakses Internet mendapat
kepuasan tersendiri dan
pengakuan sebagai warga
masyarakat yang mobile. Mereka
yang benar-benar melakukannya
untuk sekadar melangsungkan

hidup (berkecukupan) akan
sangat berbahagia dengan
berbagai kemungkinan akses
baru yang fleksibel ini.

Menarik sekali jika
mengamati bagaimana kita bisa
menghubungkan diri ke Internet
saat ini selain melalui PC.
Umumnya, teknologi akses ini
dikembangkan oleh industri
mobile device yang memasarkan
dagangannya sebagai alat
komunikasi data, selain suara.
Dengan keunggulan dalam soal
mobilitas, teknologi seluler, baik
GSM maupun CDMA, menjadi
alternatif yang seksi dalam
menjangkau
Internet. Maka tak
ayal jika pasar
peranti nirkabel
makin hari makin
ramai.

PDA sudah
merupakan
mainan para
profesional yang
harus hidup
berpindah-pindah
dengan kecepatan
tinggi dan harus
mengandalkan
peranti yang
ringkas namun
cerdas. Ponsel pun
menemani peranti
ini untuk
membantu
mengoneksikan
dengan jaringan
seluler dan
Internet. Belum
cukup juga, ponsel
dan PDA ini diga-
bung menjadi satu
dalam format pon-
sel-PDA atau PDA-
ponsel atau seka-
dar smartphone.

Berikut ini
teknologi-
teknologi yang
bisa mereka pilih
untuk menghu-
bungkan
“mainan” mereka
tersebut ke
jaringan data semesta, Internet.

HSCSD
High-Speed Circuit-

Switched Data (HSCSD)
merupakan teknologi yang
diusung GSM yang mampu
menyediakan kecepatan
transfer data sampai 57,6kpbs
jika keempat slot yang ada
(yang masing-masing
berkecepatan 14,4kbps)
digunakan sekaligus. Teknologi
ini ramai digunjingkan dan
menjadi fitur populer ponsel

yang mempunyai kapabilitas
WAP. Tahun 2000-2001
merupakan tahun HSCSD di
tanah air.

GPRS
Pada dasarnya General

Packet Radio Service (GPRS)
adalah teknologi yang
memungkinkan akses Internet
lewat ponsel berlangsung lebih
cepat dan mulus dibanding
sebelumnya.

Dengan teknologi GPRS,
sumber daya gelombang radio
hanya dimanfaatkan pada saat
ada transmisi paket, baik

diterima atau dikirim. Jadi,
bandwidth tidak diduduki dan
nganggur jika tidak digunakan.
Inilah keuntungan jaringan
berbasis packet dibanding
jaringan berbasis circuit switch
yang digunakan pada generasi
GSM sebelumnya.

Pengaryaan teknologi GPRS
ini bisa dipandang sebagai
pencangkokan jaringan di atas
jaringan GSM generasi kedua
yang telah ada. Oleh karena itu
tak heran jika platform ini
disebut-sebut sebagai generasi

Ponsel Nokia 6220 yang mempunyai
kapabilitas teknologi EDGE
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2,5 (2,5G) dan menjadi
jembatan ke 3G yang sudah
dirintis di Jepang.

Secara teoretis, kecepatan
yang bisa digeber melalui GPRS
yang “always on” ini adalah
115kbps jika kedelapan time
slot yang tersedia digunakan
semua secara bersamaan.
Kecepatan ini berarti sekitar
tiga kali lebih cepat dibanding
sambungan lewat modem dial
up yang disuguhkan oleh
jaringan telepon rumahan kita
dan sekitar sepuluh kali
kecepatan teoretis yang bisa
dicapai oleh data yang
dilewatkan pada jaringan GSM
yang ada saat ini.

EDGE
Teknologi yang merupakan

pengembangan lebih lanjut dari

GPRS ini disebut EDGE (Enhanced
Data rate for GSM Environment).

Seperti tersirat pada
namanya, teknologi ini
merupakan pengembangan
yang bisa dicangkokkan pada
GSM. EDGE ini awalnya
dikembangkan untuk operator
yang karena satu dan lain hal
tidak jadi mengembangkan
UMTS (Universal Mobile
Telephone System).

Dengan EDGE ini operator
GSM tetap dapat menyuguhkan
layanan mobile data yang
hampir menyamai layanan
UMTS yaitu pada kecepatan
maksimum 384kbps. Dan, tentu
saja, di atas layanan GPRS.
Ponsel yang sudah dilengkapi
dengan teknologi EDGE yang
masuk ke Indonesia adalah
Nokia 6220.

BEBASKAN FREKUENSI 2,4GHZ,
ANGKAT HARKAT HIDUP RAKYAT

PEMERINTAH sedang merancang pengaturan frekuensi 2,4GHz yang juga
dikenal dengan istilah frekuensi ISM (Industrial, Scientific, and Medical).
Frekuensi ini sudah banyak memberi keuntungan bagi jagad Internet di
Indonesia karena memberi kemungkinan pembangunan warnet-warnet
berkecepatan tinggi. Namun, sayangnya pemerintah bersikap represif
terhadap infrastruktur yang sangat potensial mengangkat derajat
kepintaran dan kelihaian bangsa ini.

Dalam logika ekonomistik pemerintah, mereka akan kehilangan
sumber pendapatan sampai 22 miliar per tahun dari Biaya Hak Pemakaian
(BHP) frekuensi dari 2.900 sambungan microwave yang telah ada jika ISM
dibebaskan penggunaannya.

Kang Onno W Purbo merupakan pendekar yang menentang represi
ini dengan mengajukan skenario keuntungan rakyat dan pemerintah
Indonesia jika frekuensi ini dimerdekakan. Menurut Onno yang pada
tanggal 8-9 Desember lalu diundang berbicara dalam forum Role of
Science in the Information Society (RSIS) di laboratorium CERN di Genewa,
Swiss, meskipun kehilangan 22 miliar, namun dengan berkembang
pesatnya Internet akibat wireless Internet ini akan meningkatkan
pengguna yang bertumpu pada wireless Internet yang tadinya hanya
sekitar satu juta orang menjadi berpotensi mencakup 17,8 juta pengguna
Internet di Indonesia. Sebuah jumlah pengguna yang mendekati negara
Cina pada hari ini.

Jika setiap pengguna mengeluarkan uang Rp 10.000/bulan untuk
akses Internet, maka pemerintah akan memperoleh kenaikan pendapatan
dari 7 miliar rupiah per tahun dari PPh Jasa dan 1 miliar rupiah per tahun
untuk BHP Jasa Telekomunikasi, melonjak menjadi 128 miliar rupiah per
tahun dari PPh Jasa dan 21 miliar rupiah tahun BHP Jasa Telekomunikasi.
Jelas jauh lebih menguntungkan daripada 22 miliar rupiah dari BHP
Frekuensi sambungan microwave yang ada saat ini (Kompas, 20 Oktober
2003).

Itu belum pula menghitung potensi masukan pajak kepada negara
sekitar 600 miliar dari PPN investasi peralatan Access Point, client, maupun
komputer yang akan diinstalasi untuk membangun koneksi wireless
Internet. Belum pula menghitung adanya potensi membangun sendiri atau
mendatangkan investasi untuk industri peralatan wireless Internet ini.

Oleh karena itu rasanya tak ada pilihan yang lebih cerdas selain
membebaskan frekuensi ini seperti juga disarankan oleh International
Telecommunication Union (ITU) maupun PBB. PC+

TINGKATAN TEKNOLOGI TRANSPOR DATA SELULER

TEKNOLOGI DESKRIPSI PENGGUNAAN KHUSUS,
TRANSPOR KECEPATAN TRANSMISI

TDMA Time Division Multiple Suara dan data sampai 9,6kbps
Access (teknologi 2G) Suara dan data. Sampai 9,6kbps

GSM Global System for Mobile
Communications
(teknologi 2G)

GPRS General Packet Radio Service Data. Sampai 115kbps
(teknologi 2,5G
dengan dukungan
paket data)

EDGE Enhanced Data GSM Data. Sampai 384kbps
Environment (teknologi 3G)

W-CDMA/UMTS Wideband CDMA/ Universal Data dan suara. Sampai 10Mbps.
Mobile Telecommunications
System—UMTS (teknologi 3G).

CDMA2000 1xRTT Code Division Multiple Access Data dan suara. Sampai 144kbps
(teknologi  3G, fase pertama
CDMA2000)

CDMA2000 1xEV-DO Mengusung data pada kanal Sampai 2,4Mbps
terpisah

CDMA2000 1xEV-DV Memadukan suara dan data Data dan suara. Sampai 2,4Mbps
pada kanal yang sama

PDN
PDN adalah singkatan dari

Packet Data Network,
merupakan fasilitas yang ada
pada network CDMA 2000 1x
untuk melakukan koneksi data
paket seperti halnya GPRS pada

network GSM-1800.
Produk layanan akses

Internet melalui PDN disedia-
kan oleh operator CDMA 2000
1x pertama di tanah air, yaitu
TelkomFlexi, dengan nama
layanan:TELKOMNet@Flexi.

Kecepatan akses yang bisa
dicapai adalah 153 Kbps.

EV-DO
Operator CDMA Mobile-8

memperkaya khasanah broad-
band wireless dengan mengu-
sung layanan CDMA 2000 1x
yang dilengkapi dengan EV-DO
(Evolution of Data Only). Secara
teoretis, layanan ini akan dapat
mengusung data pada kecepa-
tan sampai 2,4Mbps. Pada saat
ini sedang dilakukan proyek uji-
coba wireless broadband (EV-
DO) di Jakarta.  Dari hampir 300
BTS yang terpasang, 17 BTS
telah dialokasikan untuk
layanan wireless broadband (EV-
DO) ini dengan rata-rata
throughput sebesar 500-700
Kbps. Bandingkan dengan
hanya 80 Kbps yang bisa
disediakan oleh CDMA 2000 1X.

Dengan mencicipi teknologi
EV-DO ini, berarti kita sudah
menginjak generasi ketiga (3G)
dalam industri seluler, melalui
route CDMA. PC+

Onno W Purbo, mengaku sebagai “Common Indonesian” alias orang
Indonesia biasa-biasa saja, ketika berbicara dalam forum RSIS di
Jenewa, tekun memperjuangkan akses Internet bagi sebanyak-
banyaknya rakyat Indonesia.
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Perkembangan dunia
TI terasa sangat cepat.

Teknologi yang
dulunya hanya ada

dalam bayangan dan
angan-angan,

kemudian menjadi
kenyataan. Bahkan

dengan cepat diserap
oleh pasar secara

sangat antusias.
Kecepatan

perkembangan dan
penetrasinya bahkan

seringkali di luar
perkiraan

sebelumnya.

ni bisa
dibuktikan
dengan beberapa
teknologi baru yang

muncul di tahun 2003 dan
langsung diserap pasar dengan
sangat cepat. Contoh paling jitu
untuk menggambarkan
cepatnya penyerapan ini adalah
teknologi wireless yang seakan
menyihir dunia TI dan menjadi
trend setter teknologi
umumnya untuk saat ini.
Teknologi yang diotaki oleh
Intel dan vendor-vendor tele-
komunikasi lainnya ini begitu
kuat pengaruhnya di industri TI.

Teknologi yang dipercaya mampu
mengubah cara pikir dan cara
kerja banyak orang ini begitu
cepat berkembang karena

beragam faktor
pendukungnya.

Faktor yang
penting dalam
perkembangan
teknologi yang
memanfaatkan
gelombang radio ini
selain adanya
standardisasi yang
tegas untuk
perangkatnya
sehingga
pengembangan
teknologi ini
menjadi lebih
terarah dan mudah
diintegrasikan
dengan beragam
sistem adalah
adanya kebutuhan
dasar pengguna PC
atau perangkat lain
untuk
menghilangkan
kendala akses ke

jaringan maupun Internet yang
selama ini sangat tergantung
pada carut marut kabel jaringan.
Kebutuhan inilah yang disadari

atau tidak membuat teknologi
wireless berkembang pesat.

MUDAHNYA
MENDAPATKAN PRODUK
BERBASIS WIRELESS

Cepatnya
perkembangan
wireless ini juga
yang membuat
para produsen
besar perangkat
PC tak mau
ketinggalan
kereta untuk
menghasilkan
produk-produk
mutakhirnya
yang berbasis
teknologi tanpa
kabel ini. Sebut
saja macan-
macan TI dunia
semisal Asus, Gigabyte, dan
produsen besar lainnya yang
tadinya hanya berkutat pada
masalah komponen PC standar
tak mau kalah mengeluarkan
juga beragam bentuk dan model
perangkat pendukung teknologi

wireless ini. Tidak hanya itu,
produsen lain yang tergolong
lebih kecil pun tak mau keting-
galan memperebutkan ceruk
pasar potensial untuk sistem
wireless ini.

Hasilnya bisa dilihat pada
pertengahan tahun ini. Beragam
produk dengan segala keunggu-
lan dan jenis interface-nya yang
berbasis wireless sudah bisa
didapat. Mulai dari WLAN card
dengan beraneka ragam

SI
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C
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C
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Dengan tambahan perangkat yang kecil perangkat
PC, notebook, dan PDA dengan mudah terhubung
ke jaringan secara wireless

Compact flashpun kini dapat pula berfungsi sebagai
WLAN Card adapter
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interface , access point dengan
kemudahan setting-nya, router
maupun perangkat jaringan
wireless lainnya bisa didapat
dalam beragam bentuk, jenis,
dan merek.

Menariknya, kartu-kartu
jaringan wireless di tingkat
client banyak yang tidak lagi
menggunakan interface
konvensional macam PCI pada
PC desktop maupun PCMCIA
pada notebook. Di antara
sekian jenis WLAN card yang
ada, muncul jajaran produk
yang memanfaatkan  jenis
universal serial bus, baik dari
versi 1.1 maupun 2.0 sebagai
interface penghubung dari
perangkat PC atau notebook ke
dalam jaringan wireless.
Beberapa produk jenis ini
bahkan memiliki fungsi ganda
sebagai media penyimpan data
alias pen drive lantaran
menggunakan interface yang
sama.

Menariknya, banyak dari
jenis WLAN card ini
menggunakan antena internal
untuk menerima maupun
mengirimkan sinyal radio
sehingga bentuknya sangat
mungil dan tak ubah seperti
pen drive biasa.

 Beberapa WLAN card juga
memanfaatkan interface yang
biasa digunakan pada compact
flash untuk menghubungkan

satu perangkat macam PDA ke
dalam sistem wireless. Adanya
kartu semacam ini seakan
memberikan alternatif lain
bagaimana perangkat ini
tersambung ke dalam sistem
jaringan selain WiFi jacket.

Salah satu produsen bahkan
berani mengusung port khusus
pada beberapa seri motherboard-

nya untuk ditancapkan dengan
kartu WLAN khusus agar
sistemnya bisa mengakses
jaringan secara wireless dengan
maksimal.

Adanya beragam tipe
koneksi ini sendiri di satu sisi
memang cukup memusingkan
dalam pemilihannya. Namun, di

lain pihak, ketergantungan
pengguna terhadap satu inter-
face bisa dikurangi selain juga
tersedia pilihan alternatif
interface yang bisa disesuaikan
dengan dukungan interface yang
dimiliki pengguna maupun
pilihan kemampuan teknis dalam
mentransmisikan data dari tipe
yang akan dipakai.

Menariknya, teknologi WiFi
yang dikembangkan masing-
masing produsen ini mengarah
pada satu hal yaitu kemudahan
instalasi, baik pada tingkat client
maupun pada tingkat jaringan.
Kemudahan ini seakan
menghilangkan momok sulitnya
menghubungkan satu PC ke

dalam sistem jaringan yang
selama ini ditakutkan banyak
orang.

Setting untuk access point
misalnya begitu mudah
dilakukan, bahkan bisa dilakukan
lewat browser untuk mengatur
beragam fitur yang tersedia. Hal
yang sama juga terjadi di tingkat
client. Proses instalasi maupun
setting untuk mengakses jaringan
dapat dilakukan dengan cepat
dan mudah sehingga end user
yang miskin pengalaman pun
bisa dengan mudah
melakukannya.

CENTRINO: INTEGRASI
WIRELESS DALAM SISTEM
NOTEBOOK

Membicarakan teknologi
wireless terkini tanpa
membicarakan Centrino ibarat
makan sayur tanpa garam.
Teknologi Centrino dari Intel
yang mengintegrasikan Intel
Pentium 4 mobile, keluarga
chipset i855, dan Intel Pro/
wireless 2100 dalam satu sistem
ini dalam tempo yang sangat
singkat diterima pasar dengan
sangat cepat.

Terbukti, hampir semua
produsen notebook terkemuka
saat ini sudah mengaplikasikan
teknologi yang berkiblat pada
protocol wireless 802.11a dan
802.11b ini dalam jajaran seri
produk notebook

mereka.Dengan kecanggihan
teknologi yang diusungnya,
membuat notebook yang pada
tahun ini mengalahkan PC
desktop dari sisi total
penjualan ini dapat terhubung
ke dalam jaringan secara
wireless kapan pun dan
dimana pun dengan sangat
mudah.

Teknologi yang diklaim
mampu meningkatkan
performa notebook,
memperpanjang umur baterai,
membuat notebook semakin
tipis, dan dapat
mengintegrasikan notebook
dalam jaringan wireless
dengan mudah ini memang
cukup fenomenal.  Tanpa
memerlukan perangkat
tambahan apapun, notebook
yang ada dapat terkoneksi
dalam sistem jaringan secara
optimal, asalkan notebook
tersebut masih dalam
jangkauan hots pot terdekat.

Teknologi wireless pun
sepertinya akan lebih
berkembang lagi di masa
depan. Dengan dukungan
banyak pihak yang
berkepentingan plus adanya
protokol baru yaitu 802.16 yang
mengakomodasi protokol-
protokol sebelumnya
memungkinkan penggunaan
teknologi ini akan bertambah
luas lagi. PC+

“It is  PC or HiFi Ste-
reo?” begitu

pertanyaan yang
muncul di layar moni-

tor ketika
pengunjung pertama

kali memasuki situs
produsen komponen

PC Micro Star Interna-
tional (MSI).

Pertanyaan ini
mengacu pada salah

satu produknya yang
tak bisa disebut lagi
sebagai sebuah per-

sonal computer biasa.

esungguhnya
pertanyaan
ini bukanlah perta-
nyaan biasa, tetapi

pertanyaan yang mengandung
banyak arti. Dipastikan perta-
nyaan semacam ini akan banyak
terucap oleh  para pembeli PC
awal alias new bie begitu meli-
hat deretan PC multimedia yang
lebih mirip sebagai HiFi Stereo.

Fenomena seperti ini
memang bukan cerita baru. PC
sebagai perangkat elektronik
dari awal memang diprediksi
bakal menjadi perangkat elek-
tronik yang serba multifungsi
dan serba bisa, termasuk untuk
fasilitas multimedia. Ramalan
tersebut memang sama sekali
tidak meleset. Seiring perkem-
bangan jaman, banyak perang-
kat yang bisa disandingkan

dengan seperangkat PC untuk
kemudian digabungkan menjadi
sistem multimedia.

Ini memang tak lepas dari
perkembangan hardware dan
software pada PC yang membuat
PC menjadi bukan saja sebagai
sarana pembantu pekerjaan tapi
juga sebagai sarana hiburan.
Paling sederhana misalnya PC

yang dirangkai dengan speaker.
Kemampuan yang dimiliki PC
tidak lagi hanya sekadar
menyajikan gambar visual tetapi
juga audio. Orang lalu dengan
mudah sudah berani menyebut
gabungan dua perangkat  ini
sebagai perangkat multimedia.

Nyatanya, pemahaman
semacam amatlah sederhana.

Kemampuan PC yang terus
berkembang membuat
pemahaman orang tentang
multimedia pun menjadi
lebih kompleks. PC sebagai
perangkat multimedia
haruslah sebuah PC yang
punya spesifikasi tertentu
sehingga fungsinya bisa
dinikmati dalam banyak
aspek, semisal untuk
menikmati gambar video
secara utuh, animasi, teks,
grafis, dan lain-lain.

PC sebagai sarana
multimedia inilah yang
kemudian terus
dikembangkan oleh
sebagian besar produsen
komponen PC. Salah satu
usaha ke arah itu yang
paling “sederhana” adalah
munculnya beragam

motherboard yang mengusung
banyak fitur untuk mendukung
sistem yang lebih bersifat
multimedia. Sebut saja fitur kartu
grafis onboard, dan kartu suara
onboard yang merupakan usaha
untuk menghadirkan audio visual
yang paling sederhana.

Tak hanya itu, di tahun 2003
ini beberapa produsen besar

bahkan sudah lebih bergerak
maju lagi dengan
menghadirkan PC yang sudah
siap dengan sederetan
perangkat multimedia terkini.
Sebut misalnya MSI yang
menghadirkan produknya yang
diberi nama Mega PC, Asus
yang mengeluarkan DiGimatrix,
atau Acer Aspire RC500 atau
deretan produk lain yang
merupakan perpaduan antara
PC kelas performance dan HiFi
audio dan home theater.

Selain sebagai sebuah PC
dengan fungsi-fungsi
standarnya, model-model PC
semacam ini memang
dilengkapi pula dengan fitur-
fitur audio video yang modern.
Rata-rata produk berukuran
super mini yang menyertakan
remote control sebagai fitur
pendukungnya ini menyertakan
kemampuan memutar film,
musik, atau menjalankan game
3D. Bahkan, beberapa juga
dilengkapi dengan TV tuner
sehingga program siaran TV
maupun radio bisa dinikmati
melalui perangkat semacam ini
dengan berbagai fitur dan
software pendukungnya.
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Dengan teknologi wireless, akses ke jaringan kapanpun dan
dimanapun dapat dilakukan

Mungil, ramping namun memiliki banyak fitur adalah ciri PC multimedia
modern yang tengah berkembang
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Menariknya, beberapa
model semacam ini sudah
mampu menjalankan beragam
fungsi secara terpisah. Untuk
menjalankan fitur HiFi Stereo
maupun home theater misalnya,
pengguna sudah tidak perlu
repot lagi menyalakan PC
sebelumnya. Cukup
diperlakukan seperti layaknya
sebuah DVD player atau CD
player biasa. Selain lebih
menghemat daya listrik yang
digunakan, waktu yang
diperlukan untuk menjalankan
kedua fitur ini pun bisa
dipangkas. Tidak seperti PC
konvensional yang harus

menyalakan PC secara
keseluruhan baru bisa
menjalankan fungsi audio video
yang ada. Namun demikian, fitur-
fitur ini juga tetap bisa
dijalankan saat mode PC
dinyalakan.

Tidak hanya itu, dari sisi fitur
tambahan lain yang diberikan,
sistem PC model ini juga lebih
kaya. Sebagian besar dari produk
yang dipasarkan juga
menyertakan card reader untuk
beberapa tipe storage secara
terintegrasi sehingga beragam
jenis storage bisa diakomodasi.
Tambahan lainnya adalah fitur
jaringan ataupun modem untuk

akses ke dunia maya. Itu belum
lagi perangkat input output
modern semisal firewire 1394,
USB 2.0 yang biasanya tak lupa
disertakan agar sistem seperti ini
dapat dikoneksikan dengan
beragam perangkat semisal
handycam, printer, scanner, dan
lain-lain.

Sebagai PC modern,
motherboard yang
mendukungnya juga memiliki
beberapa fitur yang
memungkinkan adanya ekspansi
ataupun upgrade di masa da-
tang. Namun, mengingat ukuran
motherboard-nya yang rata-rata
relatif kecil, kemampuan ekspansi
untuk menampung perangkat
tambahan memang lebih
terbatas. Meski umumnya tetap
menyertakan port AGP untuk
mendukung upgrade fasilitas
grafisnya, slot PCI yang
disertakan biasanya lebih
terbatas. Begitu pula untuk
ekspansi fitur-fitur lainnya.

Uniknya, ciri khas dari
perangkat PC yang sangat cocok
untuk lingkungan yang memiliki
ruang terbatas  ini adalah ben-
tuknya yang mungil dan sudah
tidak mirip sama sekali dengan
PC konvensional.

Ini tidaklah mengherankan
mengingat sistem PC semacam ini
rata-rata merupakan
pengembangan dari sistem
barebone PC yang sudah lebih

dahulu ada yang memang
dirancang untuk meminimalisir
ukuran PC sehingga ruang untuk
PC bisa lebih dihemat.

  Merancang sistem PC multi-
media yang mungil seperti ini
tentu bukanlah perkara gam-
pang. Selain desain dan tata letak
perangkat-perangkat bawaannya
yang harus cermat, sistem
pendingin yang dimiliki juga
harus diperhatikan betul
mengingat sistem semacam ini

bisa jadi akan dipakai sepanjang
waktu untuk beragam keperluan.
Tak heran jika sistem pendingin
dari sistem yang rata-rata hanya
mengusung motherboard,
perangkat drive optik seperti

DVD atau CD-ROM ini memiliki
desain yang khusus.

Ke depannya, bisa jadi sis-
tem PC multimedia berbasis
barebone semacam ini akan
menjadi perangkat rumah ida-
man buat semua pengguna
PC. Bagaimana tidak. Selain
ukuran-nya yang sangat he-
mat tempat, hanya dengan
satu perangkat seperti ini,
beragam fungsi bisa dijalan-
kan dengan kualitas lumayan.

Bisa jadi ke depannya, selain
ukurannya yang makin mini,
kemampuannya pun bisa jauh
lebih hebat dari sekarang.
Kita tunggu saja perkem-
bangan selanjutnya. PC+

Meski tempat terbatas, PC multimedia yang merupakan
pengembangan dari barebone PC tetap mengusung fitur input
output yang lengkap

Rampingnya bentuk yang diusung mengharuskan pembuatnya
mendesain secara khusus sistem pendinginnya
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Anda yang menyukai
pemrograman

komputer tentunya
pernah mengalami

betapa repotnya
menggunakan com-

piler yang berbasiskan
command line. Source
code perlu dituliskan

dahulu pada editor
teks (seperti Notepad
atau MS-DOS Editor),

lalu di-compile
dengan mengetikkan

perintah tertentu
pada command line.

eringkali (dan
memang wajar) terjadi
bahwa compiler
melaporkan adanya

kesalahan sehingga Anda keluar
dari modus kompilasi dan
membuka kembali editor teks,
demikian seterusnya hingga
program yang anda buat
berjalan sebagaimana mestinya.

Saat ini untuk memudah-
kan dalam melakukan pemro-
graman, biasanya para devel-
oper bahasa pemrograman me-
nyediakan suatu IDE (Integrated
Development Enviroment).
Anda tak perlu lagi melakukan
pengetikan, kompilasi, pelaca-
kan kesalahan (debugging) dan
berbagai macam aktivitas lain
secara terpisah, karena
semuanya telah disatukan ke
dalam suatu lingkungan
pemrograman yang terintegrasi.

Permasalahannya sekarang,
IDE semacam ini biasanya hanya
tersedia pada versi komersial
dari suatu bahasa
pemrograman, sementara untuk
versi gratisannya hanya tersedia
command line compiler yang
berjalan pada mode MS-DOS.

Kini untuk mengatasi
masalah tersebut, Anda hanya
membutuhkan Programmer's
File Editor (PFE), sebuah utiliti
yang menyediakan IDE untuk
Windows 9x/ME/NT/2000.
Program karya Alan Philips ini
dapat Anda peroleh di http://
www.lancs.ac.uk/people/cpaap/
pfe/  berupa file Pfe101i.zip
(608KB) yang perlu Anda
ekstrak dahulu.

Sebagai contoh
penggunaannya, berikut ini
langkah-langkah konfigurasi
untuk memberikan IDE bagi
compiler C/C++ Digital Mars
(www.digitalmars.com) :
1. Buka PFE32.exe, dan klik

[Option]>[Default Modes...]
2. Klik [Edit Mode Groups...] ,

pilih New...
3. Isikan C/C++ pada Mode

Group Name, dan *.c;*.cpp
pada Filename Patterns. Klik
[OK] dua kali. Sekarang anda
dapat melihat pilihan C/C++
pada bagian Files whose
name is in mode group.

4. Klik [Edit Modes...]
Pada tahapan ini Anda

dapat menentukan konfigurasi
yang diinginkan bila mengedit

source code C/C++, melalui menu
Mode Type.

Berikut ini konfigurasi yang
penulis sarankan:
1. Display.

Beri tanda centang pada
Display line numbers.

2. Input.
Beri tanda centang pada
Auto-indent new lines dan
Strip trailing spaces when
newline typed.

3. Language Awareness.
Pilih C.

4. Saving.
Hilangkan tanda centang pada
Make backup of original file.

5.  Text Formatting.
Pada Tabs, pilih Tab with
space characters (Soft tabs) ...,
dan isikan 4 pada Tab stop
every xx characters.
Beri tanda centang Enabled
pada Text Wrapping...
Bila selesai, klik Apply Now,
OK dan Close

5. Pilih menu [File]>[New...]
(atau Ctrl-N)
Pada jendela editor yang
terbuka ketikkan source code
C/C++, misalnya:
#include <stdlib.h>
#include <iostream.h>
main()
{
cout << “Hello, world!” <<
endl;
system("PAUSE");
return 0;
}
atau Anda dapat copy-paste
dari source-code yang sudah
jadi.

Tekan Ctrl+S, lalu simpan
dengan ekstensi c atau cpp.
Jangan Anda tutup dahulu
file tersebut, karena masih
dibutuhkan untuk pengujian
eksekusi compiler.

6. Pilih menu [Execute]>[DOS

Command to window...] (F11)
Pada tahapan ini anda

menentukan eksekusi dari
compiler. Karena yang
dipergunakan adalah compiler C/
C++ Digital Mars berupa file

sc.exe yang terletak pada
c:\dm\bin (sesuaikan dengan
direktori Anda) maka isikanlah
pada kolom Command
c:\dm\bin\sc %u\%d%s%f. Pada
kolom Directory, isikan
%u\%d%s%f.  Klik [OK].

Bila proses kompilasi berja-
lan lancar, Anda akan mendapat-
kan tampilan seperti Gambar 1.

Perlu diingat bahwa Anda
baru menentukan KOMPILASI
dari program dan oleh karena itu

perlu dibuat juga menu RUN
untuk menjalankan program
yang telah jadi.

Sekali lagi, jangan Anda
tutup window source code C/
C++.

Langkah-langkahnya
adalah seperti berikut ini:
1. Klik menu Launch Applica-

tion ... (Shift + F11)
2. Isikan %u\%d%s%n.exe

pada Command, dan
%u\%d%s pada Directory.
Buang tanda centang pada
Iconise editor when com-
mand starts. Klik [OK].

Bila sukses maka tampilan
yang akan muncul adalah
seperti terlihat pada Gambar 2.

Kini Anda telah memiliki
IDE bagi compiler C/C++.
Bahkan lebih dari itu,  anda
juga bisa memanfaatkannya
untuk membuat IDE bagi
compiler lain yang berjalan
pada MS-DOS mode juga seperti
assembler (TASM), tentunya
dengan memberikan mode
group yang berbeda.

Tergantung dari bahasa
pemrograman yang saat ini
sedang dipelajari, Anda
tinggal menggantinya melalui
menu [Option]>[Default

mode]>[File whose name is in
mode group] dan
menyesuaikan menu
KOMPILASI (F11) dan RUN
(Shift + F11) seperti diatas.

Happy programming! PC+

Gambar 1

Gambar 2

Arif Hendra Saptadi
ariefhs@operamail.com
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Software merupakan
salah satu unsur vital

dalam dunia
komputer. Setiap hari

software digunakan
untuk berbagai

keperluan seperti
pekerjaan, belajar,

dan hiburan. Itulah
sebabnya mengapa

software banyak
dicari oleh para

pengguna PC. Namun,
di Indonesia, orang
tidak mencari soft-

ware asli, melainkan
software bajakan.

ndonesia berada
di urutan ke tiga
dalam urusan bajak-
membajak software.

Posisi jawara dipegang oleh
Cina dan diikuti oleh Vietnam di
posisi ke dua. Mengapa soft-
ware bajakan begitu banyak di
Indonesia?

MEMBAJAK ITU MUDAH
Inilah salah satu alasannya,

membajak itu mudah. Seorang
pemilik PC, yang dilengkapi
oleh CD writer, berpotensi
untuk membajak software.
Andai saja orang itu memiliki
otak bisnis yang licik, PC-nya
bisa digunakan untuk mencari
uang dengan menjual software
bajakan dan meraup
keuntungan yang tidak sedikit.

Harga CD-writer yang
berkisar Rp.400.000,00 masih
bisa terjangkau. CD-R ada yang
dihargai Rp.2.000,00. Kotak CD
berharga Rp.2.000. CD
bajakannya bisa ia jual dengan
harga Rp. 10.000,00. Anggaplah
dalam satu hari ia bisa
menghasilkan 20 keping CD,
dan semuanya terjual habis.
Berarti, ia bisa menghasilkan
uang Rp. 200.000,00 dalam 1
hari. Dan dalam satu bulan,
meskipun sudah dipotong biaya
lain-lain seperti biaya listrik,
sablon CD, cetak cover, kopi,
serta snack, ia sudah meraih
keuntungan yang besar.

Bahkan dengan CD writer
yang lebih canggih, yang
mampu menulis di banyak CD
sekaligus, pembajakan bisa
dilakukan lebih cepat. Dan,
tentu saja, keuntungan yang
bisa diperoleh lebih banyak.

Nah, karena software
sangat diperlukan, didukung
lagi dengan cara membajaknya
mudah, software bajakan
menjadi sangat banyak di
Indonesia. Dan, software
bajakan menjadi sangat laku
karena harga software asli di
luar jangkauan rata-rata peng-
guna PC di Indonesia sehingga
membuat distribusi software
bajakan menjadi sangat besar.

MACAM-MACAM
PEMBAJAKAN

Pembajakan yang
sebelumnya dijadikan contoh

hanya merupakan satu jenis
pembajakan, yaitu end-user
piracy. Pembajakan yang
termasuk end-user piracy adalah
menggunakan software dengan
lisensi untuk satu komputer di
banyak komputer, menyalin CD,
atau disket berisi software untuk
didistribusikan, dan
menggunakan software dengan
lisensi pendidikan atau non-
commercial untuk kepentingan
lain.

Jenis pembajakan yang lain
adalah Internet piracy.
Pembajakan yang dilakukan
dengan menggunakan Internet
bisa berupa penyediaan software
yang bukan freeware untuk di-
download dan digunakan secara
gratis, Web site yang
menyediakan software bajakan
untuk dijual, dan pendistribusian
software dengan menggunakan
aplikasi peer-to-peer seperti
Kazaa dan i-Mesh. Web site yang
menyediakan nomor seri untuk
sebuah software juga termasuk
dalam pembajakan jenis ini.

Ada sebuah jenis
pembajakan yang contohnya
seperti ini. Ada sebuah
perusahaan yang menggunakan
jaringan. Server jaringan itu diisi
dengan software yang dapat
digunakan oleh seluruh
karyawan perusahaan. Ada
software yang berlisensi untuk
digunakan oleh sejumlah orang.
Namun, ada pula software yang
tidak berlisensi seperti ini. Nah,
penggunaan software yang tidak
memiliki lisensi ini, apabila
digunakan secara keroyokan,
maka pembajakan sudah terjadi.
Penggunaan software yang
memiliki lisensi untuk digunakan
keroyokan pun masih memiliki
aturan. Biasanya, jumlah
penggunanya dibatasi. Jika
jumlah penggunanya lebih dari
perjanjian, maka itu namanya
pembajakan.

Pembajakan seperti ini
bernama client-server overuse.

Harddisk loading adalah
jenis pembajakan lainnya.
Pembajakan seperti ini sering
muncul pada saat pembelian PC.
Masih ingat beberapa tahun yang
lalu, pada saat Microsoft
menuntut beberapa toko
komputer di Mangga Dua ke
pengadilan karena menyertakan
Microsoft Windows di PC yang
mereka jual? Penyertaan
Microsoft Windows secara cuma-
cuma di PC yang mereka jual itu
adalah salah satu contoh
pembajakan jenis harddisk
loading.

Tidak semua software yang
dikemas dalam kotak yang bagus
dan disertai dengan buku
manual, kartu registrasi, dan

selipan lainnya adalah software
asli. Pembajak bisa pula membuat
kemasan yang sama persis de-
ngan kemasan software asli. Pem-
bajakan jenis ini dinamakan soft-
ware counterfeiting. Tidak hanya
kemasannya saja yang menye-
rupai asli, pembajakan seperti ini
juga membuat isi kemasan yang
sama persis dengan isi kemasan
software asli.

MENGATASI
PEMBAJAKAN

Para produsen soft-
ware sudah membuat
cara agar software
mereka tidak dapat
dibajak. Tapi ternyata,
semakin canggih
teknologi proteksi,
semakin canggih pula
teknologi si pembajak.

Cara yang paling
sering digunakan oleh
para produsen software
adalah dengan membe-
rikan nomor seri yang
dimasukkan pada saat
penginstalan atau pada
saat software pertama
kali digunakan. Satu
langkah sederhana ini
dianggap mampu mencegah
terjadinya peng-copy-an software
secara ilegal.

Namun ternyata cara ini
tidak efektif. Buktinya, software-
software bajakan bisa
menyertakan nomor seri di dalam
CD, sehingga software bisa
berjalan layaknya software yang
dibeli secara legal.

Pencegahan lain adalah
dengan menggunakan aktivasi.
Software yang belum di-register
tidak dapat digunakan atau be-
berapa fungsi vitalnya dimatikan.
Biasanya aktivasi dilakukan me-
lalui Internet. Proses aktivasi ber-
jalan dengan cara memeriksa no-
mor seri yang pernah kita masuk-
kan, kemudian memeriksa kevali-
dan nomor itu. Kalau nomor itu
valid dan belum pernah diguna-
kan, software dapat digunakan.

Karena penyakit sudah
menjangkit, obatlah yang
dibutuhkan. Karena pembajakan
sudah merajalela di Indonesia,
mulai tanggal 29 Juli 2003,
Undang-undang No. 19 Tahun
2002 mengenai HaKI pun berlaku
efektif. Dan, memang benar-
benar efektif untuk jangka waktu
yang sangat singkat.

Satu hari sebelum UU HaKI
berlaku, beberapa pemilik toko
software bajakan di mal Mangga
Dua tampak sibuk merombak
toko mereka sehingga tidak
tampak seperti toko software
bajakan. Beberapa toko bahkan
sudah tidak lagi beraktivitas alias
tutup. Tapi, ada juga beberapa

toko yang tetap buka walaupun
diiringi dengan perasaan was-was
pemiliknya.

Kemudian, selama beberapa
hari setelah UU HaKI
diberlakukan, mal Mangga Dua
bersih dari toko software
bajakan. Tapi setelah itu, ada
sedikit toko software bajakan
yang mulai berani menggelar
kembali dagangannya. Hari-hari

selanjutnya jumlah toko yang
kembali aktif semakin
bertambah. Dan sampai terakhir
kali PCplus berkunjung ke sana,
toko software sudah banyak yang
beroperasi seperti biasa, seolah-
olah UU HaKI tidak pernah
berlaku.

KERUGIAN AKIBAT
PEMBAJAKAN

Tentu saja pihak pertama
yang dirugikan adalah para
produsen software. Selain karena
mereka tidak memperoleh apa-
apa dari hasil penjualan, usaha
keras para programmer mereka
seolah-olah tidak dihargai.
Business Software Aliance (BSA)
memperkirakan produsen
software merugi sampai
US$13,000,000,000 setiap tahun
akibat pembajakan.

Negara pun turut dirugikan.
Seharusnya, negara dapat me-
narik pajak dari hasil penjualan
software (dan digunakan kembali
untuk kepentingan rakyat).
Namun demikian, karena yang
para konsumen membeli soft-
ware bajakan, negara tidak dapat
menarik pajak dari produsen
software.

Pembajakan memiliki imbas
untuk produksi software lokal.
Seharusnya, software lokal
mampu memenangkan kompetisi
dalam hal harga. Namun, karena
software luar negeri yang
mungkin kualitasnya lebih bagus
dibajak dan dijual dengan harga
yang sangat murah, sekitar

Rp.10.000,00-Rp.20.000,00,
software lokal menjadi
terpendam. Mana mau mereka
susah-susah membuat software
yang dihargai dengan selembar
uang sepuluh ribuan. Ini meng-
hambat produksi software lokal.

Bagi end-user, penggunaan
software bajakan menghalangi
mereka untuk mendapat
layanan lebih dari produsen

software. Pengguna software
bajakan lebih sulit untuk
memperoleh patch untuk
menambal bug pada software.
Sedangkan bagi perusahaan,
beberapa produsen software
menyatakan bahwa dengan
membeli software mereka
secara legal, perusahaan tidak
hanya membeli software, tapi
juga membeli layanan seperti
penginstalan dan maintenance.

ASLI ATAU BAJAKAN?
Coba tanyakan pertanyaan

ini kepada mahasiswa. Jawaban
mereka, bajakan, karena murah.
Ironis, memang. Harga software
yang sangat tinggi bagi
kantong sebagian besar
pengguna komputer di Indone-
sia membuat mereka lebih
memilih bajakan. Kalau saja
harga software di Indonesia
diturunkan, harganya pun tidak
bisa serendah software bajakan,
bahkan mungkin masih tetap di
luar jangkauan.

Lalu, bagaimana agar tetap
dapat menggunakan software
secara legal selain membeli
yang asli? Software open-source
adalah jawabannya. Perkemba-
ngan software open-source me-
mang meningkat pesat di tahun
2003. Apalagi dengan berlaku-
nya HaKI.

Tapi, open-source menjadi
masalah bagi para gamer
karena banyak game tenar
belum bisa dijalankan di sistem
operasi open-source. PC+

I ARE/PCplus

Kebutuhan akan software, modal kecil, dan keuntungan besar memicu
pembajakan software
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tertentu. Tidak semua orang
bisa mengerti arti dari sebuah
pemrograman yang ditulis
dengan menggunakan high-
level language. Paling tidak,
orang itu harus mengerti dasar
pemrograman lebih dulu.

Biasanya, high-level
language memiliki sifat por-
table. Artinya, program yang
dihasilkan dengan
menggunakan high-level
language dapat berjalan di
berbagai platform. Misalnya,
sebuah pemrograman yang
dihasilkan dengan
menggunakan Javascript dapat
digunakan di PC, Macintosh,
Windows, atau Linux.

Contoh bahasa
pemrograman yang termasuk
high-level language adalah
Pascal, Fortran, Cobol, C/C++,
dan Javascript.

Bahasa pemrograman di
bawah high-level language
adalah assembly. Pada level ini,
tata bahasa dan
perbendaharaan kata lebih sulit
dimengerti. Bahkan, seseorang
harus benar-benar mengerti apa
itu bahasa assembly, baru ia bisa
memahami isi kode program.
Bahasa assembly sulit
dimengerti karena perintah-
perintah ditampilkan dalam
bentuk kata yang tidak memiliki
arti dalam bahasa sehari-hari.
Bahasa ini hanya satu tingkat di
atas bahasa mesin (machine
language).

Machine language sudah
benar-benar tidak dapat
dimengerti oleh sebagian besar
manusia. Mesin menggunakan
suatu set angka dan karakter
yang sudah benar-benar tidak
merepresentasikan apa yang
dimaksud.

Saya adalah seorang
pemula di dunia TI.

Saya ingin bisa
membuat program

sendiri. Bahasa
pemrograman apa

yang sebaiknya saya
pelajari? Apakah C++,

VB, atau lain-lain?
Saya sedang bingung

memilih.

ahasa
pemrograman
apa yang sedang
banyak dipakai, atau

terkenal, dan yang bakal akan
terkenal atau digunakan di
masa depan? Soalnya, saya
tidak mau ilmu yang saya
pelajari nanti tidak dapat
dipakai untuk kemudian hari
(tidak tren lagi).

Sebenarnya saya masih
bingung dengan bahasa
pemrograman bagaimana sih
sistem kerjanya (secara umum)
serta bagaimana cara kerjanya
(kok sering hanya mengetik
angka saja)?

Itulah tiga contoh e-mail
yang masuk ke redaksi yang
pertanyaannya berhubungan
dengan bahasa pemrograman.
Masih banyak e-mail yang berisi
pertanyaan yang senada. Oleh
karena itu, kali ini PCplus
membahas bahasa
pemrograman secara khusus.

PENGERTIAN BAHASA
PEMROGRAMAN

Komputer dan manusia.
Masing-masing memiliki bahasa
yang berbeda. Komputer
berbahasa mesin, sedangkan
manusia berbahasa Indonesia,
Inggris, Jepang, Jawa, dan
bahasa-bahasa lain. Dalam
membuat program, manusia
memberikan perintah agar
komputer melakukan berbagai
pekerjaan. Manusia tidak
memberikan perintah
menggunakan bahasa sehari-
hari, melainkan menggunakan
bahasa yang sudah memiliki

perbendaharaan kata dan tata
bahasa khusus. Bahasa itulah
yang disebut dengan bahasa
pemrograman.

Jadi, secara ringkas, bahasa
pemrograman dapat

didefinisikan sebagai suatu
bahasa dengan perbendaharaan
kata dan tata bahasa khusus yang
memberikan perintah kepada
komputer untuk menjalankan
pekerjaan tertentu.

Istilah bahasa pemrograman
sering digunakan untuk mengacu
kepada bahasa pemrograman
tingkat tinggi (high-level lan-
guage). Padahal tidak. Bahasa
pemrograman dibagi menjadi
beberapa jenis, di mana salah
satunya adalah high-level
language.

JENIS-JENIS BAHASA
PEMROGRAMAN

Bahasa pemrograman yang
tersedia sangat banyak. Mungkin
inilah yang menjadi sebab
kebingungan pembaca PCplus
yang mengirimkan e-mail yang
berisi pertanyaan yang tadi sudah
disebutkan. Namun demikian,
secara umum, bahasa

pemrograman dapat dibagi
berdasarkan level dan
pengaplikasiannya.

Bahasa pemrograman dibagi
menjadi empat jenis berdasarkan
levelnya. Level ini menandakan

siapa yang bisa mengerti bahasa
itu. Apakah manusia? Apakah
komputer? Semakin tinggi
levelnya, bahasa pemrograman
itu semakin mudah dimengerti
oleh manusia. Sedangkan,
semakin rendah levelnya, bahasa
pemrograman itu semakin sulit
dimengerti oleh manusia.

Program atau software
dapat diaplikasikan di berbagai
bidang. Bahasa pemrograman
yang digunakan untuk
menghasilkan suatu program di
bidang tertentu belum tentu
sama dengan bahasa
pemrograman yang digunakan
untuk menghasilkan program di
bidang lain. Bahasa
pemrograman dibedakan
menjadi enam jenis berdasarkan
pengaplikasian program.

BERDASARKAN LEVEL
Jenis bahasa pemrograman

yang ada berdasarkan level

adalah declarative language,
high-level languave, assembly,
dan machine language. Masing-
masing jenis itu dibahas berikut
ini.

Level yang paling tinggi
adalah declarative language yang
artinya sangat mudah dimengerti
oleh manusia. Bahkan, orang
yang tidak mempelajari bahasa
pemrograman pun bisa mengerti
bahasa ini. Hal ini disebabkan
oleh penggunaan bahasa sehari-
hari untuk memberikan perintah
kepada komputer. Contoh bahasa
pemrograman ini adalah SAS dan
SPSS, yang digunakan untuk
urusan statistik. Bahasa
pemrograman lain yang termasuk
di level ini adalah SQL.

Contoh penggunaan SQL
adalah seperti berikut ini. SELECT
NAME WHERE CITY=JAKARTA.
Sintaks itu amat mudah
dimengerti. Dari sintaks itu bisa
disimpulkan bahwa ada tabel
yang berisi nama (NAME) dan
kota (CITY), serta mungkin juga
berisi informasi lain seperti
nomor telepon, e-mail, dan jenis
kelamin. Sintaks itu mengandung
arti memilih nama (NAME) yang
tinggal di kota (CITY) Jakarta.

Bahasa pemrograman yang
levelnya berada di bawah
declarative language adalah
high-level language. Bahasa
pemrograman level inilah yang
paling sering digunakan untuk
membuat program. Karena inilah
mengapa pengertian bahasa
pemrograman seolah-olah
menjadi milik mereka.

High-level language masih
menggunakan bahasa manusia
sehari-hari (biasanya Bahasa
Inggris), namun dirangkai
dengan sintaks yang
menggunakan simbol-simbol

IS
TI

M
EW

A

Bahasa Pemrograman adalah perantara agar manusia dapat
memberikan perintah kepada komputer
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Pemrograman menampilkan
perbandingan antara high-level
language, assembly, dan
machine language. Pascal, yang
termasuk high-level language,
menjabarkan z adalah jumlah w
ditambah dengan hasil kali
antara x dengan y dengan
sintaks yang bisa dimengerti.
Tapi, assembly dan machine
language menggunakan sintaks
yang rumit, yang lebih dari satu
baris.

BERDASARKAN
PENGAPLIKASIAN

Program yang dihasilkan
dengan menggunakan bahasa
pemrograman digunakan di
berbagai bidang. Berdasarkan
bidang-bidang itu bahasa
pemrograman dibagi menjadi
scientific application, business
application, artificial intelli-
gence, system programming,
scripting languages, dan special-
purposed language. Berikut ini
adalah penjelasan masing-
masing jenis.

Scientific application adalah
aplikasi yang digunakan sebagai
alat hitung untuk keperluan
ilmiah. Karena berfungsi
sebagai alat hitung, bahasa
pemrograman untuk membuat
scientific application harus
memiliki struktur data yang
sederhana namun mendukung

PASCAL ASSEMBLY MACHINE

Z:=W+X*Y L 3,X 41 3 0C1A4
M 2,y 3A 2 0C1AB
A 3,w 1A 3 0C1A0
ST 3,z 50 3 0C1A4

TABEL PERBANDINGAN
BAHASA PEMROGRAMAN

mahir menggunakan high-level
language, kemampuan bisa
ditingkatkan dengan
mempelajari bahasa assembly.

Kalau orang yang termasuk
pemula bisa memilih belajar
bahasa pemrograman seke-

hendak hati, tidak
demikian halnya
orang yang sudah
berkecimpung di
dunia kerja. Mereka
harus pintar-pintar
memilih bahasa
pemrograman yang
mereka pelajari
agar tetap dapat
dipakai oleh
perusahaan tempat
mereka bekerja.

Bahasa
pemrograman yang
dipilih lebih baik
sesuai dengan
pengaplikasian
program yang
dihasilkan. Untuk
keperluan membuat
situs misalnya,
bahasa
pemrograman yang

dipakai adalah HTML. Tapi, bisa
saja sebuah program dibuat
dengan mengombinasikan
beberapa bahasa
pemrograman. Tentu saja ini
harus sesuai kebutuhan.

Sebenarnya, setelah
menguasai sebuah bahasa
pemrograman, untuk belajar
bahasa pemrograman lain tidak
sulit. Karena konsep dasar
pemrograman selalu sama, yaitu
algoritma. Bahasa
pemrograman hanya alat untuk
menerjemahkan algoritma ke
bahasa yang bisa dimengerti
oleh komputer.  PC+

penghitungan angka-angka
dalam jumlah besar. Struktur
data yang biasa digunakan
adalah array dan matriks.
Biasanya bahasa pemrograman
untuk membuat scientific
application berasal dari high-level
language.

Bahasa pemrograman yang
pertama kali digunakan untuk
pembuatan business application,
aplikasi yang dibuat untuk
memenuhi keperluan bisnis,
adalah Cobol. Karakteristik

bahasa
pemrograman
yang digunakan
untuk business
application
adalah adanya
mampu untuk
membuat
aplikasi yang
dapat

menghasilkan laporan, mampu
berurusan dengan angka-angka
desimal, serta mendukung
operasi aritmatika.

Bidang berikutnya adalah
artificial intelligence alias
kepandaian buatan. Sering pula
disebut dengan istilah keren,
intelegensi semu. Aplikasi seperti
ini dibuat dengan bahasa
pemrograman yang mampu
melakukan perhitungan rumit
berdasarkan data-data yang
diperolehnya. Misalnya saja,
super computer milik IBM yang
bernama Deep Blue yang mampu
mengalahkan Gary Kasparov
karena sudah mengenal taktik
juara catur dunia itu dari hasil
perhitungannya. Bahasa
pemrograman yang terkenal
untuk membuat artificial
inteligence adalah LISP dan
Prolog.

System programming adalah
pemrograman untuk membuat
system software. System software
sendiri adalah bisa berupa
operating system, debugger, dan
compiler, yang mengatur re-
source komputer. Contoh bahasa
pemrograman untuk
membuat system
software adalah PL/S.

Scripting lan-
guage adalah bahasa
pemrograman yang
biasanya sangat
sederhana dan tidak
perlu di-compile. Jenis
pemrograman seperti
ini dibaca per baris.
Satu baris adalah satu
perintah. Contoh
bahasa pemrograman
ini adalah sh (shell),
Perl, dan Javascript.

Satu lagi ada
special-purposed
language yang hanya
dapat digunakan
untuk tujuan
tertentu. Contoh
bahasa ini adalah
RPG, yang khusus
untuk menghasilkan laporan
bisnis.

MEMILIH BAHASA
PEMROGRAMAN

Secara singkat, PCplus
pernah membahas bagaimana
memilih bahasa pemrograman
pada edisi 150. Sekarang, PCplus
akan lebih merinci bagaimana
memilih bahasa pemrograman.

Evolusi bahasa pemrograman
belum selesai. Setiap tahun, ada
saja pengembangan atau bahkan
pemunculan bahasa
pemrograman.
Perkembangannya dimulai dari

tahun 1957, pada saat Fortran
pertama kali dikenalkan, sampai
C# yang dikenalkan pada tahun
2002.

Para pemula, yang ingin
belajar bahasa pemrograman,
bisa menggunakan high-level

language seperti C++ dan Java,
karena dengan sintaks yang
masih menggunakan bahasa
sehari-hari memudahkan para
pemula ini untuk mempelajari
algoritma. Algoritma adalah
suatu rumusan untuk
memecahkan masalah. Contoh
algoritma yang dapat dijumpai
dalam kehidupan sehari-hari
adalah resep untuk membuat
kue. Resep yang menjelaskan
bahan-bahan serta cara
mengolah bahan itulah yang
disebut dengan algoritma. Pada
saat pemrograman, variabel serta
logika adalah algoritma. Setelah

Contoh pemrograman dengan bahasa C++ yang merupakan
high-level language. Bahasa pemrograman level ini cocok
digunakan pemula untuk belajar.
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Pesatnya
perkembangan

Teknologi Informasi
(TI) baik perangkat

keras maupun
perangkat lunaknya

di dunia telah
mendorong

pergerakan dan
perubahan perilaku
masyarakat di suatu

negara, tidak
terkecuali Indonesia.

ilihat dari
ketiga
komponen
utama (hardware,

software, brainware) dalam
usaha pemanfaatan TI ini,
faktor yang dinilai akan
membebani implementasinya
adalah masalah hardware dan
software yang sebagian besar
atau seluruhnya masih
merupakan komponen impor.
Masalah ketersediaan hard-
ware, memang kita masih akan
membutuhkannya dengan cara
impor. Sedangkan untuk
penggunaan software banyak
individu maupun organisasi
yang secara sengaja maupun
tidak disengaja telah
menggunakan perangkat lunak
yang beredar luas tanpa
membeli lisensi pemakaian
seperti yang telah
dipersyaratkan dalam hukum
dan peraturan nasional maupun
internasional. Mereka dapat
dikategorikan melakukan
pembajakan, sehingga dapat
dikategorikan telah melanggar
hukum hak cipta.

Praktek pembajakan
banyak dilakukan karena
mahalnya harga perangkat
lunak aplikasi, sebagai
gambaran suatu sistem operasi
yang sangat dikenal masyarakat
Indonesia seharga US$200 per
mesin dan untuk sistem operasi
jaringannya (network operating
system) seharga US$589. Coba
bayangkan berapa banyak
devisa yang harus dikeluarkan
oleh pemerintah maupun
organisasi hanya untuk membeli
perangkat lunak yang berlisensi
tersebut. Hal ini hanya dari sisi
sistem operasi, belum termasuk
aplikasi-aplikasi lainnya yang
terutama diperlukan mahasiswa
untuk mempelajari dan
mengembangkan suatu materi.

Praktek pembajakan
perangkat lunak yang sudah
membudaya akan menimbulkan
krisis penghormatan atas HAKI
(Hak Atas Kekayaan
Intelektual).  Ketika suatu
produk Teknologi Informasi
Indonesia diekspor, produk
tersebut akan dikenakan
penelitian terhadap asal produk
dan bahan baku berkaitan
dengan ada tidaknya
pelanggaran atas HAKI. Selain
itu juga akan melemahkan
semangat industri perangkat
lunak dalam negeri, karena

mereka beranggapan akan
merugi akibat produk perangkat
lunak yang dibuat juga akan
dibajak. Tindakan pembajakan
tidak sekadar menyangkut
masalah etika, namun lebih dari
itu tindak pembajakan memiliki
dampak ekonomi dan sosial yang
tidak menyenangkan.

Sebenarnya sudah tersedia
solusi alternatif bagi usaha
penghematan biaya
implementasi karena telah hadir
produk-produk perangkat lunak
komputer dengan model lisensi
baru yang menekankan pada
aspek keterbukaan (openness)
dan kebebasan (freedom) dalam
menggunakan perangkat lunak.
Keterbukaan berarti tidak ada
pembatasan apapun yang
diterapkan untuk usaha-usaha
melihat, mengamati, dan
mempelajari setiap aspek desain
dan implementasi dari perangkat
lunak. Kebebasan berarti
keterbukaan di atas berlaku
untuk setiap orang, bahkan
seseorang diijinkan untuk
menggunakan perangkat lunak
tersebut untuk berbagai
keperluan dan diijinkan untuk
melakukan modifikasi. Lisensi
tersebut adalah lisensi open
source.

OPEN SOURCE
Open source dapat diartikan

kode terbuka. Arti yang lebih
spesifik adalah program
komputer yang sudah dibuat
dapat diperoleh dalam bentuk
aslinya oleh pihak lain dengan
seluas-luasnya selain dari pihak
pembuat program komputer
tersebut. Selanjutnya, bahkan
dapat dilakukan perubahan pada
program sesuai dengan
keperluan pemakai atau
pengembangan selanjutnya.
Konsep open source tersebut
sangat berbeda dengan konsep
sebelumnya (closed source). Pada
konsep closed source, program
komputer hanya disebarluaskan
dalam bentuk binary yang siap
dijalankan di komputer, tetapi
tidak dapat dibaca atau
dimengerti.

Suatu perangkat lunak dapat
disebut Open Source yaitu jika
memenuhi kriteria sebagai
berikut (www.opensource.org)
:

• Free Redistribution
Tidak ada pembatasan lisensi

yang melarang distribusi
perangkat lunak atau
menggabungkan dengan
aplikasi-aplikasi lainnya. Tidak
ada royalti atau kompensasi
terhadap hak kekayaan
intelektual terhadap perangkat
lunak.

• Source Code
Source code dari perangkat

lunak harus tersedia dan dapat
diakses serta didistribusikan
dengan gratis oleh siapa saja. Jika
source code tidak disertakan
maka harus disediakan fasilitas
akses yang mudah. Tidak
diperkenankan menyembunyikan
sebagian dari source code atau
menyediakannya dalam bentuk
intermediate (object), harus
benar-benar dalam bentuk source
code tingkat pertama.

• Derived Works
Lisensi open source

memberikan hak kepada siapa
saja untuk mengubah source
code tersebut atau membuat
perangkat lunak lain berdasarkan
perangkat lunak tersebut tetapi
tetap dengan memberikan
penghargaan referensi kepada
penciptanya. Perangkat lunak
yang telah diubah atau
diturunkan harus didistribusikan
dengan syarat-syarat yang sama
dengan perangkat lunak open
source induknya.

• Integrity of the Author
  Source Code

Perangkat lunak yang
diturunkan dari lisensi open
source harus menjaga integritas
dari pencipta perangkat lunak
dengan tidak mempergunakan
kode konfigurasi yang sama
dengan perangkat lunak asal.

• No Discrimination Againts
   Persons or Groups

Lisensi tidak boleh
melakukan diskriminasi terhadap
seseorang atau sekelompok
orang. Open  source berlaku
untuk seluruh umat manusia
dengan hak yang sama.

• Distribution of License
Perjanjian lisensi open source

ini harus disertakan pada setiap
perangkat lunak dan harus
berlaku untuk setiap program
atau perangkat lunak yang
diturunkan  dari lisensi open
source.

• License Must not be Specific
  to a Product

Hak-hak yang diberikan oleh
lisensi tidak boleh berbeda
dengan yang terdapat pada
distribusi asli walaupun terdapat
pada konteks yang sedikit
berbeda atau berbeda sama
sekali.

• License Must not Contami
   nate Other Software

Lisensi open source tidak
boleh membatasi perangkat
lunak lain yang didistribusikan
bersama-sama perangkat lunak

open source dalam media yang
sama.

Bila kita berbicara tentang
open source, biasanya akan
langsung merujuk pada sistem
operasi Linux. Linux pada
dasarnya adalah sistem operasi
seperti Windows dan DOS yang
beroperasi di PC. Seperti juga
Windows yang mempunyai
banyak versi ada Windows 3.11,
3.12, 95, 98, Millenium Edition,
NT, 2000, XP. Di Linux juga
banyak sekali distribusi Linux
dengan berbagai versinya. Ada
Red Hat, Mandrake, Slackware,
SuSE,  Debian, Caldera, Trustix,
serta Trustix Merdeka (http://
merdeka.trustic.co.id) yang
merupakan distribusi Linux yang
secara keseluruhan telah
memakai bahasa Indonesia dan
berbasis TSL (Trustix Secure
Linux).

Banyak sekali keistimewaan
Linux, baik yang berasal dari
UNIX maupun keistimewaannya
sendiri, beberapa keistimewaan
tersebut diantaranya adalah:
Investasi perangkat lunak dan
perangkat keras minimal,
sehingga dana dapat digunakan
untuk biaya lainnya daripada
untuk pembelian sistem operasi
ataupun program infrastruktur.

MULTIUSER
DAN MULTITASKING
• Linux dapat mendukung dua

protokol jaringan penting
dalam sistem UNIX, yaitu TCP/
IP dan UUCP. TCP/IP (Transmis-
sion Control Protocol/Internet
Protocol) merupakan protokol
yang memungkinkan sistem di
seluruh dunia berkomunikasi
pada jaringan tunggal yang
disebut Internet. Dengan
Linux, TCP/IP,  dan koneksi ke
jaringan, kita dapat
berkomunikasi dengan user
dan mesin melalui Internet via
e-mail, USENET news,  transfer
file dengan FTP dan masih
banyak lagi. UUCP (UNIX-to-
UNIX Copy) merupakan
mekanisme yang lebih tua
yang digunakan untuk
mentransfer file e-mail, serta
electronic news di antara
mesin-mesin UNIX. Mesin-
mesin UUCP terhubung satu
dengan yang lain melalui
kabel telepon dengan
menggunakan modem, UUCP
juga dapat mentransfer
melewati network TCP/IP.

• Linux mendukung dengan
baik 32-bit sehingga
mendukung manajemen
memory protected-mode
pada platform 80386 ke atas.

• Mendukung shared library.
Hal ini memungkinkan

program untuk
menggunakan library
bersama-sama sehingga file
executable dapat lebih
sedikit menggunakan  ruang
pada disk.

• Linux mendukung
bermacam-macam file
system untuk menyimpan
data. Berbagai file system
seperti FAT16 (MS-DOS file
sistem), Minix-1, FAT32,
ISO9660 CDROM, dan lain-
lain dapat dibaca dan
diakses dari Linux.

• Mendukung virtual memory.
Adanya fasilitas ini
memungkinkan penggunaan
ruang pada harddisk sebagai
memori sehingga dapat
mengatasi kekurangan RAM
untuk menjalankan suatu
proses.

• Linux mendukung demand-
paged loaded executable
sehingga segmen dari
program yang benar-benar
digunakanlah yang dibaca
dari disk ke memori.

• Mengimplementasikan
unified memory pool untuk
program dan disk cache.
Dengan cara ini semua free-
memory akan digunakan
sebagai cache untuk
mempercepat proses.

• Memiliki fasilitas GUI
(Graphical User Interface)
yang dikenal dengan nama
Xfree86.

• Mendukung hampir semua
fasilitas pada UNIX.

• Dukungan software GNU,
memungkinkan
ketersediaan aplikasi yang
beragam dan powerful.

• Perkembangannya cepat.
Perkembangan versi dari
distribusi Linux dalam
hitungan bulan.
Dengan adanya beberapa
fakta seperti di atas,
ternyata masih terdapat
banyak kendala dalam
memasyarakatkan
perangkat lunak open
source (Linux) ke masyarakat
Indonesia.

PEMASYARAKATAN
OPEN SOURCE

Ada beberapa hal yang
perlu diperhatikan dalam
pemasyarakatan open source,
yaitu:
• Pertama, perlu adanya

dukungan pemerintah
secara nyata dalam
pemasyarakatan perangkat
lunak open source.
Dukungan pimpinan
dibutuhkan untuk
mendorong pengurangan
secara bertahap
penggunaan perangkat
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lunak yang dianggap tanpa
lisensi sah.

• Kedua, diperlukan
kesadaran dari diri kita
sendiri tentang penting dan
mendesaknya masalah hak
cipta intelektual terlebih
dengan diberlakukannya
AFTA (ASEAN Free Trade
Area) pada 2003 ini. Kita
tentu tidak ingin dianggap
sebagai masyarakat
pembajak, pencuri, tidak
bermoral, tidak menjunjung
nilai etika, dan sejenisnya.
Negara kita saat ini

termasuk ranking sepuluh
besar di dunia dalam
pembajakan perangkat lunak.

• Ketiga, diperlukan adanya
pendekatan yang bertujuan
mengenalkan open source
(Linux) melalui milis
(Internet), pelatihan, kuliah
umum, presentasi, diskusi,
demo program, seminar, dan
sebagainya. KPLI (Kelompok
Pengguna Linux Indonesia)
maupun KSL (Kelompok Studi
Linux) di masing-masing
daerah maupun kampus
diharapkan dapat turut

Virus, kata yang satu
ini selalu bikin ngeri

para pemakai
komputer. Sekalipun
telah menggunakan

antivirus terbaru
dengan virus defini-
tion yang mutakhir,

perasaan was-was itu
selalu ada. Hal ini
disebabkan selalu
muncul virus-virus

baru yang dapat
mengakali antivirus-

antivirus yang
beredar.

ulu
penyebaran
virus ini cukup
mudah ditangkal. Asal

tidak menggunakan disket
orang lain di komputer kita,
bisa dipastikan komputer kita
akan bebas virus. Tapi di jaman
Internet ini, di mana kebutuhan
akan informasi sedemikian
tinggi, komputer yang
terhubung ke Internet bak pasir
di tepi laut banyaknya. Internet
merupakan salah satu sarana
yang paling potensial dalam
penyebaran virus. Tidak heran
kalau hanya dalam beberapa
hari, bahkan mungkin hitungan
jam, sebuah virus baru dengan
cepat menyebar dan sanggup
meluluh-lantakkan begitu
banyak komputer di seluruh
belahan dunia.

PATAHNYA SEBUAH
MITOS

Sistem operasi yang sangat
rentan terhadap virus adalah
sistem operasi berbasis Win-
dows dan DOS. Tidak heran,
karena kedua sistem operasi
tersebut –terutama Windows–
masih merupakan raja yang
menguasai pangsa pasar di
dunia. Logikanya, tentu banyak
orang yang sirik dengan
keberhasilan tersebut, lalu
menciptakan berbagai jenis
virus tersebut.

Belakangan ini mulai
muncul sebuah sistem operasi
“tandingan” Windows, yang
popularitasnya juga naik
dengan tajam: Linux. Para
pengguna Linux ini semula
sangat berbangga, karena
mereka tidak perlu

membantu. Khusus untuk
seminar, pelaksanaannya
harus mendapatkan tindak
lanjut. Janganlah hasilnya
nanti hanya dari peserta
kembali ke peserta dan dari
pembicara kembali ke
pembicara.

• Keempat,  Pendekatan tidak
cukup satu arah bottom up
ataupun top down, tetapi
harus ada timbal balik antar
keduanya. Karena provokasi
sehebat apapun tidak akan
bermanfaat jika tidak ada
dukungan yang cukup.

• Terakhir, diperlukan suasana
dan lingkungan yang
mendukung
pemasyarakatan perangkat
lunak open source ini.

Akhirnya, open source dapat
memberikan manfaat yang besar
bagi negara kita karena
umumnya program-program
open source tersedia dengan
biaya yang relatif jauh lebih
murah dibandingkan program-
program closed source dan lebih
andal. Negara akan mampu
menghemat devisa yang ke luar

Virus-virus
Pengganggu Linux

Yahya Kurniawan
yahya@e-pcplus.com

menyediakan antivirus, sebab
tidak ada virus yang menyerang
Linux. Tetapi kebanggaan
tersebut sekarang menjadi
punah, karena sudah ada virus
yang menyerang Linux. Distro
Linux  yang termasuk rentan
terserang virus adalah RedHat,
distro Linux yang boleh dibilang
paling populer. Bahkan, Web
server yang menggunakan
RedHat mencapai angka hampir
70% dari seluruh Web server
berbasis Linux. Rupanya, hukum
yang mengatakan bahwa
keberhasilan selalu mengundang
kesirikan orang juga berlaku di
sini.

Sifat open source dari Linux
juga menjadi pedang bermata
dua bagi berkembang-biaknya
virus-virus tersebut. Di satu sisi,
virus-virus tersebut akan cepat
terdeteksi dan dicari
pembasminya, tapi di sisi lain,
varian dari virus-virus tersebut
juga akan cepat berkembang,
sebab siapa pun akan dapat
mempelajari source code virus-
virus tersebut. Bagi hacker dan
programmer yang baik hati,
tentu mereka akan segera
mencari serum yang tepat untuk
membasmi virus-virus tersebut.
Sebaliknya, jika source code virus-
virus tersebut jatuh ke tangan
orang yang salah, justru akan
dipelajari untuk dikembangkan
tingkat keganasannya.

RAMEN: PIONIR SANG
PENGANCAM LINUX

Beberapa contoh paling
heboh tentang virus yang
menyerang Linux antara lain
adalah sebuah worm yang
menyerang RedHat 6.2 dan 7.0.
Worm ini disebut dengan
Ramen. Salah satu efek negatif
yang ditimbulkan oleh worm ini
adalah konsumsi bandwidth
Internet yang sangat besar,
terutama saat worm Ramen ini
melakukan scanning. Hal ini
dikemukakan oleh Mihai
Moldovanu, seorang network
administrator pada Radio ProFM

Bucharest. Menurutnya, worm ini
mampu melakukan scan terhadap
jaringan-jaringan kelas B
berjumlah sekitar 130.000 alamat
Internet hanya dalam waktu
kurang dari 15 menit!
Untungnya, worm ini hanya
sanggup menyerang sistem Linux
RedHat yang diinstal secara
default. Jika server sudah
ditingkatkan sistem
keamanannya, maka server
tersebut aman dari gangguan
worm ini.

Ramen worm menginfeksi
sistem RedHat 6.2 melalui
kelemahan yang terdapat pada
RPC.statd dan wu-FTP.
Sebenarnya kelemahan ini juga
terdapat pada distro SuSE,
Mandrake dan Caldera, namun
tampaknya sang pembuat virus
memang sentimen terhadap
RedHat karena mengkhususkan
virusnya hanya untuk
menginfeksi si Topi Merah. Pada
RedHat 7.0, Ramen akan
membanjiri fungsi error logging
pada printer server dengan
banyak data, sehingga
menimbulkan buffer overflow.
Pada RedHat yang berfungsi
sebagai web server, Ramen akan
mengganti halaman utama Web
dengan file HTML yang
bertuliskan “RameN Crew --
Hackers looooooooooooove
noodles.”

TIDAK HANYA LINUX,
TAPI UNIX

Contoh kedua adalah virus
Lion yang lahir sekitar Februari
2001 lalu. Virus ini masuk ke
dalam kategori worm. Lion
memiliki kemampuan untuk
mengubah setting jaringan,
mencuri password,
menghancurkan security, dan
menginfeksi sistem untuk
serangan lebih lanjut. Sistem
Linux yang diserang adalah Linux
yang memasang BIND (Berkeley
Internet Name Domain) versi 8.
Bahkan tidak hanya Linux, tapi
UNIX pun mampu diterjang oleh
virus ini. Lion menggunakan

aplikasi yang disebut randb
untuk melakukan scan random
terhadap jaringan kelas B
(memiliki jangkauan nomor IP
128.0.xxx.xxx sampai
191.155.xxx.xxx), melakukan
probe terhadap TPC port 53,
kemudian mengeksploitasi sistem
dan menginstal sebuah tool yang
disebut t0rn toolkit. Setelah
terinstal, Lion akan mencuri
password dan beberapa setting
jaringan serta mengirimnya ke
sebuah e-mail ber-domain
china.com. Lion juga akan men-
delete file /etc/hosts.deny dan
beberapa catatan log sistem.

Tool yang disebut t0rn
tersebut akan mengganti
beberapa file binary dalam
rangka menyembunyikan diri.
File binary yang diganti tersebut
antara lain adalah:

• du
• find
• ifconfig
• in.telnetd
• in.fingerd
• login
• ls
• mjy
• netstat
• ps
• pstree
• top

Selain itu, Lion juga
menambahkan file binary t0rn
dan tfn. Mjy, sebuah utiliti yang
menghapus catatan log,
diletakkan pada direktori /bin dan
/usr/man/man1/man1/lib/.lib/.
File in.telnetd juga diletakkan
pada direktori-direktori tersebut.
Kegunaan file ini belum diketahui.

Untuk mendeteksi
keberadaan Lion, William Stearns
dari Dartmouths Institute for
Security Technology Studies telah
menulis skrip yang bernama
Lionfind (http://www.sans.org/
y2k/lionfind-0.1.tar.gz). Namun
untuk sementara, utility ini baru
bisa mendeteksi saja dan belum
bisa membasmi Lion. Sebagai
langkah pencegahan, para

pemakai Linux yang memasang
BIND dengan distribusi 4.9.8
dan 8.2.3 sangat dianjurkan
untuk memasang patch yang
dapat di-download dari ftp://
ftp.isc.org/isc/bind/src.
Sementara itu, patch untuk
BIND 9.1 dapat di-download
dari ftp://ftp.isc.org/isc/bind9.
Meskipun kelemahan BIND ini
telah dipublikasikan secara luas
dan bahkan patch-nya telah
ada, namun belum banyak situs
yang melakukan tindakan
pencegahan. Sebabnya adalah
proses perbaikan ini memaksa
mereka untuk meng-offline-kan
DNS server dalam jangka waktu
yang cukup panjang.

VIRUS LINTAS PLATFORM
Contoh lain adalah virus

W32.Winux, yang juga dikenal
sebagai W32/Lindose.2132.
Virus ini lahir Maret 2001 lalu,
dan segera menimbulkan
kehebohan yang cukup dahsyat.
Bagaimana tidak, virus ini
adalah virus yang mampu
menginfeksi Windows sekaligus
Linux! Sebagian orang
mengatakan bahwa ini adalah
virus pertama yang mampu
melintas batas platform
Windows dan Linux. Tapi
menurut Deb Zaborav pada
sebuah artikelnya di
ITworld.com, deskripsi tersebut
mungkin kurang tepat, karena
sebelumnya telah ada virus-virus
yang bersifat application
specific (sebagai “lawan” dari
operating sistem specific) yang
menginfeksi aplikasi yang dapat
berjalan pada kedua operating
sistem, misalnya virus makro
dokumen Word. Karena
dokumen Word bisa dibuka baik
di Windows (dengan MS Office)
dan di Linux (dengan
StarOffice), maka mestinya virus
macro tersebut juga mengin-
feksi dokumen-dokumen pada
kedua sistem operasi tersebut.

Virus ini mula-mula
ditengarai oleh Central Com-
mand. Detail yang mereka
berikan mengenai  identitas
virus ini adalah sebagai berikut:
Name : Win32.Winux,

Linux.Winux,
Win32.PEELF.2132

Aliases : W32/Lindose, ELF/
Lindose, W32/
Winux

Detection added : March 27,
2001

Spread Method : by in

D

serta menambah lapangan
kerja. Selain itu, pada akhirnya
masyarakat pengguna TI di
Indonesia tidak hanya
dikategorikan sebagai pemakai
pasif saja, tetapi dapat mulai
beralih menjadi pengembang
atau bahkan pencipta sistem
komputer.  Hal ini ditunjang
dengan adanya kesempatan
mempelajari listing program
yang terbuka. Semuanya ini
merupakan perjalanan yang
panjang tetapi kapan lagi kita
memulai kalau tidak dari
sekarang? PC+
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fecting files
under both
Windows and Linux
operating system

Risk : Low

Deskripsi yang mereka
berikan tentang virus ini adalah
sebagai berikut:

W32.Winux adalah virus
yang bersifat non-resident di
memori. Virus ini bisa
berkembang biak pada sistem
operasi Windows 9x/ME/NT/2000
dengan menginfeksi file PE
(Windows executable, termasuk
di dalamnya file *.exe), dan
sistem operasi Linux dengan
menginfeksi file ELF (Linux
executable). Jurus yang
digunakan dalam menginfeksi
file PE adalah dengan menimpa

(overwrite) bagian .reloc. Jika
bagian .reloc ini tidak cukup
besar untuk menampung body
virus, maka file tersebut tidak
akan terinfeksi. Sedangkan untuk
file ELF, virus ini akan menimpa
bagian entry point, dan kode
aslinya dipindahkan pada bagian
akhir file.

McAfee sebagai salah satu
biang pembasmi virus juga segera
mengambil langkah untuk
menangkal virus tersebut. Simak
komentar yang mereka berikan
tentang virus ini:

“Virus ini datang dari tipe
file PE, jadi untuk bisa hidup,
mula-mula dia harus menginfeksi
Windows. Jika pada komputer
yang sama ditemukan juga sistem
operasi Linux, maka si Penguin
akan ketularan. Untuk mende-

teksinya, gunakan file DAT ter-
baru kami. Untuk file yang tidak
dapat dibersihkan, gantilah file
tersebut dengan backup-nya!”.

DUAL BOOT: PANGKAL
SIMPUL INFEKSI

Memperhatikan komentar
dari McAfee ini, maka dapat
diambil kesimpulan bahwa
sebenarnya yang rentan terhadap
virus ini adalah Windows. Jika
sebuah komputer memiliki dual
boot Windows dan Linux.
Windows terjangkit virus ini,
barulah Linux akan tertular.
Tetapi jika sebuah komputer
hanya memiliki sistem Linux saja,
maka virus ini tidak akan
menjangkitinya.

Virus lain yang mirip dengan
ini adalah Linux.simile. Anda

dapat membaca informasinya di
http://
securityresponse.symantec.com/
avcenter/venc/data/
linux.simile.html.

“KLINIK KESEHATAN”
SI PENGUIN

Semakin bertambahnya
jumlah maupun variasi virus
yang dapat menyerang Linux
menuntut  para “dokter
hewan” untuk segera
menemukan imunisasi yang
ampuh agar si Penguin tetap
sehat. Dan nyatanya, di Linux
pun dikenal yang namanya Anti
Virus. Berikut adalah beberapa
contohnya:

• Dr. Web (www.drweb.ru/
unix), yang ini tidak bersifat

open source melainkan
proprietary.

• Trend ServerProtect
(www.trendmicro.com),
proprietary.

• Open AntiVirus
(www.openantivirus.org),
open source.

• F-Prot (www.f-prot.com),
proprietary.

• Clam Antivirus
(clamav.elektrapro.com),
open source.

ª Kaspersky
(www.kaspersky.ru),
proprietary.

Nah, para pengguna Linux,
hati-hatilah karena virus kini
bukan cuma monster yang
ditakuti oleh para pengguna
Windows. PC+

Utiliti Pemeliharaan
Sistem Linux

S

Vincent Bayu Tapa Brata
vincent@e-pcplus.com

 Mitos superioritas
kestabilan Linux

mengakibatkan kita
sering menganggap

enteng upaya
pemeliharaan sistem.

Padahal, banyak
sekali utility dalam
Linux yang sangat

berguna untuk me-
ngecek, mengevaluasi

dan memelihara
kehandalan sistem.

elama ini
berbagai
utility seperti
free, badblocks,

fsck, vmstat, top, dump,
fdisk diasumsikan hanya
berguna bagi administrator
atau komputer yang terhubung
ke jaringan. Perkembangan di
dunia Linux yang semakin
menjanjikan, terutama lingkup
desktop-nya semakin mengikis
anggapan ini. Bagi pengguna
desktop, utility ini sifatnya
“mudah dipakai dan perlu”.
Apalagi, koleksi utility tersebut
dapat dijalankan oleh user
biasa, tidak harus oleh root.

Kiranya tidak cukup alasan
apabila berbagai utility pemeli-
haraan sistem Linux dianggap sulit
lantaran dijalankan lewat console
atau terminal. Bila kita kurang
jelas dan ingin memahami sintaks
maupun berbagai option bisa
dilihat dengan perintah man
<nama_utility>. Uraian berikut
ini akan mencoba mengajak
untuk memahami berbagai utility
tersebut.

• free
free berfungsi untuk menge-

tahui alokasi pemakaian memori
CPU (prosesor), memori RAM, ser-
ta memori swap (memori virtual).
Sintaksnya: free -<option>
Option free antara lain:
-b : menampilkan hasil penge-

cekan dalam satuan bytes.
-kb: menampilkan hasil penge-

cekan dalam satuan kilobyte.
-mb: menampilkan hasil penge-

cekan dalam satuan mega
byte.

-t: menampilkan hasil pengece-
kan secara keseluruhan (total).

Gejala ketidakberesan da-
pat kita ketahui bila, misalnya,
alokasi pemakaian memori
tinggi, sementara aplikasi yang
kita jalankan tidak banyak atau
tidak terlalu memerlukan me-
mori banyak. Hal ini bisa dise-
babkan antara lain oleh ba-
nyaknya proses yang resident
saat startup.

Virus atau worm dapat
menjadi salah satu biang-nya.
Harap diingat, Linux bukanlah
sistem operasi yang kebal sama
sekali akan serangan virus (baca
uraian di halaman lain).

• vmstat
vmstat bermanfaat untuk

mengetahui informasi
tentang berbagai proses,
alokasi memori, penulisan
memori ke swap device,
aktivitas CPU (prosesor).

Sintaks vmstat adalah:
vmstat -n <waktu selang>
<intensitas>

Waktu selang adalah jeda
antara satu proses pengujian
dengan proses berikutnya, dalam
satuan detik. Intensitas adalah
jumlah proses pengujian yang
akan dilakukan.

Option -n menyebabkan
header ditampilkan hanya sekali.
Beberapa kolom yang
mengandung informasi
penting antara lain:
procs (jenis proses): (r)
proses-proses yang
menunggu dalam antrean
run time, (b) uninterupted
sleep, serta (w) swaped out.
Besarnya jumlah proses yang ada
di antrean run time merupakan
salah satu penyebab lambatnya

kerja sistem. Selanjutnya, kolom
swpd menunjukkan jumlah
penggunaan memori cadangan
di harddisk. Kolom free
menginformasikan jumlah
memori yang siap dipakai.
Kolom buff berisi informasi
memori penyangga (penyimpan
sementara sehingga proses
menjadi lebih kontinu dan
cepat). Kolom cache menerang-
kan jumlah memori yang tersisa
di cache (penyimpan proses-
proses yang sering dipakai dari
harddisk sehingga proses
menjadi lebih cepat). Kolom (si)
berisi jumlah memory proses
paging dari harddisk, dan ke-
balikannya adalah kolom (so).

Dari sisi hardware, besarnya
jumlah antrean runtime dapat
dikurangi antara lain dengan
menggunakan perangkat
berteknologi hyperthreading
(pada prosesor), penggunaan

teknologi Southbridge-
Northbridge (pada
motherboard), dan lainnya.
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• fsck

fsck bermanfaat untuk
mengetes dan memperbaiki file
system Linux, baik yang berupa
label file system (misalnya EXT3,
EXT2), nama perangkat
(misalnya /dev/hd untuk
harddisk), maupun titik kait /
mountpoint (misalnya / , /
home, /boot).

Sintaksnya: fsck [ -
sACVRTNP ] [ -t fstype ]
filesys [ ... ] [--] [ fsck-options
]

Misalnya: fsck  –a  /dev/
hda1
Option-nya adalah:
-t : menentukan tipe file

system (FAT, EXT2/,
EXT3, dan lainnya)

- A : melihat file tabel file
system /etc/fstab dan
menguji semua file
system

-C : menampilkan progress
bar (hanya untuk ext2)

-N : tidak mengeksekusi, ha-
nya menampilkan apa
yang akan dikerjakan

-R : melewatkan (skip) root
file system (hanya jika
dengan option -A)

-T : tidak menampilkan
judul saat eksekusi

-V : menampilkan output
yang verbose (detail)

-filesys: nama partisi yang akan
dicek

-fsck-option :
-a : otomatis memperbaiki
-r : memperbaiki secara

interaktif (setiap
langkah akan ditanya-
kan/konfirmasi dulu).

Perintah fsck ini
sebaiknya dilakukan saat
device/media penyimpan
dalam keadaan umount,
karena ada kemungkinan
mengakibatkan data corrupt,
sehingga file system rusak.

• badblocks
badblocks akan

melaksanakan proses pengecekan
badblock yang ada dalam media
penyimpan, misalnya partisi
harddisk. Pengetesan ini
memerlukan penentuan blok di
mana pengetesan mulai dan blok
di mana pengetesan berhenti.
Jika tidak ditentukan, maka
secara standar (default) blok awal
dan blok akhir perangkat
penyimpan dipakai sebagai
patokan.

Sintaks dari badblocks:
badblocks [ -svwnf ] [ -b block-
size ] [ -c blocks_at_once ] [ -i

input_file ] [ -o

output_file ] [ -p
num_passes ] device [
last-block ][ start-block ]
misalnya: badblocks  –n
/dev/fd0

Option dari
badblocks:
-b : menetapkan ukuran blok

(dalam byte)
-c : menetapkan jumlah blok

yang akan dicek
-f : melakukan pengujian

dalam mode read/write
(sangat tidak disarankan
jika perangkat
penyimpan dalam
keadaan mounted)

-i : membaca daftar badblock
yang sudah ada dan men-
skip-nya (karena sudah
dianggap bad)

-o : mencatat hasil badblock
ke dalam output file

-p : mengulangi proses scan
sampai tidak ditemukan
badblock sampai
num_passes iterasi
(default 0 setelah
pengujian selesai, langsung
keluar)

-n : menggunakan mode non-

destructive read/write
-s : menampilkan kemajuan

dari proses dengan
menampilkan nomor blok

-v : mode verbose (menampilkan
detail proses).

Sebaiknya, parameter –n
digunakan supaya kemung-
kinan rusaknya data hilang.

• Top
Mirip dengan vmstat yang

menggunakan waktu selang
antarproses (delay), utility top
menampilkan informasi proses-
proses yang berlangsung di CPU
(prosesor) sekaligus peringkat
proses yang mengonsumsi
memori paling banyak. Bedanya,
kita bisa langsung melakukan
melakukan tindakan terhadap

suatu proses langsung
dari utility ini.
Tindakan tersebut
misalnya
menghentikan (kill)
proses yang dalam
keadaan

zombie (mati tidak,
tapi terhenti, stuck).
Caranya, tekan
tombol k di key-
board dan isi nomor
PID proses yang
disajikan top.
Sementara, untuk
mendapatkan Help, tekan tombol
h. Tekan tombol q untuk keluar

dari utility top.
Sintaks: top -<options>
Options:

-d : waktu delay dalam detik
-p : hanya memonitor proses

dengan nomor PID yang
ditentukan

-q : menjalankan top tanpa
melakukan refresh

-s : menjalankan top dalam
secure mode

-i : menjalankan top dan
mengabaikan proses yang
idle atau bersifat zombie

Kita juga bisa mengirimkan
sinyal untuk mematikan suatu
proses dari console dengan
perintah kill.

Sintaksnya: $ kill <PID>.
PID suatu proses dapat
diketahui dengan perintah ps.

Seiring semakin eksisnya
Linux, berbagai gangguan pasti
telah menanti. Mempersiapkan
diri dan membiasakan diri dari

dini adalah tindakan yang
bijaksana. PC+
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Di tengah kondisi
makin populernya

Linux sebagai
alternatif sistem

operasi baru, kiranya
masih sedikit orang

yang telah benar-
benar meninggalkan
sistem operasi lama.
Ibarat kata, mereka
telah menyeberang

jurang dan memutus
jembatan.

agi pemula
yang berada dalam
tahap migrasi –dan
semakin lama

diharapkan menjadi eksodus-
dual boot merupakan cara
adaptasi yang banyak
ditempuh. Namun demikian,
tentu ada kendala yang
menghalangi tahapan ini.
Masing-masing sistem operasi
memiliki file system masing-
masing. Linux menggunakan
EXT2 atau EXT3, sementara
Windows menggunakan FAT16,

FAT 32 atau NTFS.
Kernel (inti sistem operasi)

Linux memang telah
mendukung user Linux untuk

masuk ke partisi Windows
melalui mekanisme mount.
Partisi Windows yang
menggunakan file system FAT32
dapat di read dan write oleh
Linux. Sementara itu, partisi
Windows yang menggunakan
file system NTFS baru dapat di
read oleh Linux. Permasalahan

mulai terlihat
ketika distro
Linux yang
cukup populer:
Redhat dan
Fedora Core
tidak
mendukung
pembacaan file
system NTFS
terkait dengan
hukum dan hak
cipta. Bagaimana
kalau semakin
lama semakin
banyak distro
Linux yang harus
tunduk pada
permasalahan
hak cipta dan hukum?

Tidak perlu khawatir, karena

Linux berkembang dan dewasa
dari basis komunitas. Selalu saja
ada pihak-pihak yang concern
dengan permasalahan yang

menghadang perkembangan
Linux. Mereka menciptakan
pemecahan-pemecahan tersebut
dan mendistribusikannya secara
gratis. Dalam kasus file system
NTFS, telah terdistribusi kernel
NTFS yang jika diinstal ke dalam
sistem operasi Linux akan
memungkinkan Linux membaca

(read) partisi Windows yang
menggunakan file system NTFS.

Langkah pertama yang
harus kita lakukan adalah men-
download kernel NTFS ini.
Download server yang
menyediakannya antara lain
adalah http://linux-
ntfs.sourceforge.net/rpm/
index.html. Jangan khawatir,
bentuknya adalah RPM dan
ukurannya cukup kecil, hanya
36KB. Nama file tersebut adalah
kernel-ntfs-2.4.20-8.i686.rpm.
File download kernel NTFS
tersedia untuk basis mesin Intel
maupun AMD.

Setelah men-download,

tempatkan di di-
rektori /usr/local/
src (gambar 1).
Kita dapat me-
nginstal dengan
dua cara, yaitu
dengan perintah
rpm di console/
terminal sebagai
root atau lang-
sung klik ganda
file kernel NTFS
tersebut. Jika
menggunakan
perintah rpm, kita
harus login
sebagai root atau

tetap sebagai user biasa tapi
memberi perintah su lalu
mengisi password root.
Sintaksnya adalah: # rpm –ivh
kernel-ntfs-2.4.20-8.i686.rpm
(gambar 2). Langkah
selanjutnya adalah mencoba
me-mount partisi Windows agar
dapat dibaca Linux. Perintah
mount dilakukan di console
dalam kapasitas sebagai root.
Sebelum memberi perintah
mount, kita harus tahu lokasi
partisi Windows. Berikan
perintah fdisk –l /dev/hda atau
df –h (gambar 3). Isikan
informasi partisi Windows
output perintah fdisk atau df
ke perintah mount.
Sintaksnya: # mount –t
<file_sistem>  /dev/hd<…>   /
mnt. Misalnya: # mount –t
ntfs  /dev/hda1  /mnt
(gambar 4).

Tidak adanya pesan error
berarti proses mount berhasil.
Browse direktori /mount
dengan klik ganda ikon home
di desktop. Dalam  direktori /

mount akan tampak direktori-
direktori Windows (gambar 5)
. Kita bisa membaca dan
menyalin data dari sana.
Sayangnya, kita belum dapat
menyimpan (write) dari Linux ke
partisi Windows ini.

Jika kita dapat “melongok”
file dan direktori di partisi
Windows dari Linux, apakah
kita dapat melakukan sebali-
knya: menebar pandang ke
“habitat Si Penguin”? Jawabnya
adalah: bisa..! Banyak aplikasi
yang bisa melakukan hal ini,
antara lain explore2fs
(gambar 6) dan WinSCP. Biasa-
nya, file download aplikasi-
aplikasi ini berbentuk ZIP,
sehingga harus diekstrak dahulu
sebelum diinstal ke Windows.
Explore2fs dapat di-download
dari http://
uranus.it.swin.edu.au/~jn/
linux/explore2fs.htm.

Sama halnya dengan
perintah mount partisi NTFS di
Linux, aplikasi explore2fs ini
hanya mampu melakukan pem-
bacaan file saja, dan tidak bisa
merekam (write) ke partisi
Linux. Explore2fs merupakan
aplikasi yang terpisah dari
sistem operasi Windows, tidak
seperti perintah mount yang
merupakan bagian dari shell
Linux. PC+
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Bagi pembaca yang tertarik untuk berinteraksi di rubrik ini, silakan
mendaftar dengan mengirimkan e-mail  kosong ke mailplus-

subscribe@yahoogroups.com.
Agar keanggotaan Anda segera diaktifkan, balas e-mail konfirmasi yang

dikirimkan oleh Yahoo ke alamat e-mail Anda. Setelah terdaftar, Anda
dapat mengirimkan e-mail pertanyaan ataupun tukar menukar

pengalaman seputar dunia komputer.
Jangan lupa untuk memeriksa account e-mail Anda secara rutin. Jika

Anda tertarik untuk berdiskusi langsung secara online, silakan Anda join
ke server DALnet pada channel #chatplus di mIRC.

PENTING!!!
Kalau Anda ingin menerima dan membaca e-mail secara digest (satu

e-mail berisi beberapa message), kirim e-mail kosong ke mailplus-
digest@yahoogroups.com. Sebagai informasi, setiap hari Jum’at hingga

Minggu adalah hari bebas di milis ini.
Setiap anggota dapat mem-posting e-mail diluar seputar masalah

komputer asalkan tidak mengandung SARA, pornografi, bajak-membajak
software, flamming, dan sebagainya. Jika Anda tidak ingin menerima e-

mail OOT (Out Of Topic), kirim e-mail ke mailplus-
nomail@yahoogroups.com, dan silakan Anda aktifkan kembali ke mode
normal dengan mengirim e-mail ke mailplus-normal@yahoogroups.com.

•Redaksi

Kartu VGA dan Speaker

Numpang tanya lagi ya, my
friends.
• Kalau mau memilih VGA itu

gimana ya? Apa harus yang
punya skor benchmark
tinggi? Trus masalah support
DirectX-nya itu pengaruh
gak? Soalnya kan ada VGA
dengan benchmark tinggi
tetapi belom support
DirectX tertentu kayak
GeForce FX5200 (DirectX 9)
vs GeForce 4 Ti (DirectX 8),
katanya kalau dari bench-
mark-nya bagusan yang
GeForce-4 Ti ya? Terus
kualitas gambarnya bagusan
yang benchmark tinggi atau
yang full support DirectX 9
(dalam contoh FX200 vs
GeForce-4 Ti4600 tadi)

• Satu lagi. Kalau soal speaker,
yang bagus itu yang
bagaimana? Maksudnya,
misalnya sound card 2.1, 5.1
dan 6 channel itu gimana
maksudnya? Terus misalnya,
pakai speaker Altec Lansing
AVS 300 (2 speaker dan 1
woofer), apa itu cocoknya
atau lebih bagus pakai
sound card yang cuma
support 2.1 channel?

Maaf kalau pertanyaannya
banyak banget. Terima kasih
untuk informasinya. Salam.

Chinank

Jawab:
• Kalo VGA, ya terserah

kebutuhan pemakaian.
Memang sih, tentu enak
rasanya punya VGA yang

skor benchmark-nya tinggi,
berarti lebih cepet. Tetapi
ngga ada card yang menang
di semua benchmark, jangan
terlalu dibuat patokan. Jadi
sesuaikan aja dengan game
yang suka atau akan
dimainkan. Bisa jadi satu VGA
card unggul di Jedi Knight
tetapi kalah di Unreal
Turnament 2003.
Soal DirectX juga sesuaikan
dengan kebutuhan. Kalau
masih memainkan game-
game lama yang masih
support kartu grafis DirectX
8.1, ya kartu grafis DirectX 9
tentunya kurang
termanfaatkan. Tetapi ini
pendapat saya lho, karena ke
depannya bakal banyak game
yang membutuhkan kartu
grafis yang support DirectX 9
(ikut perkembangan zaman).
Jadi, disarankan sih beli aja
card yang sudah support
DirectX 9. Kalau soal kualitas
gambar, tentu lebih bagus
DirectX yang lebih tinggi dari
pada yang skor benchmark-
nya tinggi.
Kalau Anda memang
penggemar game, sebaiknya
cari yang support DirectX 9,
kayak FX5200, FX5600 atau
FX5900. Untuk keluarga ATi
Radeon, ada seri R9500, seri
R9600, seri R9700, dan seri
R9800.
Untuk kasus tersebut, GeForce
FX5200 dan GeForce-4 Ti,
memang hasil benchmark di
3DMark2001 akan menang
GeForce-4 Ti (Ti4200
sekalipun). Tetapi kalau sudah

nyoba 3DMark2003,
sepertinya Ti4200 akan keok
di beberapa pengujian.
Sekarang, pastikan dan
tentukan kebutuhannya.
Jangan lupa pikirkan pula
budget-nya, urusan memilih
VGA soalnya gampang-
gampang susah. Biasanya sih
uang berbicara, makin
mahal makin bagus.

• Soal speaker juga sesuaikan
dengan kebutuhan. Kalo
akan digunakan untuk
nonton DVD, tentu lebih
enak yang 5.1, sesuai
dengan "keunggulan" DVD.
Apalagi kalau ditambah
dengan dukungan decoder
DTS atau Dolby Digital.
Nonton DVD bakalan kayak
beneran deh.
Buat game juga enak, jadi
bisa keluar suara surround-
nya. Kalau cuma speaker 2.1
kan hanya suara dari depan
aja, regardless sound card-
nya gimana. Biar sound card-
nya support 7.1, ya tetep
enak aja dipake 2.1, hanya
ya nggak maksimal jadinya.
Kalau sound card-nya

hanya support 2.1, ya mending
ambil speaker yang 2.1 aja.
Soalnya kalo nekat ambil yang
5.1, colokan output dari sound
card-nya nggak ada sehingga
mubazir. Memangnya sudah
yakin sound card-nya hanya 2.1?
Ngomong-ngomong Anda pakai
sound card apa?

Adri Febrianto, Mat Gemboel,
Adhitya F. Anggoro

Memori Utama untuk
Notebook

Temen-temen sekalian, saya
ada rencana mau meng-upgrade
memori SDRAM 64MB PC-100
pada notebook Dell Latitude
C600-PIII saya. Tetapi sebelumnya
ada beberapa hal yang ingin saya
tanyakan:
• Apakah saya bisa memakai

memori yang PC-133?
• Manakah yang lebih cepat,

128MB PC-133 atau 192MB
PC-100? Soalnya harga 128MB

Update BIOS

Halo kawanku semua, aku mau tanya cara update BIOS.
Gimana caranya? Masalahnya aku tidak tau merek motherboard-ku
apa, gimana ya? Sebagai informasi, motherboard-ku ini sudah
kupakai selama enam tahun. Thanks.

santo_free

Jawab:
Standarnya sih, kalau mau meng-update BIOS, Anda harus tau

dulu merek motherboard dan tipenya. Kalau sudah tau, coba Anda
browsing ke website vendor motherboard tersebut. Cari link
download atau update BIOS. Pelajari cara update-nya langkah demi
langkah. (Biasanya ada link untuk tutorial atau caranya). Setelah
Anda men-download file BIOS dan utility update-nya (kalau ada),
jalankan update BIOS.

Saat sistem melakukan flash terhadap BIOS, pastikan listrik
jangan sampai mati. Hati-hati juga saat melakukan update tersebut.
Kalau gagal, bisa jadi Anda harus mengucapkan selamat tinggal
pada motherboard Anda.

Kalau Anda tidak tahu apa merek dan tipe motherboard Anda,
coba Anda gunakan software Aida32. Biasanya software ini mampu
mendeteksi informasi tersebut. Kalau Anda ingin men-download-
nya, silakan kunjungi www.aida32.hu. Download saja versi Personal
Edition, gratis kok.

Adhitya F. Anggoro, 0600661160

• Masalah lebih cepat,
tergantung prosesornya juga.
Anda menggunakan Pentium-
III kecepatan berapa? Kalau
prosesor Pentium-III Anda
sudah menggunakan FSB
133MHz, ya pakai PC-133,
kalo pake FSB 100MHz ya
pake PC-100, lain masalah
kalau notebook tersebut bisa
diset asinkron. Maksudnya
RAM tetap jalan di 133 tapi
FSB prosesor jalan di 100.
Tetapi kayaknya jarang ya,
notebook yang bisa seting-
seting BIOS kayak desktop.
Untuk memori tadi, kalau
beda harganya tipis, ya men-
dingan beli PC-133 saja, tentu
asal memang bisa dipasang.

PC-100 dan PC-133, bedanya
tipis banget.
Bagi yang tahu jawabannya,

tolong ya. Terima kasih banyak.

Khresno Wibowo

Jawab:
• Untuk komputer branded

kayak gitu, agak susah untuk
menemukan merek RAM yang
cocok. Anda harus minta
garansi ke tokonya bahwa
RAM yang Anda beli tersebut
bisa dipasang dan jalan di

komputer Anda. Kalau bisa,
minta garansi juga kalau RAM
tersebut tidak jalan bisa
ditukar. Sebetulnya akan lebih
baik bila Anda membawa
notebook tersebut ke tokonya
biar lebih aman, daripada
bolak-balik kan? Kalau secara
teori, komputer tersebut bisa
dipasangi memori PC-133.
Cuma jalannya tetap di PC-
100, alias mubazir aja tuh 33
MHz kelebihannya. Sekarang
tergantung Anda, mau beli
yang mana?

Sebagai informasi, untuk
notebook modul yg dipakai
bukan SDRAM biasa, tapi
SODIMM SDRAM. In my opin-
ion, bisa saja kok dipasangi PC-
133, walaupun performanya
tidak akan maksimal. Tetep saja
akan jalan di PC-100
sesuai dengan spesifikasi
notebook-nya.

Tambahan lagi, kalau Anda
mau membeli modul SODIMM,
pastikan yang agak bermerek.
Biasanya pilihannya Kingston
atau yang lainnya. Jadi, bawa aja
notebook-nya ke toko si penjual,
pasang di sana dan tes langsung.

mbUdh, Adri Febrianto, Mat
Gemboel

✔

+

✔

+

✔

+
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Vincent Bayu Tapa Brata
vincent@e-pcplus.com Iseng Membuat

Kartu Ucapan
Selamat NatalK

Natal sudah dekat, kita buat kartu ucapan
Selamat Natal, yuk! Untuk fotomodelnya, kita

pakai saja orang-orang tercinta kita, supaya efek
emosionalnya lebih terasa.

ita juga perlu pekerjaaan yang cepat, maka
pergunakan saja Adobe Photoshop.

OK, ayo kita mulai …

• MEMISAHKAN SUBJEK DARI LATAR BELAKANG
1. Buka foto bahan dasar. Klik ganda pada bar layer Background untuk menjadikannya

layer normal. Jika perlu, ganti namanya dengan Asli melalui Layer Properties.

5. Bila sudah sempurna, klik ikon Load Channel as Selection di bawah palet Channel.
Buka palet Layers, klik menu [Select]>[Inverse] untuk membalik seleksi. Klik  menu
[Select]>[Feather], beri nilai kecil agar tepian seleksi tidak tajam (kesan guntingan).
Klik ikon [Add Layer Mask] di bawah palet Layers.

2. Buka palet Channel, pilih channel yang paling kontras. Klik arrow di kanan atas palet
Channel, pilih [Duplicate Channel] supaya data asli tidak rusak. Inilah yang
dinamakan Alpha Channel.

3. Tingkatkan kontras subjek terhadap latar belakang agar subjek memiliki nada yang
bertolak belakang dengan latar belakang. Klik menu [Image]>[Adjustment]>[Level].
Geser slider highlight, midtone, dan shadow.

4. Sempurnakan dengan menyapu subjek menggunakan nada yang bertolak belakang
dengan latar belakang. Gunakan Paintbrush Tool. Pilih nada gelap atau terang pada
palet Foreground Color  Intensitas sapuan brush dapat diatur dengan menggeser
slider Tool opacity. Sementara itu, diameter brush diatur dengan menekan tombol [
dan ] di keyboard. Sapu juga latar belakang dengan nada yang berlawanan.

• MEMPERBAIKI TONE (GRADASI NADA WARNA) SEHINGGA DETAIL
DAN TEKSTUR BAJU SUBJEK MUNCUL

1. Salin layer Asli. Klik arrow, pilih Duplicate Layer. Beri nama GaunEdit.
Sembunyikan layer Asli dengan menghilangkan ikon mata (layer visibility). Aktifkan
layer salinan. Klik mask, kemudian sembunyikan tangan dan kepala subjek dengan
Paintbrush Tool dan nada gelap.

2. Klik dan aktifkan layer-nya, perbaiki detail baju dengan Levels. Klik menu [Image]>
[Adjustment]>[Level]. Jangan pedulikan perubahan warnanya. Perbaiki warna
dengan Color Balance. Lakukan pada highlight, midtone, dan shadow. Naikkan
kecerahan warna putih pada baju dengan Brightnes and Contrast.

Klik ganda

Nama
Layer

Salinan Channel/
Alpha Channel

Slider Levels

Tool
Opacity

Paintbrush
Tool

Nada Gelap palet
foreground color

Layer Visible
(tampak)

Ikon Add
a mask

Mask aktif

Layer hidden

Klik untuk
aktifkan mask

Shadow

Layer
aktif

Klik aktifkan
layer
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• MEMBERI KESAN BERSIH, BERCAHAYA, DAN PANCARAN AURA
1. Salinlah layer Asli dan layer GaunEdit. Tempatkan di urutan layer bawah.

Tambahkan pula layer baru untuk latar belakang dengan klik arrow, pilih [New
Layer]. Isi dengan satu warna. Tempatkan di urutan layer terbawah.

2. Klik layer ketiga dari bawah, gabungkan ketiga layer dengan klik arrow, pilih Merge
Down.

3. Klik Magic Wand Tool di Toolbox, klik di latar belakang. Berikan feather bernilai
kecil, lalu tekan Delete. Ubah nama layer dengan Aura. Tempatkan di urutan layer
paling atas.

4. Naikkan Level layer Aura, kemudian kaburkan dengan [Filters]>[Blur]>[Gaussian
Blur].

5. Beri mask dengan menekan ikon [Add Layer Mask]. Klik [Paintbrush Tool], turunkan
Tool Opacity, sembunyikan aura (yang menutupi)  tekstur baju dan beberapa bagian
kecil subjek, misalnya mata dan bibir.

6. Tambahkan layer baru. Klik [Paitbrush Tool], pilih warna putih. Beri pijar pada
tongkat ajaib subjek.

• MENAMBAHKAN UNSUR GAMBAR LAIN UNTUK MEMPERKUAT TEMA
1. Buatlah seleksi pada unsur penunjang tema, misalnya dengan Magic Wand Tool atau

menu [Select]>[Color Range]. Beri feather, lalu klik menu [Edit]>[Copy].

2. Aktifkan kanvas kerja, klik [Edit]>[Paste]. Tempatkan di urutan layer di belakang
(bawah) subjek. Sesuaikan ukuran dengan menu [Edit]>[Transform]>[Scale]. Tekan
[Shift] sambil geser handle point di sudut. Tekan [Enter].

3. Samarkan beberapa tepian gambar penunjang dengan klik ikon [Add Layer Mask].
Sapu dengan Paintbrush Tool, nada gelap, dan Tool Opacity rendah.

4. Save pekerjaan kita dengan format .PSD

Selamat mencoba. Selamat Natal. Pertanyaan dan permintaan source file format
.PSD dapat dikirimkan ke e-mail penulis. PC+

Layer aktif

Nada gelap palet
foreground color

Mask aktif

Ikon
Add mask

Magic
wand tool

Handle
point

Tool
Opacity

Mask aktif
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Operator Seluler CDMA:
(Seharusnya) Tak Cuma Tawarkan

Layanan Bicara Tapi Juga
Komunikasi Data

K

Kian ramailah
persaingan bisnis

telekomunikasi seluler
di negeri ini.

Persaingan juga
mencerminkan

keterbelahan
pengadopsian

teknologi antara GSM
dan CDMA. Namun,
persaingan ini juga

mengundang
sejumlah pertanyaan.

Siapa yang bakal
tergilas? Siapa yang

bakal bertahan? Siapa
yang bakal menang?

artu telepon
berbasis CDMA
2000 1x dan EV-DO
yang satu ini boleh

jadi memang tidak ditujukan
buat anak-anak muda di Ciamis,
Indramayu atau Pandeglang.
Bahkan salah-salah mereka
mengeja dan menuliskannya pun
secara salah: Pren. Padahal,
FREN, demikian nama produk
yang diusung oleh operator
seluler Mobile 8, jelas-jelas
menyasar anak muda yang lagi
seneng-senengnya gaul dan
berduit tebal.

Segmentasi (bakal)
konsumen yang dipilih oleh Fren
sangat jelas: anak-anak muda di
kota besar di level ekonomi
menengah sampai atas. Selain
mereka, para profesional muda
kerah putih pun jadi sasaran.
Dus, minggirlah para remaja
yang ingin menikmati derajat
gaulitas tetapi kagak punya
dompet ekstra. Juga menepilah
jauh-jauh para pekerja yang
cuma bergaji pas-pasan dan
tabungannya cuma cukup buat
membeli ponsel bekas.

Kalau mau lebih dipertegas,
Fren memilih untuk tampil beda
dengan para pendahulunya
seperti Telkomflexi maupun Esia
yang sekadar mendengung-
dengungkan tarif telepon seluler
yang murah.

Makanya, ketika
mengampanyekan produk
barunya lewat blocking time di
beberapa stasiun televisi awal

Desember lalu,  Mobile 8
memanfaatkan artis
papan atas yang menjadi
“kegemesan” sekaligus
ikon bagi anak-anak
gaul di kota-kota besar
seperti Sheila On 7,

Dewa, Audi, Glen, Marcel, Rio
Febrian atau Titi DJ. Bukan Inul
Daratista, Christina, Alam, atau
Cici Faramida, meski level
berkesenian mereka di blantika
musik tanah air boleh jadi selevel
dan tarif manggung mereka juga
relatif tak beda jauh.

Meski dari sisi teknologi Fren
menggunakan infrastruktur yang
sama dengan Flexi dan Esia, sejak
awal Mobile 8 menegaskan
bahwa mereka bukan operator
berbasis fixed wireless access
sebagaimana dua pendahulunya
melainkan sebagai operator
wireless mobile telecommunica-
tion. “Kami adalah operator
pertama di sektor wireless mobile
telecommunication,” ujar B.T. Lim,
CEO Mobile 8 yang tak lain adalah
mantan presiden direktur Hewlett
Packard Indonesia.

Pembedaan pendekatan ini
juga membuat wajah Flexi dan
Esia menjadi sangat berbeda
dengan Fren dari sisi marketing.
Coba lihat pendekatan masing-
masing. Flexi mengedepankan
faktor murah dan kata-kata
“bukan sekadar telepon biasa”
menjadi senjata. Intinya tetap
pada telepon sebagai alat
komunikasi dan bicara. Setali tiga
uang dengan Esia. Ketika waktu
(bercakap-cakap) tak menjadi
masalah karena ongkos berbicara
sudah menjadi murah, Esia justru
langsung berhadap-hadapan
dengan Flexi, padahal secara
konsep promosi, boleh jadi
sasaran tembaknya adalah para
pengguna telepon berbasis GSM.
Tapi, sama seperti Flexi, Esia masih
mengeksplorasi “harga murah”
sebagai senjata jualan.

Akibatnya, dari sisi fitur, tak
banyak konsumen yang meminta
lebih dari teknologi yang
dihadirkan oleh Flexi maupun
Esia. Yang penting bisa bicara
lama dan murah, itu poinnya.

Fren menggarap konsumen
pada segmen yang dipilihnya
adalah konsumen cerdas, dinamis,
aktif, konsumen yang meminta
ponsel lebih dari sekadar bicara,
karena secara teknologi, infra-
struktur komunikasi yang terpa-
sang memang bisa memberi lebih.

FOKUS DI JAWA
Mengikuti rembesan

pertumbuhan ekonomi negeri ini

yang sangat menumpuk di Pulau
Jawa, Mobile 8 memfokuskan diri
untuk meraup pelanggannya di
pulau terpadat di Indonesia ini.
Maklumlah, anak muda berduit ya
ada di sini. Para profesional ya di
sini.

Ketika pertama kali
diluncurkan 8 Desember lalu,
Mobile 8 membangun hampir 300
Base Transceiver Station (BTS) di
seluruh Pulau Jawa. Sementara
itu, di Jakarta, pasar paling
potensial, Mobile 8 tengah
melakukan ujicoba proyek
wireless broadband EV-DO
(Evolution of Data Only) yang
memungkinkan komunikasi data
berlangsung lebih cepat dan
ditransmisikan pula melalui
jaringan bergerak (mobile
network). “Jangan meremehkan
komunikasi data. SMS misalnya,
dalam waktu 3 tahun sudah
memberikan kontribusi revenue
sebesar 20% bagi seluruh opera-
tor seluler di Indonesia,” B.T Lim
meyakinkan. Untuk saat ini, dari
300 BTS yang sudah terpasang, 17
BTS di antaranya telah
dialokasikan untuk layanan EV-DO
dengan throughput data rata-rata
sebesar 500-700kbps. Bandingkan
dengan throughput data CDMA
2000 1X yang cuma menghasilkan
80 kbps.

FITUR DAN LAYANAN
Fren, selain menawarkan

layanan percakapan biasa juga
memberikan layanan aplikasi
konten seperti faster data access,
traffic monitoring, video on
demand. Video on demand yang
sekarang sudah tersedia antara lain
adalah video infotainment, siraman
rohani dai kondang Abdullah
Gymnastiar atau AA Gym, dan klip
musik. Tersedia juga layanan WAP
Portal seperti berita (dari situs
detik.com dan Kompas Cyber Media
misalnya), info finansial seperti kurs
mata uang, layanan e-mail, dan info
sinema.

Sementara itu, peranti terminal
yang digunakan untuk
mengoptimalkan fitur dan layanan
Fren yang sudah tersedia di pasar
cukup banyak ragamnya, mulai dari
PDA berbasis Microsoft Windows
Pocket PC, notebook atau desktop
berbasis PCMCIA Card CDMA 1X
modem, atau ponsel yang
terkoneksi dengan kabel data
sebagai modem.

Dari sisi fitur yang ditawarkan,
keterbatasan yang sekarang ini
masih mendera layanan mobile
communications justru terletak
pada handset yang beredar di
pasaran. Kecuali menggunakan PDA

dan notebook, praktis handset-
handset yang beredar sekarang ini
masih benar-benar handset dengan
kemampuan minimal. Bahkan dari
sisi desain dan harga, ponsel-ponsel
berbasis CDMA yang dirilis oleh
Nokia, Motorola, Samsung, Verxion,
Sanex, ZTE, Kyocera, atau Modotel
belum bisa menandingi desain dan
harga ponsel-ponsel berbasis GSM
yang dirilis oleh vendor yang sama.

TARIF MAHAL?
Jawabnya relatif. Mahal

dibandingkan apa atau siapa?
Dibandingkan dengan tarif Flexi
atau Esia yang mendekati tarif
telepon rumah, tentu tarif Fren
jauh lebih mahal. Dibandingkan
dengan tarif telepon berbasis
GSM, Fren punya kemiripan.
Bahkan struktur pentarifannya
pun mengikuti pola pentarifan
yang dilakukan oleh sebagian
besar operator seluler GSM.

Tom A. Dinhasa, direktur
pemasaran Mobile 8 mengatakan,
Fren menyamakan tarif untuk
prabayar dan pascabayar. Untuk
tarif sambungannya, Fren
menggunakan tiga jenis
komunikasi yakni komunikasi
antarsesama pengguna Fren,
antara Fren dengan telepon

rumahan biasa, dan antara Fren
dengan operator seluler lain.

Untuk sambungan ke PSTN,
terdapat tiga jenis tarif yakni tarif
lokal seharga 800 per menit, tarif
zone 1 (kurang dari 200 km)
sebesar 2400 per menit, dan tarif
zone 2 (lebih dari 200 km) sebesar
3800 rupiah per menitnya.

Untuk sambungan ke
operator GSM yang lain, tarif

lokalnya seharga 1500 rupiah
per menit sedangkan tarif
nonlokalnya 3800 rupiah per
menit.

Yang paling murah adalah
tarif antara sesama pengguna
Fren, yakni 800 dan 1500 rupiah
untuk tarif lokal dan nonlokal.
SMS sendiri tarifnya 350 rupiah
per pesan dan berlaku untuk
semua operator.

Dengan struktur tarif
semacam itu, jelas bahwa Fren

mengincar pasar GSM. Tapi ia
punya nilai lebih di dalam
layanan komunikasi data.
Apalagi, tersedia akses Internet
gratis sampai dengan bulan
April 2004 untuk setiap
pembelian kartu Fren versi
Launch Edition.

Gitu, fren! PC+

Kartu perdana Fren. Menawarkan solusi
telekomunikasi mobile yang tak sekadar
cuap-cuap.

B.T. Lim, CEO Mobile-8 (kiri), “User tidak mementingkan teknologi
apa yang ada di belakangnya. Yang penting bagi mereka adalah
kenyamanan dan kemudahan.”

Menteri Perhubungan Agum Gumelar meresmikan peluncuran
perdana Fren didampingi oleh B.T Lim dan Hary Tanoesoedibjo
(Dewan Komisaris Mobile-8).
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B

komputer kita ke televisi atau
perangkat stereo di rumah kita.

Rumah sebagai home dan
bukan sekadar house boleh jadi
akan semakin mantap tatkala
semua peranti elektronik yang
bersifat digital bisa saling
berkolaborasi, bertukar medium,
dan bahkan berkomplementasi.

Beberapa tonggak teknologi
penting lainnya yang akan
membuat kehidupan digital di
rumah antara lain:
• Komputer sudah mulai bisa

memahami gerakan bibir
• Game berbasis PC akan

semakin canggih dan matang
dengan kualitas grafik yang

Teknologi wireless
sudah terasa sangat

matang sepanjang
tahun 2003 ini.

Sebagai salah satu
bukti, ia kini sudah

menjadi fitur standar
pada sebuah

komputer notebook,
sementara pada

tahun 2004 fitur dan
teknologi nirkabel ini

akan terintegrasi ke
dalam PC desktop,

sehingga komputer
akan menjadi lebih
mudah digunakan

sekaligus kabel-kabel
di rumah Anda akan

menjadi lebih sedikit.

ukti yang
lain, berbagai
standar baru berpusat
pada teknologi

wireless terus digarap untuk
membuat teknologi ini makin
nyaman dan aman.

Teknologi nirkabel juga
akan semakin meluas tatkala
gaya hidup digital menjadi
tuntutan hidup yang tak bisa
ditawar-tawar atau ditunda
lagi. Menghubungkan peranti-
peranti seperti MP3 Player,
kamera digital, telepon seluler,
ke dalam komputer selama ini
masih tergantung dengan
menggunakan sambungan
kabel, entah itu USB, firewire,
atau tipe-tipe interkoneksi
khusus.

Konsep tentang digital
home alias rumah digital yang
pernah ditulis di tabloid ini
boleh jadi akan semakin
manifes di tahun 2004
mendatang. Rabu (10/12) lalu,
Intel mempertontonkan konsep
tentang rumah digital
bertempat di Pakubuwono
Residence, Jakarta. Dari demo
yang ditunjukkan oleh Intel,
terlihat bahwa vendor-vendor
terkemuka sudah siap dengan
produk-produk mereka guna
mendukung gagasan tentang
digital home ini. Sebut saja
misalnya Acer, Asus, Micro Star
International, Shuttle Computer
Group, Soltek, Founder, Great
Wall, Legen Group, Samsung,
Fujitsu, Hitachi, dan NEC.

Apa bukti-bukti yang
memerlihatkan bahwa
kehidupan digital akan manifes
setidaknya di tahun depan?

Pertama, peranti-peranti
yang bersifat universal plug and
play sudah memungkinkan kita
untuk mengontrol komputer
menggunakan remote control
dari jarak hingga 3-4 meter,
sehingga Anda tak perlu
beranjak dari sofa duduk di
rumah Anda untuk menyalakan
atau mengoperasikan
komputer.

Kedua, adapter media
digital akan semakin luas
tersedia di toko-toko komputer
dan elektronik di manapun.
Dengan adanya adapter media
digital ini, kita dapat mengirim-
kan musik atau foto dari

makin
prima

• Layanan
broadband akan semakin
meluas tidak hanya di kota-
kota besar melainkan akan
semakin merasuk di kota-kota
kecil

• Kebutuhan orang untuk

menikmati musik
berkualitas akan meningkat
seiring dengan meningkat-
nya kualitas yang ditawar-
kan oleh beragam alat
pemutar musik digital. PC+

Menonton televisi bisa dilakukan di layar tivi lebar,
atau juga di layar notebook yang kecil, sembari
ngrumpi.
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Mengenal
Database PostgreSQL

(Bagian 2-habis)

Yahya Kurniawan
yahya@e-pcplus.com

Pada edisi lalu Anda
telah diberi

pengenalan mengenai
apa itu PostgreSQL
dan bagaimana cara

mengaktifkannya.
Sekarang kita akan

bahas bagaimana
bekerja dengan

PostgreSQL dalam
menangani sebuah

database.

ebagai
sebuah
contoh kasus,
kita akan membuat

sebuah database untuk
perpustakaan. OK, kita mulai
saja.

Pertama-tama jangan lupa
untuk ganti user postgres
terlebih dahulu (ingat,
sebelumnya Anda harus login
sebagai root).

# su postgres
bash-2.05b$

Membuat database
Untuk membuat database,

perintah yang digunakan adalah
sebagai berikut:

createdb namadatabase

Contoh:

bash-2.05b$ createdb
perpustakaan
CREATE DATABASE
bash-2.05b$

Jika berhasil, PostgreSQL
akan menampilkan “CREATE
DATABASE”.

Setelah database dibuat, kita
harus “masuk” dahulu ke dalam
database tersebut sebelum dapat
bekerja dengannya. Untuk
memasuki database
“perpustakaan” tadi perintah
yang digunakan adalah:

bash-2.05b$ psql -s perpustakaan
Welcome to psql 7.3.2, the
PostgreSQL interactive terminal.

Type: \copyright for distribution
terms
\h for help with SQL
commands
\? for help on internal slash
commands
\g or terminate with
semicolon to execute query
\q to quit

perpustakaan=#

Prompt akan berubah
menjadi namadatabase=#. Pada
keadaan ini kita telah siap untuk
bekerja dengan database
tersebut.

Opsi -s yang diberikan
setelah perintah psql berarti
setiap baris perintah harus
dikonfirmasi terlebih dahulu
sebelum dieksekusi.

Membuat tabel
Untuk membuat tabel,

perintah yang digunakan adalah
sebagai berikut:

CREATE TABLE namatabel
(definisi);

Namatabel adalah nama
dari tabel yang akan dibuat.
Definisi adalah rangkaian nama
field beserta tipe datanya.
Contoh:

perpustakaan=# create table buku(
perpustakaan(# isbn char(15),
perpustakaan(# judul varchar(30),
perpustakaan(# penulis
varchar(30),
perpustakaan(# penerbit
varchar(30),
perpustakaan(# thterbit date);
***(Single step mode: Verify
query)******************************
***************
create table buku(
isbn char(15),
judul varchar(30),
penulis varchar(30),
penerbit varchar(30),
thterbit date);
***(press return to proceed or
enter x and return to
cancel)********************

Sampai di sini Anda diminta
untuk melakukan konfirmasi,
apakah proses pembuatan tabel
akan diteruskan atau dibatalkan.
Jika diteruskan, tekan [Enter].
Jika hendak dibatalkan tekan [x]
kemudian [Enter]. Jika proses
pembuatan tabel akan diterus-
kan, PostgreSQL akan memberi-
kan output sebagai berikut:

CREATE TABLE
perpustakaan=#

Menambahkan record
ke dalam tabel

Untuk menambahkan record
ke dalam tabel, seperti biasa
gunakan perintah SQL Insert.
Contoh:

perpustakaan=# insert into buku
values (
perpustakaan(# '979-20-4716-
6','Pemrograman VB .NET
2003','Yahya Kurniawan',
perpustakaan(# 'Elex Media','2003-
08-01');
***(Single step mode: Verify
query)**********************
***********************
insert into buku values (
'979-20-4716-6','Pemrograman VB
.NET 2003','Yahya Kurniawan',
'Elex Media','2003-08-01');
***(press return to proceed or
enter x and return to can-
cel)********************
INSERT 16980 1
perpustakaan=#

Jika berhasil, PostgreSQL
akan menampilkan INSERT
disertai dengan angka-angka
tertentu.

Jika record yang hendak
ditambahkan hanya sedikit,
menggunakan perintah insert
tentu tidak masalah. Bagaimana
jika banyak?

Trik
lama yang
selalu
PCplus
gunakan
adalah
membuat
terlebih
dahulu
sebuah file
teks dengan
teks editor
berisi data-
data yang
akan
dimasukkan.

Setidaknya
dengan teks
editor fasilitas
penyuntingannya lebih
lengkap, sehingga menuliskan
data dengan jumlah banyak
tidaklah terlalu menjengkelkan.
Misalnya teks yang dibuat
isinya adalah sebagai berikut:

979-20-1819-0,VBScript,Yahya
Kurniawan,Elex Media,2000-07-01
979-20-2165-5,Apl. Web Dengan
ASP,Yahya Kurniawan,
Elex Media,2001-04-01
979-20-2165-5,Apl. Web Dengan
PHP MySQL,
Yahya Kurniawan,
Elex Media,2002-02-01

Simpanlah dengan nama
misalnya buku.sql. Perhatikan
bahwa pemisah antar data
pada teks tersebut adalah

karakter koma (,). Setelah itu,
data-data pada file teks
tersebut dimasukkan ke dalam
tabel dengan perintah Copy
yang sintaksnya adalah sebagai
berikut:

COPY table [ ( column [, ...] ) ]

FROM { 'filename' |
stdin }
[ [ WITH ]
[ BINARY ]
[ OIDS ]
[ DELIMITER [ AS ]
'delimiter' ]
[ NULL [ AS ] 'null
string' ] ]

atau
COPY table [ ( column [, ...] ) ]

TO{ 'filename' |stdout }
[ [ WITH ]
[ BINARY ]
[ OIDS ]
[ DELIMITER [ AS ]
'delimiter' ]
[ NULL [ AS ] 'null
string' ] ]

Sintaks pertama digunakan
untuk menyalin data dari file teks

perpustakaan=# select * from buku;
***(Single step mode: Verify query)*********************************************
select * from buku;
***(press return to proceed or enter x and return to cancel)********************

      isbn |           judul |     penulis |  penerbit |  thterbit

979-20-4716-6 | Pemrograman VB .NET 2003 | Yahya Kurniawan | Elex Media | 2003-08-01
979-20-1819-0 | VBScript | Yahya Kurniawan | Elex Media | 2000-07-01
979-20-2165-5 | Apl. Web Dengan ASP | Yahya Kurniawan | Elex Media | 2001-04-01
979-20-2165-5 | Apl. Web Dengan PHP MySQL | Yahya Kurniawan | Elex Media | 2002-02-01
(4 rows)

perpustakaan=#

+ + + +

sedangkan sintaks kedua
digunakan untuk menyalin data
ke file teks. Sekarang kita
terapkan perintah copy tersebut
dalam contoh tabel buku di atas
sebagai berikut:

perpustakaan=# copy buku from '/
home/postgres/buku.sql' with
delimiter ',';
***(Single step mode: Verify
query)*************************
********************
copy buku from '/home/postgres/
buku.sql' with delimiter ',';
***(press return to proceed or
enter x and return to cancel)
********************
COPY
perpustakaan=#

Jika berhasil, PostgreSQL
akan menampilkan “COPY”.

Mengambil query
Untuk mengambil query,

seperti biasa perintah yang
digunakan adalah perintah SQL
Select. Contoh:

Sudah tentu PostgreSQL juga
mengenal penggunaan kondisi
dan fungsi-fungsi tertentu dalam
penggunaan perintah select,
seperti yang diberikan pada
contoh-contoh berikut ini:

• select * from stok where
harga < 10000

• select max(suhu) from cuaca
• select buku.isbn,

buku.judul, buku.penulis,
penerbit.nama from buku,
penerbit where
buku.penerbit =
penerbit.nama

Nah, rasanya pengenalan
PostgreSQL cukup sampai di sini,
minggu depan kita akan belajar
koneksi dari PHP ke database
PostgreSQL. Sampai jumpa.  PC+
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Mengenal Atribut
File di Linux

(Bagian 2-habis)

Willy Sudiarto Raharjo
willy@e-jogja.net

M

Setelah selesai
melakukan

pengaturan attribut,
maka sekarang

saatnya kita mencoba
apakah file ini benar-

benar tidak bisa
dimodifikasi.

ari kita coba
login dengan user
biasa dengan
mengetikkan exit

untuk logout dari user root.
Sebelumnya, mari kita lihat
terlebih dahulu apa isi dari file
tersebut, dengan perintah cat
<nama_file>, seperti pada
Gambar 1.

Sekarang kita akan
melakukan proses editing
terhadap file tersebut dengan
sebuah teks editor. Anda bebas
memilih teks editor kesayangan
Anda, namun penulis akan
menggunakan vi, salah satu
teks editor paling sederhana
yang ada dalam sistem Linux.
Setelah file diedit, kita coba
untuk menyimpan file, maka
akan muncul pesan error,
seperti pada Gambar 2. Tam-
pak bahwa file memang tidak
bisa dihapus isinya. Namun,
dengan melihat definisi di atas,
kita bisa melihat bahwa file se-
harusnya bisa ditambah isinya.

Mari kita coba bersama.
Keluarlah dari teks editor dan
batalkan semua perubahan
yang telah Anda lakukan. Pada
vi, hal ini dilakukan dengan
menekan tombol Esc untuk
menuju command mode, dan
dilanjutkan dengan perintah :q!
Untuk membatalkan semua
perubahan dan keluar dari vi.
Setelah itu, ketikkan echo
tambahan >> <nama_file>.
Perintah ini berfungsi untuk
memasukkan kata tambahan
pada <nama_file>. Setelah itu,
Anda bisa lihat isi file dengan
perintah cat (Gambar 3).
Tampak bahwa isi file sudah
berubah. Perhatikan, bahwa file
yang sudah memiliki attribute
a, tidak akan bisa dihapus, oleh
user root sekalipun, sebelum
attribut ini dihapus, oleh karena
itu, jangan asal memberikan
attribute ini pada semua file
Anda.

Anda ingin lebih ekstrem?
Bisa!!. Dengan memberikan
attribut i, maka file Anda tidak
akan bisa dimodifikasi dengan
cara apapun. Cara ini akan
sangat efektif bila Anda ingin
agar orang lain bisa melihat isi
file Anda, namun tidak
diperkenankan untuk
memodifikasinya. Meskipun
Anda bisa melakukan hal ini
dengan perintah chmod,
namun penggunaan attribute
ini kadangkala lebih bersifat
transparan dan dapat Anda
gunakan untuk memproteksi
data Anda secara lebih aman,
misalnya ketika Anda telah
salah memberikan ijin akses
777, yang berarti file Anda
World-Writeable (dapat ditulis
oleh semua orang). Namun,

selama file ini masih mempunyai
attribute a, maka file tersebut
akan tetap aman dari serbuan
modifikasi dari orang lain.
Gabungan dari penggunaan
attribute dan hak akses akan
menambah lapisan pelindung
terhadap file Anda.

Perlu dipahami bahwa tidak
semua attribute ini bisa berguna
bagi Anda. Pilihlah attribute yang
memang betul-betul diperlukan
saja, karena penggunaan
beberapa attribute justru bisa
menimbulkan kerepotan

tersendiri bagi Anda. Salah satu
contohnya adalah attribute a ini.
Jika kita memberikan attribute a
pada file dan suatu saat kita
ingin menghapusnya, maka kita
harus login sebagai user root
terlebih dahulu dan menghapus
attribuet ini dengan perintah
chattr -a <nama_file>, baru kita
bisa menghapus file tersebut.
Sebuah pemborosan waktu yang
tidak akan terjadi jika kita tidak
memberikan attribute pada file.
Selamat mencoba dengan
attribute file yang lain. PC+

Gambar 3

Gambar 2

Gambar 1

Menambahkan Side Image
dan Mengedit Submenu

pada Menu Bar KDE
Pengguna OS Windows tentunya akan sangat
mengenali dengan baik tampilan pada sisi kiri menubar yang
menampilkan image dengan tulisan Windows 9x atau Windows XP
secara vertikal (untuk Win XP, image ini muncul jika Anda
menggunakan classic style). Image yang berada pada sisi kiri menu
bar ini disebut sebagai side image. Dengan menggunakan OS
Window Anda juga dapat melakukan perubahan nama-nama
submenu pada menu bar tersebut dengan mengutak atik registry
ataupun dengan bantuan program seperti Winboost. Jika Anda
menggunakan OS Linux Anda akan memilki dua pilihan desktop
yaitu KDE dan GNOME. Bagi Anda yang “Windows Minded” dan
meginginkan tampilan menu bar Anda seperti pada OS Windows,
maka Anda dapat menggunakan desktop KDE, meskipun untuk

melakukan pilihan ini  komputer Anda harus memiliki “daya
ingat” lebih dari 128MB agar dapat berjalan dengan baik. Anda
dapat melakukan kustomasi pada menubar KDE seperti
menambahkan side image dan mengubah nama-nama pada
submenu  dengan mudah tanpa harus melakukan langkah yang
cukup rumit ataupun menggunakan pogram tambahan seperti di
Windows. Untuk melakukan pengeditan pada menubar KDE
tersebut ikuti langkah berikut:

• Login sebagai root, isikan password dan sebelum menekan
[Enter] atau klik [OK], pilih session KDE.

• Klik [Main Menu]>[Control Center]>[Desktop]>[Panels].
• Arahkan mouse Anda pada tab Menus.
• Untuk menambahkan side image pada menu bar, berikan

tanda centang pada checkbox Show side image.
• Untuk melakukan pengeditan submenu pada menu bar KDE,

klik tombol [Edit K Menu].
• Pada dialog box KDE Menu Editor, klik submenu yang akan

Anda edit kemudian lakukan pegeditan seperti mengubah
nama submenu, jenis icon, user, shortcut key, dll dengan hanya
menggunakan klik mouse. Setelah melakukan pengeditan,
jangan lupa klik tombol [Apply].

Untuk melihat hasilnya, klik menu bar KDE, dan lihat
tampilannya sekarang. Menu bar KDE Anda memilki side image
yang bertuliskan KDE 3.1 (Jika Anda menggunakan Linux RH 9.0)
secara horizontal. Disamping itu juga submenu yang ada juga
telah mengalami perubahan sesuai dengan setting yang telah
Anda lakukan.

Arif Perdana
mail_id_2001@yahoo.com
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SysMark 2002
Rating :287
Internet Content :354
Office Productivity:232

3D Mark 2001
640 x 480  16bit :17281
1024 x 768  32bit :13841

3D Mark 2003
640 x 480 :6075
1024 x 768 :3909

Quake III Arena
640 x 480  normal :366,6
1024x768 high quality:360,3

TMPGenc
36 menit 57 detik

Serious Sam
640 x 480 :129,5
1024 x 768 :92,3

Sebagai salah
satu produsen yang
cukup ternama, DFI
mengeluarkan beberapa
seri yang cukup menarik
yaitu Infinity dan LAN
Party. Salah satunya
adalah seri LAN Party NF2
Ultra B yang
memanfaatkan chipset
nVidia, yaitu nForce2
Ultra 400.

Seperti juga produk
yang menggunakan
chipset nForce II, sistem
yang diterapkan pada
produk ini adalah AMD
bersoket 462 pin
dengan dukungan FSB
400MHz atau kelas di bawahnya.
Dukungan terhadap teknologi
dual channel pada memori
utamanya juga bisa dinikmati
pada produk yang mengusung 3
buah soket DIMM 184 pin
berkapasitas 3GB yang
disertakan.

Sementara, Southbridge-
nya yang menggunakan nForce2
MCP-T sudah mendukung pula
teknologi mutakhir yang ada.
Sebut saja dukungan terhadap
ATA 133 dan LAN onboard.
Menarik untuk disimak adalah
adanya fitur dual LAN pada
produk yang juga menyertakan
dua buah port LAN pada sistem
input-outputnya. Fitur ini
dimungkinkan mengingat
selain menggunakan controller
LAN bawaan dari Southbridge-

Asus kembali
mengeluarkan seri terbarunya
yang cukup inovatif. Tidak
seperti biasanya, produsen yang
berkedudukan di Taiwan ini
mengusung chipset bikinan ATI
sebagai pengendali utamanya.

P4R800-VM yang berbasis
prosesor Intel Pentium-4 478
pin ini menggunakan chipset
ATI Radeon 9100IGP untuk
Northbridge-nya dan ATI IXP200
untuk Southbridge-nya.
Pemakaian Radeon 9100IGP
sebagai Northbridge ini
membuat sistem ini sudah
mendukung teknologi Hyper-
threading dan mendukung
penggunaan prosesor ber-FSB
800MHz pada prosesor Intel
terkini atau varian di
bawahnya. Selain itu, untuk
memori yang digunakan, sistem
yang mengusung 4 buah soket
DIMM 184 pin dua warna ini
juga sudah mendukung
teknologi dual channel untuk
memori PC-3200 hingga
kapasitas 4GB.

nya, produk ini juga dipersenjatai
pula dengan controller LAN
tambahan dari kelas Realtek
RTL8110S gigabit LAN. Tak lupa
disertakan pula 4 buah port serial
ATA, baik penggunaan biasa
maupun untuk sistem RAID. Fitur
lain yang disertakan adalah dua
buah port infrared, 3 port firewire
1394, dan sebuah port tambahan
USB.

Selain itu, disertakan pula
sebuah controller suara onboard
dari kelas Realtek ALC650 yang
sudah mendukung teknologi
suara 6 channel. Yang menarik,
untuk mendukung keluaran suara
yang dihasilkan, DFI menyertakan
5 buah port audio untuk keluaran
analog dan dua buah port untuk
keluaran berbasis S/PDIF pada port
input-outputnya. Adanya dua

jenis port ini sangat
membantu buat
pengguna speaker
modern untuk
memilih jenis
keluaran sinyal

audio yang dihasilkan.
Tak kalah menarik

diperhatikan adalah sistem
AwardBIOS yang dimilikinya.
Tampaknya DFI cukup serius
mempersenjatai BIOS produk ini
dengan fitur-fitur yang cukup
menarik. Sebut saja fitur CMOS
Reloaded yang menjadi trademark
dari motherboard DFI saat ini.
Dengan fitur ini, pengguna bisa
mengatur setting BIOS yang
paling sesuai untuk aplikasi
tertentu agar sistem bekerja
secara maksimal. Tak ketinggalan
adalah fitur buat overclock
prosesor maupun memori yang
cukup lengkap, plus pengaturan
setting fitur lain yang cukup
memuaskan.

PCplus menguji produk ini
dengan menggunakan test bed
baru yaitu prosesor AMD Athlon
3200+ FSB400MHz, memori

Kingston 1GB dua keping,
harddisk Barracuda ATA 7200.7
40GB, kartu grafis Albatron
GeForce FX5700 128MB DDRII,
power supply Enlight 420W, dan
monitor ViewSonic PF950F+.
Driver yang digunakan adalah
versi terbaru yaitu 3.13 dengan
detonator 52.16. Pengujian
dilakukan dengan menggunakan
software SysMark 2002,
3DMark2001, 3DMark 2003,
Quake3 Arena Demo, TMPGenc,
dan Serious Sam.

Dari uji ini, terlihat
kemampuan yang ditawarkan
produk ini cukup baik.
Dibandingkan dengan produk
sejenis yang sudah diuji, skor yang
dihasilkan umumnya sudah lebih
tinggi, termasuk untuk proses
encoding yang lebih cepat.

Pada kemasan jualnya, selain
disertakan dua buku manual yang
sangat lengkap, disertakan pula
kabel-kabel data, port-port
tambahan, CD driver plus software
tambahan, dan sebuah case
badge. Buat pengguna yang
menginginkan fitur motherboard

Seperti pada produk yang
menggunakan chipset sejenis,
Asus juga memberikan beragam
fitur onboard pada produk
bertipe all in one ini. Sebut saja
yang paling nyata terlihat adalah
adanya VGA onboard yang
dilengkapi dengan fitur memory
frame buffer hingga 128MB pada
BIOS-nya ini. Untuk tipe ini,
produsennya menggunakan
controller GPU onboard dari kelas
ATI Radeon 9200 yang memiliki
kemampuan yang cukup baik
untuk beragam aplikasi. Meski
begitu, terbuka pula
kemungkinan untuk upgrade
VGA karena pada sistem ini
disertakan pula sebuah port AGP
hingga mode 8X yang sudah
mendukung kartu grafis
termodern saat ini.

Tak ketinggalan pula
disertakan pula 3 buah slot PCI
untuk bermacam kartu add- on
yang mungkin dipasang pada
sistem ber-form factor micro-ATX
ini. Selain itu, sebuah controller
LAN dari kelas Realtek RTL8201BL

juga disertakan selain juga
sebuah controller audio dari kelas
ADI AD1888 yang sudah
mendukung teknologi suara 6
channel. Untuk mendukung
controller audionya, selain port
audio standar dengan 3 buah
port, disertakan pula sebuah port
S/PDIF untuk keluaran tipe
coaxial yang sudah banyak
digunakan pada speaker modern.

Sementara, untuk interface-
nya, selain menyertakan port
standar, P4R800-VM juga
memiliki 4 buah port USB yang
tertanam pada body-nya dan bisa
diekspansi 2 port lagi. Disertakan
pula sebuah port serial tambahan
yang dilengkapi dengan
braketnya.

Sayangnya, pada BIOS yang
disertakan, tidak ada fitur yang
spesial. Produk berbasis AMI BIOS
yang menyertakan hardware
monitoring ini tidak menyertakan
sama sekali kemampuan untuk
menaikkan frekuensi kerja
prosesor maupun memori yang
digunakan.

PCplus menggunakan test
bed prosesor Intel 3,2GB
FSB800MHz, memori PC-3200
512MB 2 keping, harddisk
Barracuda 7200.7 40GB, power
supply Enlight 420W, dan monitor
Samsung SyncMaster 990NF. Driver
yang digunakan adalah driver
terbaru yang di-download dari
situs ATI.

Dari serangkaian uji yang
dilakukan, terlihat hasil yang
diperoleh menunjukkan hasil yang
relatif standar. Skor yang dihasil-
kan tidak terlalu tinggi namun
sudah memadai untuk beragam
aplikasi ringan hingga sedang.

Buat pengguna yang sensitif
harga namun memerlukan sistem
yang all in one, produk ini bisa
dipertimbangkan. (sil)

SysMark 2002
Rating :300
Internet Content :412
Office Productivity:219

3D Mark 2001
640 x 480  16bit :6847
1024 x 768  32bit :5154

Quake III Arena
640 x 480  normal :168,8
1024x768 high quality:79,6

TMPGenc
37 menit 05 detik

Serious Sam
640 x 480 :48,5
1024 x 768 :30,7

yang  lengkap dan teranyar,
produk ini bisa jadi pilihan
utama untuk yang berbasis
AMD. (sil)

ARE/PCplus

ARE/PCplus
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SL-75MRN:

Motherboard Bertenaga
dari Soltek

Berca Cakra Teknologi
www.soltek.com.tw

☎ (021) 2316352
93 dolar AS

Gigabyte GA-7S748-L:

Pertama dengan
Chipset SiS untuk AMD

Nusantara Eradata
www.gigabyte.com.tw

☎ (021) 6018218
86 dolar AS

SysMark 2002
Rating :247
Internet Content :315
Office Productivity:193

SisoftSandra 2002
ALU :8017 MIPS
FPU :3282 MFLOPS

3D Mark 2001
640 x 480  16bit :13483
640 x 480  32bit :13155
800 x 600  16bit :12292
800 x 600  32bit :11887
1024 x 768  16bit :10653
1024 x 768  32bit :10381

Quake III Arena
640 x 480  16bit :247,7fps
640 x 480  32bit :246,8fps
800 x 600  16bit :244,7fps
800 x 600  32bit :240,7fps
1024 x 768  16bit :233,8fps
1024 x 768  32bit :219,9fps

Salah satu seri
motherboard Soltek yang saat
ini bisa ditemui di pasaran
adalah seri SL-75MRN yang
mengusung chipset nVidia
yaitu nForce2. Chipset ini
memang tidak tergolong baru.
Namun, buat pengguna
prosesor AMD berbasis soket
462 alias soket A, chipset ini
masih merupakan salah satu
chipset tertangguh di pasaran.

Datang dengan soket A,
motherboard ini sudah
mendukung prosesor AMD
Athlon ber-front side bus
400MHz atau varian di
bawahnya. Sementara, untuk
memorinya, produk yang
mengusung 3 buah soket
DIMM 184 pin ini juga sudah
mendukung teknologi dual
channel untuk jenis memori PC-
3200 atau di bawahnya dengan
kapasitas hingga 3GB.

Seperti motherboard yang
dilengkapi dengan chipset
modern, fitur-fitur yang
melengkapi produk ber-form
factor ATX ini juga cukup

Akhirnya
Gigabyte memproduksi
motherboard dengan chipset
SiS untuk sistem berbasis AMD.
Padahal, beberapa bulan lalu
kami sempat mendapat
konfirmasi bahwa vendor asal
Taiwan yang satu ini belum ada
rencana untuk membuat
produk yang menggunakan
chipset SiS untuk AMD. Mereka
lebih memilih menggunakan
chipset VIA, dan kemudian
nVidia.

Saat diluncurkannya
chipset SiS748 sekitar per-
tengahan tahun 2003, Gigabyte
juga masih belum seagresif
vendor lain dalam merilis
produk yang memanfaatkan
chipset tersebut. Namun,
tentunya mereka tidak ingin
kehilangan peluang. Melihat
teknologi yang didukung oleh
chipset SiS ini, Gigabyte

menarik.
Selain
menyertakan
port AGP 8X/
4X, chipset
Southbridge-
nya yaitu
nForce2 MCP
juga
mendukung
penggunaan 5
slot PCI, 2
paralel ATA 133/ 66/33.

Kelengkapan lainnya yang
dimiliki oleh produk berwarna
dasar kuning keemasan ini
adalah adanya LAN onboard
yang mendukung 10/100 fast
Ethernet base T LAN. Tak
ketinggalan disertakan pula
sebuah controller suara onboard
AC’97 dari kelas ALC650 yang
sudah mendukung teknologi
suara 6 kanal. Tak lupa produk ini
dipersenjatai pula dengan fitur
USB untuk interface data dengan
kecepatan tinggi.

Produk berbasis Award BIOS
ini juga menyertakan sebuah
VGA onboard dari kelas GeForce4

MX untuk sistem yang lebih
ekonomis namun dengan
performa yang cukup lumayan.
Untuk mendukung VGA onboard
yang disertakan ini, Soltek
menyediakan fitur share memori
hingga sebesar 128MB. Dengan
share memori sebesar ini,
dukungan terhadap aplikasi
game 3D sudah cukup baik.

Dari BIOS yang ditawarkan
produsennya, tidak terdapat fitur
yang cukup istimewa kecuali
pada fitur System Performance
untuk menentukan FSB prosesor
dan clock kerja dari memorinya.
Tersedia pilihan Optimal, Aggres-
sive, Turbo, atau Expert. Untuk

pilihan Expert, tersedia pilihan
FSB dari kecepatan 100MHz
hingga 250MHz. Buat
overclocker, ini adalah fitur yang
cukup menarik. Untuk fitur ini,
pengguna memang harus
mengetahui bagaimana men-

setting kedua fitur ini dengan
tepat agar prosesor maupun
memori bekerja pada clock
yang sesuai.  Namun
sebelum itu, pengguna
juga harus memasang
jumper untuk CPU clock
pada posisi yang tepat.

Sementara, untuk
desainnya, SL-75MRN
ini tergolong
standar. Hanya
posisi pada port
input output
yang terlihat

agak berbeda.
Sementara, untuk port power,
Soltek masih meletakkan kedua
port power ini di bagian tengah
yang kemungkinan besar kabel
power dari power supply akan
mengganggu aliran udara pada
sistem bila sudah diletakkan di
dalam casing.

PCplus menguji produk ini
dengan menggunakan test bed
baru, yaitu prosesor AMD Athlon
3200+ FSB400MHz, memori
Kingston 1GB dua keping,
harddisk Barracuda ATA 7200.7
40GB, kartu grafis Albatron
GeForce FX5700 128MB DDRII,
power supply Enlight 420W, dan
monitor ViewSonic PF950F+.
Driver yang digunakan adalah

akhirnya memutuskan untuk
membuat produk untuk itu.

Saat ini ada dua jenis produk
motherboard Gigabyte yang
menggunakan chipset SiS748:
yaitu GA-8S748, yang merupakan
versi standar, dan GA-7S748-L
yang menggunakan fitur LAN
onboard. Tidak ada versi Ultra,
apalagi yang menggunakan
fasilitas 6 Dual Channel Miracle,
karena tampaknya produk seri ini
memang ditujukan untuk
pengguna pada segmentasi value
user.

Meskipun chipset-nya
ditujukan untuk kelas value,
namun mobo yang kita uji kali
ini, yaitu GA-7S748-L, bukanlah
produk low end. Teknologi yang
didukung dan fitur kelengkapan
yang disediakan cukup membuat
seri GA-7S748 menarik untuk
dimiliki.

Sebut saja seperti dukungan

terhadap semua generasi
prosesor AMD K7 yang ber-FSB
200, 266, 333, dan 400 mulai dari
Duron hingga Athlon XP dengan
core Barton, kartu grafis terbaru
AGP 4x/8x, serta memori DDR
2100, DDR 2700, dan DDR3200.

Untuk menampung modul
memori tersebut, pada
motherboard ini tersedia tiga
buah slot DDR-DIMM 184-pin
yang dapat digunakan untuk
menampung memori hingga
kapasitas maksimal 3GB. Pada
motherboard yang chipset-nya
terdiri dari northbridge SiS748
dan southbridge SiS 963L,
tertanam chip lain yaitu ALC655
keluaran Realtek yang
merupakan chip Codec AC’97.

Konektor internal input
output pada board yang memiliki
form factor ATX berukuran 30,5 x
20 cm ini di antaranya adalah
FDD port, dua buah port UDMA
ATA133/100/66 Bus Master IDE,
sebuah konektor USB 2.0 yang
mendukung dua port USB, dua
buah cooling fan pin header, dan
sebuah konektor game/MIDI.

SysMark 2002
Rating :279
Internet Content :349
Office Productivity:233

3D Mark 2001
640 x 480  16bit :16785
1024 x 768  32bit :13535

3D Mark 2003
640 x 480 :6409
1024 x 768 :3501

Quake III Arena
640 x 480  normal :345,3
1024x768 high quality:337,4

TMPGenc
37 menit 20 detik

Serious Sam
640 x 480 :126,3
1024 x 768 :92,5

versi terbaru yaitu 3.13 dengan
detonator 52.16. Pengujian
dilakukan dengan
menggunakan software
SysMark 2002, 3DMark2001,
3DMark 2003, Quake3 Arena
Demo, TMPGenc, dan Sisoft
Sandra 2003Pro.

Dari sisi kemampuan yang
ditawarkan, sistem ini memang
cukup bertenaga untuk
mendukung kerja prosesornya.
Skor yang diraih sudah cukup
tinggi, meski pada saat
melakukan encoding, prosesnya
cukup lama. (sil)

ARE/PCplus

Sebanyak lima buah slot PCI
tersedia pula pada board ini.
Sedangkan pada panel belakang,
fasilitas yang tersedia adalah
empat buah port USB, dua buah
port COM, sepasang port PS/2,
port LAN, dan port Audio.

Dari BIOS, fitur yang tersedia
antara lain adalah hardware
monitoring, hardware detect and
report for voltage and fan speed,
mendukung auto temperature
detect serta menyediakan fungsi
thermal shutdown. Namun
demikian, fasilitas Dual BIOS
tidak tersedia pada board ini.

Kami menguji Gigabyte GA-
7N400E-L Ultra ini menggunakan
AthlonXP 3000+. Untuk memori
utamanya, kami menggunakan
dua keping memori Corsair DDR
PC-3200 berkapasitas 256MB.
Untuk uji grafisnya, kami
memasang Gigabyte GV-
R96P128D yang menggunakan
chip ATi Radeon 9600Pro 128MB,
sedangkan untuk menyimpan
sistem operasi dan software uji,
kami menggunakan Seagate
Barracuda 7200.7 40GB. Untuk

OS-nya sendiri kami
menggunakan Windows XP
Professional dengan Service
Pack 1. (fmn)

ARE/PCplus
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V-Gen PC-3200:
Memori PC-3200 dengan
CAS Latency 3

Sennheiser PC150:

Merengkuh Kepala
dengan Merdu Nada

Astrindo Senayasa
www.sennheisercommunications.com

☎ (021) 6121330
84 dolar AS

Magicstor 1022C:

Compact Flash Type II
dengan Kapasitas Jumbo

PT Equal Solusindo
www.gs-magicstor.com

☎ (021) 6596587
230 dolar AS

Interface Computer
☎ (021) 6597133

44 dolar AS

Salah satu merek
memori yang bisa ditemui di pasar
Indonesia adalah V-Gen.
Perusahaan third party ini
memasarkan hampir semua jenis
memori yang luas digunakan.
Salah satu tipe yang dipasarkan
adalah jenis PC-3200. Jenis memori
ini dari sisi sikronisasi sudah cocok
dengan FSB prosesor terbaru dari
Intel maupun AMD.

PCplus menerima dua sampel
memori yang memiliki frekuensi
200MHz (berarti bekerja efektif
pada frekuensi 400MHz karena
sistem double data rate) yang
masing-masing memiliki kapasitas
sebesar 256MB. Dua keping yang

Perkem-
bangan
periferal dewasa ini
membawa dampak pula pada
media penyimpanan data.
Untuk saat ini, beragam media
penyimpan data bisa ditemukan,
dari yang berukuran besar
hingga yang berukuran
supermini. Salah satu media
penyimpan yang paling banyak
dipakai adalah compact flash.

Salah satu produsen
penghasil compact flash yang
sejak tahun lalu meramaikan

Sennheiser Com-
munication sebagai salah
satu perusahaan joint venture
yang bergerak di bidang
komunikasi mengeluarkan
beberapa seri produk headset.
Salah satu yang sudah bisa
didapatkan di Indonesia adalah
versi PC150. Dari namanya sudah
bisa ditebak kalau produk
buatan Denmark ini memang
dirancang untuk kebutuhan
para pengguna PC ataupun
notebook untuk beragam
aplikasi, termasuk VOIP.

Dari spesifikasi yang
diberikan, PC150 yang

dilengkapi fitur khusus noise
cancelling microphone ini
memang cukup menjanjikan
untuk para penikmat audio.
Dengan frekuensi respons antara
20Hz hingga 22KHz dan
impedansi sebesar 32ohm,
headphone yang dimilikinya
menjanjikan kemampuan
mengeluarkan suara yang cukup
lebar, dari frekuensi rendah
hingga frekuensi tinggi.

Sementara, untuk micro-
phone-nya yang menempel pada
headphone sebelah kiri, frekuensi
respons yang dimilikinya
mencapai 80Hz hingga 15KHz

dengan impedansi sebesar 2 kilo
ohm.

Pada kabel konektornya,
Sennheiser PC150 ini dilengkapi
pula dengan pengendali volume
suara yang digabungkan dengan
indikator kekerasan suaranya.
Selain itu, fitur ini dipersenjatai
pula dengan microphone mute
switch bila penggunanya ingin
agar headset ini hanya digunakan
untuk mendengarkan sinyal audio
saja.

Menariknya, produk yang
menggunakan konektor audio
berukuran 3,5mm sebanyak dua
buah untuk headphone maupun
microphone-nya ini menggunakan
kabel sepanjang 3 meter yang
sangat kuat karena terbuat dari
karet yang biasa digunakan pada
rompi antipeluru.

Headset ini sendiri memiliki
bahan yang cukup lentur dan
nyaman digunakan. Untuk
headphone-nya, Sennheiser
menyertakan pula busa untuk

kenyamanan telinga
yang dapat diputar 360
derajat sehingga
bisa disesuaikan
dengan ka-
rakteristik
telinga pen-
dengarnya.
Selain itu,
Sennheiser
juga
menyertakan
busa di bagian headband untuk
kenyamanan pemakaian.

Dari uji yang dilakukan PCplus
dengan menggunakan beragam
aplikasi, baik untuk CD audio, game
3D, maupun untuk chatting,
headset yang nyaman dipakai ini
dari segi audio yang dikeluarkan
sudah cukup baik. Suara berfre-
kuensi rendah cukup jernih ditang-
kap. Efek surround yang jernih di-
hasilkan juga sangat terasa menge-
lilingi kepala. Ketika mendengarkan
CD audio, karakter masing-masing
instrumen jelas terdengar.

Pada kemasan jualnya,
Sennheiser menyertakan pula
sebuah keterangan spesifikasi
teknis PC150 dan sebuah buku
manual praktis. Buat pengguna
PC atau notebook yang ingin
mendengarkan musik atau game
tanpa mengganggu sekitar,
produk ini boleh jadi salah satu
pilihan yang baik. (sil)

persaingan adalah Magicstor.
Produsen yang berkedudukan di

Cina ini mengeluarkan pula
produk compact flash

untuk beragam
keperluan. PCplus
memperoleh satu
dari sekian produk

compact flash buatan-
nya yaitu dari seri 1022C.

Kesan pertama dari
produk jenis CF+ tipe II ini

dibanding produk compact flash
yang umum di pasaran adalah
ukurannya yang sedikit lebih tebal
dari ukuran standar. Oleh karena
itu, masalah kompatibilitas
produk dengan tebal 5 milimeter
ini dengan perangkat lain semisal
printer, kamera digital, atau card
reader harus diperhatikan bila
menggunakan produk yang
memiliki 50 lubang untuk
interface data ini. PCplus,
misalnya, mendapati produk
dengan berat 16 gram ini tidak
dapat dipasang pada kamera

digital Kodak DC260 maupun
Ixus400 yang memanfaatkan
compact flash sebagai media
penyimpan datanya. Ukuran yang
lebih besar ini dikarenakan
standar yang digunakan produk
ini adalah CF tipe II sehingga tidak
semua perangkat mendukung tipe
ini. Oleh karena itu, hanya kamera
tertentu yang sudah mendukung
penggunaan tipe II ini saja yang
kompatibel dengan produk yang
memiliki rotion speed sebesar
4.200rpm dengan tegangan 3,3/
5.0 volt ini.

Keunggulan yang jelas
terlihat dari produk yang

dilengkapi pelindung metalik ini
adalah kapasitasnya yang super
besar. Dengan kapasitas sebesar
2,2GB, data yang bisa disimpan
memang sangat banyak. Ini tentu
menjawab tuntutan sebagian
besar pengguna akan kapasitas
tampung yang besar dari compact
flash yang dipakai. Ketika PCplus
menggunakan produk ini pada
kamera digital Minolta Dimage 7i
mengunakan setting JPEG dan
superfine untuk mendapatkan
gambar, image yang bisa ditam-
pung bisa mencapai 740 gambar.

Pada kemasan jualnya,
produsen hanya menyertakan

tidak memiliki heatspreader ini
benar-benar identik dan sama sama
menggunakan chip bikinan
Samsung dengan chip bernomor
K4H560838E-TCCC. Masing-masing
keping merupakan tipe memori
single side yang dipersenjatai
dengan 8 buah IC dengan kapasitas
32MB. Pada keadaan default-nya,
kemampuan teknis yang
ditawarkan cenderung standar yaitu
dengan CAS latency 3, T(RAS) 8,
T(RCD-read) 3, T(RCD-write) 3,
R(RP)3.

PCplus menguji produk ini
dengan menggunakan test bed
yaitu prosesor AMD Athlon 3200+
FSB400MHz, Motherboard NFII ultra

B, harddisk Barracuda ATA 7200.7
40GB, kartu grafis Albatron GeForce
FX5700 128MB DDRII, power supply
Enlight 420W, dan monitor
ViewSonic PF950F+. Driver yang
digunakan adalah versi terbaru
yaitu 3.13 dengan detonator 52.16.
Pengujian dilakukan dengan
menggunakan, 3DMark2001,
3DMark 2003, Quake3 Arena Demo,

dan Sisoft Sandra 2003 Pro.
Dari serangkaian uji yang

dilakukan PCplus menggunakan
dua keping memori ini pada
beragam tipe motherboard,
kompatibilitas yang dimiliki produk

ini cukup baik. Bisa jadi
ini dikarenakan chip

yang digunakan cukup
baik dan
kompatibel dengan
beragam chipset
yang beredar saat
ini.

Nyatanya,
PCplus juga

mendapati memori ini tetap bekerja
stabil pada CAS latency CL2,5.
Sementara, untuk overclock memori
ini mampu bekerja hingga batas
frekuensi 215MHz, atau 7,5% dari
frekuensi standarnya dengan
perbandingan dengan FSB prosesor
1:1. Setelah itu, sistem cenderung
tidak lagi stabil.

Buat pengguna yang memiliki
sistem prosesor ber-FSB 800MHz

3DMark 2001
640 x 480  16bit :17204

3D Mark 2003
1024 x 768 :3912

Quake III Arena
640 x 480  normal :357,4fps

Sisoft Sandra 2003 Pro RAM Int
Buffered :3066,3

SisoftSandra 2003 Pro RAM Float
Buffered :2871,3

untuk yang berbasis Intel dan
FSB400MHz untuk yang berbasis
AMD, memori ini bisa jadi pilihan.
Selain lifetime warranty yang
diberikan distributornya,
kemampuan yang ditawarkan
juga sudah memadai untuk
penggunaan biasa. (sil)

sebuah penutup dari plastik
sebagai pelindung. Buat
pengguna yang ingin memiliki
compact flash sebagai media
penyimpan data  dengan
kapasitas besar namun dengan
harga yang relatif terjangkau,
produk ini bisa dijadikan pilihan
menarik. Namun, Anda harus
menyesuaikan dengan ukuran
slot yang dimiliki pada
perangkat Anda. (sil)

ARE/PCplus

ARE
/P

Cpl
us

ARE/PCplus



plusGame IV • 16 Desember 2003 - 05 Januari 2004
PCplus 156

| 51

Call Of Duty:
Pertempuran Berlatar

Perang Dunia II

Dwinanto
antotheninja@yahoo.com

G

Call of Duty
membawa kita

kembali ke masa
Perang Dunia II,
sebuah periode

sejarah yang sangat
familiar bagi para

pemain game. Game
ini memberikan
suasana perang

seperti sesungguhnya.
Ide tentang prajurit

super, yang
memenangkan

perang seorang diri,
tidak akan kita temui

di sini. Ingat game
Medal of Honor:

Allied Assault?

ame tersebut
merupakan
game pertama yang
menempatkan

pemainnya sebagai bagian dari
pasukan. Dengan misi-misi
seperti pendaratan di pantai
Omaha, atau pertempuran
penuh kekalutan di hutan
Ardennes, Medal of Honor:
Allied Assault menjadi contoh

bagi game lain. Tim dalam
Infinity Ward, perusahaan
pengembang Call of Duty,
dulunya adalah bagian dari
2015 Studios yang telah sukses
dengan Medal of Honor-nya.

Dalam Call of Duty kita
akan melihat PD II dari
perspektif tiga pasukan sekutu:
Amerika Serikat, Inggris dan
Rusia - masing-masing memiliki
misi tersendiri dengan skala
pertempuran lebih besar. Kita

akan dibuat
tercengang pada
misi pertama
dalam campaign
pasukan Rusia.
Momen awalnya
seperti pada film
"Enemy at The
Gate",
menggambarkan
kondisi yang

memprihatinkan saat pasukan
Rusia melawan pasukan
Wermacht Nazi-Jerman.

Misi dalam game ini
bervariasi, contohnya sabotase
terhadap bendungan Elber,
mempertahankan sebuah kota di
Perancis, atau menjalankan tank
T34 menuju Berlin. Namun,
beberapa misi bergaya prajurit
komando (seperti sabotase
bendungan Elber) rasanya kurang
sesuai dengan ide keseluruhan
dalam game ini - seperti kembali
ke ide klise, jagoan yang beraksi
seorang diri. Namun banyaknya
momen fantastis dalam game ini
bisa membuat para penggemar
shooter game ingin
mengoleksinya.

Game dimulai saat kita,
anggota pasukan payung Divisi
ke-101 Amerika Serikat,
diterjunkan ke daratan Perancis
untuk menyerang sasaran-sasaran
musuh sebagai persiapan
pendaratan pasukan utama di
pantai Normandia. Di sini kita
akan merasakan kesunyian
mencekam karena kita
diterjunkan sendirian untuk
memasang beacon (suar) sebagai
penanda lokasi terjun pasukan
kita. Untuk bisa memasang

beacon, kita harus melumpuhkan
dua orang penjaga, kemudian kita
harus menunggu pesawat
pengangkut menerjunkan
pasukan ke wilayah kekuasaan
Jerman tersebut.

Ketika kita bergabung
dengan pasukan dan mulai maju
mendekati sasaran, neraka
pertempuran pun segera terasa.
Pasukan Jerman mendadak
mengambil posisi dalam
bangunan-bangunan,

memberondong senapan mesin
MG42 ke arah pasukan kita yang
mendekat. 'Keindahan' dari
tembakan gencar dan suara yang
menggelegar ini akan kita alami
di seluruh misi dalam Call of Duty.
Efek suara dalam game ini bagus
sekali, suara peluru yang
berdesingan saja sudah cukup
membuat kita gentar, apalagi
suara peluru yang menembus
daging saat kita atau rekan kita
tertembak. Jangan heran bila
pada saat bermain, kita sampai
merunduk-runduk di depan layar
komputer.

Jika kita memiliki soundcard
dan speaker dengan sistem dolby
surround, pengalaman bermain kita
akan jadi sempurna. Voice acting-
nya sangat profesional, beberapa
dialog yang kental dengan sinisme
gaya militer di film-film Hollywood
akan membuat kita tersenyum.
Sayangnya, seluruh suara vokal dan
percakapan dibuat dalam bahasa
Inggris, padahal yang bertempur
bukan hanya tentara Inggris.
Mungkin game ini akan terasa lebih
sempurna jika karakter-karakternya
menggunakan bahasa asal mereka,
tentunya dengan terjemahan bagi
bahasa non Inggris.

Game ini dibuat dengan teknik
grafis Quake III yang sudah berusia
empat tahun, namun masih tetap
menampilkan keunggulan.
Mungkin game ini tidak menyajikan
hal yang benar-benar baru, namun
tampilan visualnya memiliki gaya
tersendiri, dengan tekstur yang
halus, model-model karakter dan
wajah yang bagus, juga
pencahayaan yang baik. Animasi
karakternya pantas diperhatikan,

saat para prajurit berlarian sambil
menembak, mereka sesekali
melindungi kepalanya dan memberi
isyarat tangan untuk menunjukkan
arah yang harus kita tuju. Sistem
partikelnya membuat ledakan
tampak indah. Tampilan airnya
tampak bagus dengan efek pixel
shading. Dalam menjalankan misi,
kita akan menyaksikan ledakan-
ledakan artileri, dan formasi
pesawat pembom di atas langit
Stalingrad.

Sama dengan game-game lain
yang berbasis engine Quake III, Call
of Duty masih memiliki kekurangan,
tekstur resolusinya agak rendah dan
interiornya agak usang. Selebihnya,
tidak ada yang perlu
dipermasalahkan dalam game ini.

AI (Artificial Intelligence)
pasukan mampu mendukung aksi
kita dan menambah unsur realistis
dalam game ini. AI musuh tak kalah
cerdasnya. Saat bertempur mereka
selalu berusaha mendekat ke posisi
kita, tapi
umumnya
juga sambil
berusaha
berlindung.
Mereka
mampu me-
manfaatkan
semua aspek
lingkungan
seperti
bangkai tank,
parit, bunker
dan bangunan
untuk
berlindung.
Musuh bisa
mengintip dari perlindungan dan
menembak sasaran dengan
perhitungan. Mereka senang
melempar granat saat kita sedang
bersembunyi di balik sesuatu, atau
menghajar kita dengan popor
senapan dalam jarak dekat. Game
ini benar-benar fair, kedua pasukan
harus berusaha mati-matian supaya
tetap hidup.

Musuh mampu memilih
sasaran dan menyerang kita lebih
dahulu. Mereka bisa saja mengincar
kita dan bersembunyi sambil
menunggu kita lengah. Misalnya
saja, saat seorang tentara Jerman
bersembunyi di balik pintu. Dia
membiarkan begitu saja seluruh
tentara Sekutu melewati pintu itu.
Tapi ketika giliran kita melewati
pintu tersebut, tiba-tiba saja dia
melompat dan menghajar kepala
kita. Sangat mengejutkan, bahkan
kita mungkin merasa diperlakukan
tidak adil: kenapa hanya kita yang
diserang? Tapi tak perlu sedih, itulah
kenyataan yang terjadi dalam
perang sungguhan. Don't take it
personal, it's 'only' a war.

Pasukan kita juga pandai
dalam memilih posisi dan
menembak. Namun, bisa saja
prajurit kita (mungkin karena
'naskah' dari skripnya) berlari
melewati tentara Jerman begitu
saja, lalu mendapat gebukan di
kepalanya atau diberondong peluru
di bagian punggungnya. Hal ini
tentu saja sangat menjengkelkan.
Skrip merupakan hal yang
terkadang dipermasalahkan oleh
gamer. Tapi scripting dalam game
ini cenderung menyatu dengan
gameplay-nya.

Publisher: Activision
Developer: Infinity Ward
Jenis: First-Person Shooter
Jumlah Pemain Online: 32

Persyaratan spesifikasi
sistem minimal:

• Prosesor Pentium III
600MHz or Athlon 600MHz

• OS Windows 98/ME
• DirectX 9.0b
• RAM 128MB
• Ruang harddisk 1.4GB (plus

400MB untuk Windows 98/
ME swap file, 600MB untuk
Windows 2000/XP swap
file)

• Soundcard 16-bit
kompatibel dengan DirectX
9.0b

• Keyboard dan mouse

Kekurangan dari game ini
adalah ceritanya yang terlalu
singkat. Dari keseluruhan level
game, level Veteran merupakan
tingkat permainan tersulit,
terutama karena tidak adanya
health packs untuk memulihkan
life atau tenaga kita. Secara
keseluruhan, kualitas game ini
tetap memuaskan. Tapi akan lebih
memuaskan jika pihak
pengembangnya mau
mempertimbangkan untuk merilis

expansion missions yang bisa di-
download gratis.

Mode multiplayer dalam Call
of Duty mirip dengan game
Counter-Strike. Jika kita
terbunuh, otomatis kita keluar dari
permainan. Salah satu bagian
yang paling menarik dari mode
multiplayer ini adalah Killcam, jika
kita terbunuh dalam sebuah
permainan, kita bisa melihat
melalui mata pembunuh beberapa
detik sebelum dia membunuh kita.

Aksi dan suasana yang luar
biasa mampu menutup celah-celah
kekurangan yang ada. Masalah-
masalah sepele dan single player
campaign yang relatif singkat
tidak menghalangi momen-
momen brilian dalam memainkan
game ini. PC+
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FIFA 2004:
Pengalaman
Bermain Bola
yang Lebih
Realistis

Bulan November yang
lalu, EA SPORT merilis

serial game
sepakbolanya yang

terbaru, FIFA 2004.
Sebagai salah satu

game sepakbola yang
beredar di jagad

game olahraga, FIFA
2004 dipastikan bisa

menarik perhatian
para penggemar

gameplay Winning
Eleven. Berbagai fitur

terus ditambahkan
oleh divisi olahraga
Electronic Arts atas
saran dan masukan

dari jutaan
penggemar serial FIFA

di seluruh dunia.

GAMEPLAY YANG LEBIH
REALISTIS

Banyak gamer
menganggap serial FIFA terlalu
mudah untuk dimainkan karena

mereka bisa dengan mudah
menciptakan gol, hingga
terkadang hasil akhir
pertandingan terlihat tidak
realistis. Setelah merilis FIFA
2002, EA mulai
mengembangkan permainan ke
level yang lebih tinggi. FIFA
2004 dinilai cukup berhasil
memuaskan para penggemar
game sepakbola yang menuntut
tingkat permainan yang lebih
sulit.

Yang paling terlihat adalah
AI (Artificial Intelligence)
pertahanan yang jauh lebih
agresif di kotak pinalti – jangan
harap pemain bisa berlari,
berputar, lalu menembak gol
langsung dalam kotak pinalti.
Pertahanan komputer memang
lebih longgar di lapangan
tengah, tapi begitu mendekati
kotak pinalti, pemain bertahan
lawan tidak hanya akan
berusaha menutup ruang
tembak penyerang, tapi juga
akan menjaga pemain lain yang
memiliki kemungkinan akan
mendapatkan operan bola.

Dalam game ini, kita harus
membangun serangan dari awal
dengan sabar dan melakukan
operan-operan untuk mencari
celah pertahanan lawan yang
bisa ditembus. FIFA 2004 lebih
mengutamakan operan untuk
membangun serangan ke kubu
lawan.

Dengan menggunakan
power meter dan accuracy
meter yang dikombinasikan
dengan tingkat curve

tendangan, kita bisa meng-
hasilkan tendangan bebas yang
terlihat lebih realistis. Seperti
pada serial FIFA sebelumnya, EA
selalu menyediakan fasilitas
teknik dribbling untuk melewati
lawan. Dalam FIFA 2004, pemain

masih bisa
menggunakan
fitur freestyle
untuk melakukan
gerakan gerakan
mengecoh lawan.
Tetapi, jangan
harap kita bisa
bergerak seperti
Maradona,
mengelabui
sejumlah pemain
bertahan, lalu
mencetak gol.

OFF-THE-BALL
Off-the-ball merupakan satu

fitur kebanggaan EA, yang
bahkan dipatenkan olehnya.
Idenya memang bagus, tetapi
masih memerlukan banyak
perbaikan. Dengan kontrol off-
the-ball, kita bisa bertindak
sebagai playmaker untuk
melakukan operan bola yang
menakjubkan menembus jebakan
offside lawan. Kita akan diberi
tiga pilihan pemain penyerang
untuk menerima operan bola
kita. Setelah kita menekan
tombol off-the-ball, pemain yang
dipilih akan mencari tempat
kosong di mana ia bisa berdiri
dengan bebas untuk menerima
bola – ini pun tergantung pada
skill kita untuk mencari ruang
gerak bebas. Memang terlihat
sulit pada awalnya, namun

setelah terbiasa, kita akan
tertarik untuk mempelajari trik
ini.

Off-the-ball lebih
bermanfaat pada saat tendangan
penjuru. Kita dapat memilih
pemain mana yang akan diberi
operan bola, kemudian yang
harus kita lakukan adalah
berkonsentrasi untuk mengecoh
pemain bertahan lawan untuk
mendapat tempat terbaik.

MODE CAREER
Mode Career dalam FIFA

2004, bisa dibilang jauh lebih
mengesankan dibandingkan
dengan seri sebelumnya. Kita bisa
memilih tim dari 18 liga atau tim
nasional, dan bermain-main
dengan 10.000 pemain. Kita
dapat melatih tim atau pemain
kita apabila ada keterampilan
pemain yang kita anggap masih
kurang. Hal yang perlu diingat:
bukan hanya kecepatan saja yang
sangat berpengaruh dalam game
ini, tetapi juga keterampilan
para pemainnya. Ada sasaran
yang harus kita capai untuk
mendapat nilai Prestige. Nilai ini
memberi kita kesempatan untuk
menarik pemain berkaliber lebih
tinggi, dan melatih tim yang
lebih baik.

Dalam FIFA 2004, terdapat
pula fitur FootballFusion yang
konon kabarnya akan dipakai
untuk “menyatukan” FIFA 2004
dengan Total Club Manager
2004. Dengan fitur ini, kita dapat
memainkan klub yang kita
bangun pada TCM 2004 di FIFA
2004, begitu juga sebaliknya. Hal
ini sangat menarik. Sebaiknya,

Jonathan H. Sitohang
jonathan_hs@telkom.net

Rating Game
Grafis & Tampilan 87
Rating 89
Sound 90
Gameplay 90

Konfigurasi minimum
• Prosesor 600MHz Intel

Pentium III atau setaranya
64MB RAM (128 MB untuk
Windows XP dan Windows
2000)

• Sound card kompatibel
dengan DirectX 8.1

• Kartu grafis 32MB
kompatibel dengan DirectX
8.1

• Ruang hard disk 880MB
• Sistem Operasi Windows

98, Windows ME, Windows
XP or Windows 2000

kita tunggu saja rilis dari Total
Club Manager 2004.

TAMPILAN DAN SOUND
Seperti biasa, EA selalu

memperhatikan tampilan grafis
game-game yang mereka rilis.
Walaupun belum menggunakan
DirectX 9.0, seperti yang
diharapkan oleh banyak
penggemarnya, permainan ini

masih bisa memikat perhatian
banyak gamer. EA lebih memilih
untuk menggunakan DirectX 8.1
untuk menarik target pemain
dengan kartu grafis minimum.

Jumlah polygon
ditingkatkan, sehingga sosok
karakter pemain terlihat lebih
“manusia” dibandingkan
sebelumnya, mata pemain pun
tampak lebih hidup. Cara pemain
berlari, berjalan, menendang
bola, bahkan jatuh pun terlihat
lebih realistis. Bila pemain kita
jatuh, baju seragam mereka akan
ikut kotor. Stadion digambarkan
lebih indah dengan pernak-
pernik bendera tim dan teriknya
sinar matahari.

Tampilan presentasi menu
yang disajikan EA masih menarik
seperti game-game sebelumnya.

Untuk sound-nya, EA
menyediakan 35 lagu
soundtrack yang sangat asyik
untuk didengar. Sebagai efek
latar di stadion, kita bisa
mendengarkan suara penonton
mengelu-elukan nama tim
andalannya pada saat
pertandingan. Suara penonton
dan komentator pertandingan
terdengar cukup “hidup”. PC+
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Daftar Harga Komputer &
Periferal yang dihimpun dari
berbagai toko & distributor

komputer di Jakarta.
Harga dalam Dolar AS
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MOTHERBOARD

Asus P4S800, SiS648FX, 5 PCI,
AGP 8X, USB 2.0, HTT 95
Asus P4PE-X, i845PE, AGP4X, DDR,
6PCI, USB2.0, Hyper-threading 85
Asus P4SDX, SiS655, AGP8X, DDR,
6PCI, USB2.0, Hyper-threading 71
Asus P4C800 Deluxe, Intel 875,
FSB800, ATA100, RAID, AGP Pro 252
Asus P4P800 Deluxe, i865, FSB 800,
ATA100, 4DDR 158
Asus P4T-CM, i850, soket 423,
FSB400, ATA100, 2RDRAM 63
Asus P4P800, i865, FSB800,
4DDR, RAID, LAN, audio 137
Asus P4C800, i875, FSB800, 4DDR,
RAID, Audio, Gigabit LAN 189
Asus P4P800 +WiFi, i865PE, FSB800,
ATA100_SATA, 4DDR, audio 179
Asus P4S533-MX, SiS651 FSB533,
ATA133, 2DDR+ 2SDR, audio,
VGA onboard 70
Asus P4S8X/L 1394, SiS648,
FSB533, 3DDR, AGP8x, audio,
Serial ATA, 1394 131
Asus P4S8X-X , SiS648, FSB533,
ATA133, AGP8x, 3DDR, audio,
Gigabit LAN 80

Asus P4P800S, i848P, FSB800, 2DDR,
audio, S/PDIF 111
Asus A7V8X/L 1394, KT400, ATA133,
AGP8x, FSB266, 3DDR, audio,
LAN, 1394 126
Asus A7V600, VIA KT600, 6 PCI,
3DDR, AGP8x 107
Asus A7N8X-X, NForce2, ATA133,
5 PCI, 3DDR, audio dolby, AGP8x 101
Asus A7V8X/L, VIA KT400, 6 PCI,
3DDR, SATA, ATA133 116

APLUS AP984 SATA, i865PE,
FSB 800MHz, 4DDR400, ATX, AC97 91
APLUS AP981,i845GE, FSB 533MHz,
2DDR, ATX, AC’97 74
APLUS AP980, i845PE, ATX,
FSB533,2DDR333 SOUND AC97 68
APLUS AP986 VIA P4X400, ATX,
FSB533, SOUND AC97 6 channel,
3DDR400, AGP8X 52
APLUS AP976E2, VIA P4X266E, FSB
533MHz, 2DDR,M- ATX, AC’97 49
APLUS AP976, VIAP4X266E,
FSB 400MHz, 2DDR, M-ATX, AC’97 48
APLUS AP972A3 VIA P4M266A, ATX,
533FSB, SOUND AC97, 2DDR 49
APLUS AP982 VIA KT400, ATX,
266FSB, SOUND AC97, 3DDR 62
APLUS AP975 VIA KT333, ATX,
266FSB, SOUND AC97, DDR333 60

MSI 875P Neo FIS2R, i875P, ATX,
FSB800, 2DIMM, ATA100, AGP8X, 6PCI 200
MSI P4MAM-L, VIAP4M266A, ATX,
FSB533, 2DIMM, ATA133, AGP4X, 3PCI 59
MSI 651M-L, SiS 651, m-ATX, FSB533,
2DIMM, ATA133, AGP4X 66
MSI 648 MAX-V, SiS 648x, ATX,
FSB533, 3DIMM, ATA133, AGP8X, 6PCI 68

MSI 848P Neo-S, i848P, FSB800MHz,
AGP8X, 2GB DDR400, SATA, 5PCI 94
MSI 648F Neo, SiS648FX, FSB800MHz,
AGP8X, 3GB DDR ATA133,
SATA, AGP8X 78
MSI 645GVM, I845GV, Matx, FSB533,
2DIMM, ATA100, AGP4X, 6PCI 72
MSI 845PE Max, I845PE, ATX, FSB533,
2DIMM, ATA100, AGP4X, 6PCI 74
MSI 865PE Neo2, I865pe, ATX,
FSB800, 2GBDDR, ATA133,
AGP8X, 5PCI 120
MSI K7N2 Delta-L, nForce2, ATX,
FSB400, 3GB DDR, ATA133,
AGP8X, 5PCI 102
MSI K8T Neo-FIS2R, VIA K800T800,
ATX, FSB800, 3DDR, ATA133,
AGP8X, 5 PCI 180
KT4V, Via KT400, ATX, FSB333,
3GBDDR, ATA133, AGP8X, 6PCI 72

Matsonic 9158E+, VIA P4M266,
FSB533, USB2.0, VGA ONBOARD 49
Matsonic 9127C, VIAP4X400, FSB533,
USB2.0, DDR400, AGP8X 55
Matsonic 9327D+, SIS650, FSB533,
USB2.0, 2DDR, VGA ONBOARD 54
Matsonic 9337C, SIS648, FSB533,
USB2.0, 3DDR400, AGP8X 64
Matsonic 9377C, SIS648FX, FSB800,
3DDR400, AGP8X, HTT 69
Matsonic 9367E, SIS 650GX, FSB533,
2DDR, VGA ONBOARD +AGP 55
Matsonic 8137C, VIA KT266A, FSB266,
2DDR, VGA ONBOARD +AGP 49
Matsonic 8157E, VIA KM266, FSB 266,
2DDR, AUDIO, VGA ONBOARD +
AGP 58
Matsonic 8167C, VIA KT333, FSB266,
3DDR333, AGP 4X, AUDIO 51

Matsonic 8147C, VIA KT400A, FSB333,
3DDR400, AGP 8X, LAN ONBOARD 59

Gigabyte GA-7VKMP-P, VIA AKM266,
ATX, Soket A, ATA133, LAN 65
Gigabyte GA-7VA, VIA KT400,
ATX, Soket A, ATA133 79
Gigabyte GA-7N400-EL,
nForce2 ultra, ATX, Soket A, ATA133 99
Gigabyte GA-7N400 Pro,
nForce2 ultra, ATX, Soket A 150
Gigabyte GA-7NNXP, nForce2 Ultra,
FSB400, 4DDR, 5 PCI 212
Gigabyte GA-7NNXPV, nForce2,
FSB333, 4DDR, 5PCI 242
Gigabyte GA-S648,  SiS 648, ATX,
FSB533, ATA133, AGP8X, 5PCI 73
Gigabyte GA-S648FX, SiS 648FX,
ATX, FSB800, ATA133, 5PCI 97
Gigabyte GA-SINXP 1392 DDR400,
SiS655, ATX, FSB533, ATA133 167
Gigabyte GA-S648-L, SiS648,ATX,
FSB533, ATA133, 5PCI 75
Gigabyte GA-8IPE1000, i865PE,
ATX, FSB800, 4DDR, 5PCI 127
Gigabyte GA-8PE800Ultra+Raid,
i845PE, ATX, FSB800, ATA133 92
Gigabyte GA-8KNXP+Raid+ SATA,
i875P, ATX, FSB800, ATA133, AGP pro 217
Gigabyte GA-K8N, Nforce3 150,
FSB800, 3DDR, ATA133, AGP8X, 5PCI 132
Gigabyte GA-K8NNXP, Nforce3 150,
FSB800, 3DDR, SATA, AGP8X, 5PCI 217
Gigabyte GA-K8VT800M, VIAK8T800,
FSB800, 3DDR, SATA, AGP8X, 5PCI 122
Gigabyte GA-K8VNXP, VIAK8T800,
FSB800, 3DDR, SATA, AGP8X, 5PCI 207

DFI LAN Party Pro875, i875P, ATX,
FSB800, AGP8X, 2SATA 190

DFI LAN Party KT400A, VIA KT400A,
ATX, FSB400, AGP8X, 1SATA 130
DFI LAN Party NF II Ultra, nForce 2,
ATX, FSB400, AGP8X, 1SATA 155
DFI PS83-BL, i865PE, ATX, FSB800,
AGP8X, 2SATA 85
DFI 648FX-ALE, i648FX, ATX, FSB800,
AGP8X, DDR 400 67
DFI P4X800-AL, VIA P4X400, ATX,
FSB533, AGP8X, ATA133 52
DFI KT400A Infinity, VIA KT400A,
ATX, FSB333, AGP8X, 1SATA 88

Iwill mP4G2S, i845GL, soket 478,
FSB400, LAN, DDR, 65
Iwill mP4G2, i845GV, soket 478,
FSB533, DDR, 68
Iwill P4G, i865PE, soket 478,
FSB800, LAN, DDR, serial ATA 69
Iwill P4HT2, i845PE, soket 478,
FSB 533, DDR, Audio, 78
Iwill P4SE, i865PE, soket 478,
FSB 800, DDR, Audio, ATA100,
Serial ATA 110
Iwill DX400-SN, ii860, soket 603,
RDRAM, Dual Pro include casing,
SCSI 999

Soyo K7V Dragon Ultra. VIA KT333,
6ch audio, AGP Pro, LAN10/100 145
Soyo K7V Dragon Lite. VIA KT333,
6ch audio, AGP 4x 85
Soyo P4X400, VIA P4X400, RAID,
6ch audio, AGP PRO, 6 PCI 155
Soyo P4I Fire Dragon, i845D, DDR266,
RAID, 6ch audio, AGP PRO, 6 PCI 120
Soyo P4S Dragon Ultra, Sis645A2+
961, RAID, 6ch audio, AGP PRO, 6 PCI 140
Soyo P4IS2, i845, SDRAM, AC97,
6PCI, AGP4X 60
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KURSUS

KURSUS Video Editing (Adobe Premier) 350rb
Digital Imaging (Photoshop) 150rb Merakit PC
95rb LAN 95rb Praktis,Cepat,Certificate IZZAH
Com  J l .Rawamangun Timur No.78
Ph.47867273

LAIN-LAIN

DISTRO LINUX,Menjual CD Linux terbaru.
Mandrake/Redhat/Slackware/Openoffice dll
Murah dan Bergaransi (1 to 1 Replacement)
Kualitas CD dijamin bagus ( LG/BenQ/Sony)
Bisa kirim keseluruh Indonesia. Hubungi:
08121876981 Email: distro_linux@yahoo.com
http://www.geocities.com/distro_linux/

IKLAN BARIS

Visipro 128MB 43
Visipro 256MB 75

COMPACT FLASH

MCPRO Flash memory 32MB 17
MCPRO Flash memory 64MB 21.5
MCPRO Flash memory 128MB 37.5
MCPRO Flash memory
256MB 54

Abit IC7 Max III  i875P, FSB800MHz,
4 DDR, AGP 8X, 5 PCI 325
Abit BE7, i845PE, FSB 533MHz,
3 DDR, AGP 4X, 5 PCI 102
Abit BH7, i845PE, FSB 800MHz,
3 DDR, AGP 4X, 5 PCI 94
Abit IC7 MAX III, i875P, FSB 800MHz,
4 DDR, AGP 8X, 5 PCI 233
Abit IC7, i875P, FSB 800MHz,
4DDR, AGP 8X, 5 PCI 143
Abit AI7, i865PE, FSB 800MHz,
4 DDR, AGP 8X, 5 PCI 144
Abit IC7G i875/ICH5-R, FSB 800MHz,
4 RIMM, AGP 8X, 5 PCI 190
Abit IS7E, i865PE, FSB 800MHz,
4 DDR, AGP 8X, 5 PCI 109
Abit IS7, i865PE, FSB 800MHz,
4 DDR, AGP 8X, 5 PCI 133
Abit VI7, VIA PT800, FSB 800MHz,
2 DDR, AGP 8X,  5 PCI 94
Abit KV7, Via KT600/8235,
FSB 400MHz, 4 DDR, AGP 8x, 6 PCI 93
Abit NF7S, nVidia nForce2,
FSB 333MHz, 3 DDR, AGP 8X, 3 PCI 116
Abit KD7-A, Via KT400,
FSB 333MHz, 4DDR, AGP 8X, 6 PCI 84
Abit NF7, nForce 2, FSB 333MHz,
3 DDR, AGP 8X, 3 PCI 93
Abit NF7-SL, nForce 2, FSB 333MHz,
3DDR, AGP 8X, 3 PCI 111

MEMORI

Visipro 128MB (4 IC) PC 133 30
Visipro 128MB (8 IC) PC 133 38
Visipro 256MB (8 IC) PC-133 60
Visipro 256MB (16 IC) PC-133 73
Visipro 512MB PC-133 110
Visipro 128MB (8 IC) PC-2100 26
Visipro 256MB (8 IC) PC2100 45
Visipro 256MB (16 IC) PC2100 Call
Visipro 512MB PC-2100 88
Visipro 128MB (4 IC) PC-2700 26
Visipro 128MB (8 IC) PC-2700 29
Visipro 256MB (8 IC) PC2700 45
Visipro 256MB (16 IC) PC2700 Call
Visipro 512MB PC-2700 89
Visipro 256MB PC3200 (8IC) 50
Visipro 512MB PC3200 102
Visipro 64MB PC800 36
Visipro 128MB PC800 (8IC) 52
Visipro 256MB PC800 (8IC) 105

V-Gen SDRAM PC-133 (8IC) 64MB 17
V-Gen SDRAM PC-133 (4IC) 128MB 28
V-Gen SDRAM PC-133 (8IC) 128MB 34
V-Gen SDRAM PC-133 (8IC) 256MB 53
V-Gen SDRAM PC-133 (16IC) 256MB 67
V-Gen SDRAM PC-133 (16IC) 512MB 105
V-Gen DDR PC-2100  128MB 24
V-Gen DDR PC-2100  256MB 41
V-Gen DDR PC-2700  256MB 42
V-Gen DDR PC-2100  512MB 80
V-Gen DDR PC-2700  512MB 81
V-Gen DDR PC-3200  256MB 44
V-Gen DDR PC-3200  512MB 87
V-Gen RDRAM PC-800 128MB 50
V-Gen RDRAM PC-800 256MB 97

Kingston 128MB DDR PC2100 22.5
Kingston 256MB DDR PC2700 42
Kingston 512MB DDR PC2700 81
Kingston 256MB DDR PC3200 45
Kingston 512MB DDR PC3200 89

MULTIMEDIA CARD

MCPRO 64MB 22
MCPRO 128MB 35
MCPRO 256MB 69,5

Twinmos MMC 64MB 27.5
Twinmos MMC 128MB 41

Visipro 64MB 26
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Jl. M. Nawi HRP G. Suka No.17
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2. Dwi Suparti
Jl. Kesatrian G-2 RT.06/03
Jatingaleh - Semarang 50254

3. Apriandi R.S.
Jl. Melati III B6/13 Perum P.U.P
Bekasi Utara 17125

4. Denny Sela
Wergu Wetan 155 04/II
Kudus 59318

5. Putut Bayuaji
Sendowo Blok F-139
Jogjakarta 55284

KUIS "Plus, aku mau beli kartu grafis. Pilihannya adalah GeForce-4
MX440, Ti4200, Ti4600, FX5200, dan FX5900", kata Mamat kawan si
Ciplus. "Yang aku bingung, dari pilihan itu mana sih yang lebih

cepat?", tambahnya. Tolong dong si Ciplus, urutkan kartu grafis yang paling cepat
hingga yang paling lambat dari daftar tersebut? Tuliskan jawaban tersebut di sehelai
kartu pos dengan mencantumkan alamat yang jelas dan sudah dibubuhi Kupon Kuis asli (di
pojok kanan). Jangan menunda-nunda, karena jawaban sudah harus masuk ke meja Redaksi
PCplus paling lambat tanggal 09 Januari 2004. PCplus akan memberikan 5 buah kaos PCplus
untuk 5 orang pemenang yang menjawab dengan benar dan beruntung! Buruan!!! Hadiah
akan dikirim langsung ke alamat pemenang.
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HARDDISK

Maxtor 6L020L 20,4GB 7200rpm
ATA133, 2MB Cache, dual processor 53
Maxtor 6E030L 30GB 7200rpm ATA133,
2MB Cache, dual processor 55
Maxtor6E040L/6E040 40GB 7200rpm
ATA133, 2MB Cache, dual processor 59
Maxtor 6Y060L 60GB 7200rpm ATA133,
8MB Cache, dual processor 72
Maxtor 6Y080L 80GB 7200rpm ATA133,
8mb cache, dual processor 75
Maxtor 6Y120L, 120GB, 7200rpm,
8,5ms, uDMA133, 8MB cache 105
Maxtor 6Y160PO, 160GB, 7200rpm,
ATA 133/serial ATA, 8MB cache 165
Maxtor 6Y200PO, 200GB, 7200rpm,
ATA 133/serial ATA, 8MB cache 225

Seagate Ux/Cuda 5400.1 20GB
ATA 100 51.2
Seagate Ux/Cuda 5400.1 40GB
ATA 100 52.3
Seagate Barracuda 7200.7 40GB
ATA100 56
Seagate Barracuda 7200.7 80GB
ATA100 71.9
Seagate Barracuda 7200.7 120GB
ATA V/100 100.4
Seagate Barracuda 7200.7 Plus
160GB ATA V/100 (8MB cache) 134.6
Seagate Barracuda SATA 80GB,
ATA100 103,5
Seagate Barracuda SATA 120GB,
ATA100 126.3

Maxtor 2F020J/L, 20GB 5400rpm,
ATA-133, 2MB cache 50
Maxtor 2F030J/L, 30GB, 5400rpm,
ATA-133, 2MB cache 53
Maxtor 2F040J/L, 40GB, 5400rpm,
ATA-133, 2MB cache 58
Maxtor 4R060J/4D060H,
60GB 5400rpm, ATA-133,
2MB cache 67
Maxtor 4D080H/4K080H, 80GB,
ATA-100, 2MB cache 80
Maxtor 4G120H, 120GB 5400rpm,
ATA-100, 2MB cache Call
Maxtor 4G160H, 160GB, 5400rpm,
9,0ms, ATA100, 2MB cache,
dual processor 165
Maxtor 6YO80MO, 80GB SATA,
7200RPM, 8MB Cache 103

Maxtor 6Y120MO, 120GB SATA,
7200RPM, 8MB Cache 125
Maxtor 6Y160MO, 160GB SATA,
7200RPM, 8MB Cache 170
Maxtor 6Y200MO, 200GB SATA,
7200RPM, 8MB Cache 235

Western Digital WDC 5400rpm
cache 2MB 20GB 53
Western Digital WDC 5400rpm
cache 2MB 40GB 57
Western Digital WDC 7200rpm
cache 2MB 40GB 67
Western Digital WDC 7200rpm
cache 8MB 40GB 79
Western Digital WDC 7200rpm
cache 8MB 80GB 112
Western Digital WDC 7200rpm
cache 2MB 100GB 135
Western Digital WDC 7200rpm
cache 2MB 120GB 160
Western Digital WDC 7200rpm
cache 8MB 160GB 210

Samsung HDD 20GB 5400rpm 56
Samsung HDD 40GB 5400rpm 70

EXTERNAL DRIVE

Maxtor 5000DV 160GB,
USB 2.0, 8MB Cache, 7200rpm 299
Maxtor 7000, 120GB, external,
USB 2.0, 2MB cache, 5400rpm 235
Maxtor 7000, 200GB, external,
USB 2.0, 8MB cache, 7200rpm 360
Maxtor 7000, 250GB, external,
1394/USB2.0, 8MB cache, 7200rpm 405

SCSI HARDDISK 7200RPM &
10K RPM

Maxtor KU018L/J 18 GB Atlas,
68/80 pin, 10 K RPM, SCSI-320,
8 MB cache 145
Maxtor 8B036L/J 36 GB Atlas IV,
68/80 pin, 10 K RPM, SCSI-320,
8 MB cache 185
Maxtor 8B073 73 GB Atlas IV,
68/80 pin, 10 K RPM, SCSI-320,
8 MB cache 425

IBM IC35LO36UWD, 36GB, 68 pin,
10 Krpm, SCSI160, 8MB cache 200

Quantum XC009J, 18GB, 68/80pin,
7200rpm, SCSI160, 4MB cache 80
IBM IC35L009, 9GB, 68pin, 10Krpm,
SCSI160,  8MB cache 115
IBM DPSS 9170W, 9,1GB, 68/80pin,
7200rpm, SCSI160, 4MB cache 95

Seagate Medalist Pro 4,5GB U2W,
M Pro, 9,5ms 54
Seagate Cheetah  U320 36,6GB 163
Seagate Cheetah U320  73GB 398
Seagate Cheetah U320 73.4GB
Fibre channel 510
Seagate Cheetah U320 36,7GB 306

MAGNETIC OPTICAL DRIVE

Fujitsu MCC-3064ATAPI, 640MB,
ATAPI internal, 3,5" 230
Fujitsu MCE-3130AP, 1,3GB,
ATAPI internal, 3,5" 325
Fujitsu MSS-3064S, 640MB,
SCSI internal, 3,5" 250
Fujitsu Dynamo 640/EE,
external firewire 1394 350
Fujitsu Dynamo 1300,
1300MB, external firewire 450

PROSESOR

Athlon Xp 1800+ (Thoroughbred A) 42.5
Athlon Xp 2000+ (Thoroughbred A) 50.5
Athlon Xp 2100+ (Thoroughbred A) 55
Athlon XP 2200+ ((Thoroughbred A) 64
AthlonXP 2400+ fan (Thoroughbred B) 71
AthlonXP 2600+ (FSB333) + fan 87
AthlonXP 2800+ (Barton FSB333) 140
AthlonXP 3000+ (Barton FSB333) 199

AMD ATHLON XP 2000+ (BOX) +
FAN TBRED B FSB 266MHz 69
AMD ATHLON XP 2200+ (BOX) +
FAN TBRED B FSB 266MHz 76
AMD ATHLON XP 2400+ (BOX) +
FAN TBRED B FSB 266MHz 83
AMD ATHLON XP 2600+ (BOX) +
FAN BARTON FSB 333MHz, CACHE 512 105
AMD ATHLON XP 2500+ (BOX) +
FAN BARTON FSB 333MHz CACHE 512 94
AMD ATHLON XP 2800+ (BOX) +
FAN BARTON FSB 333MHz CACHE 512 150
AMD ATHLON XP 3000+ (BOX) +
FAN BARTON FSB 333MHz CACHE 512 229

AMD ATHLON XP 3200+ (BOX) +
FAN BARTON FSB 400MHz CACHE 512 459

Intel Pentium-4 1,8AGHz-478 119
Intel Pentium-4 3,06GHz, box, 478 281
Intel Pentium-4 1,8AGHz,
512KB cache L2, 478 126
Intel Pentium-4 2,0AGHz,
512KB cache L2, 478 138
Intel Pentium-4 2,4BGHz,
512KB cache L2, FSB 533, 478 180
Intel Pentium-4 2,66GHz,
(512) FSB 533 179
Intel Pentium-4 2,8GHz
(512) FSB 533 210
Tray Pent-4 2,4CGHz, cache 512Kb,
FSB 800 w/o fan 165
Box Pent-4 2,4CGHz, cache 512Kb,
FSB 800 174
Box Pent-4 2,6CGHz, cache512Kb,
FSB800 194
Box Pent-4 2,8CGHz, cache512Kb,
FSB800 210
Box Pent-4 3.0GHz, cahce512Kb,
FSB800 297
Box Pent-4 3,2GHz, cache512Kb,
FSB800 441
Intel Celeron 1,7GHz, c/128 62
Intel Celeron 2.0GHz, c/128 65
Intel Xeon Pentium-4 2,4GHz
512KB cache L2 239
Intel Xeon Pentium-4 2,BGHz,
512KB cache L2, 533 250
Intel Xeon Pentium-4 2,6GHz,
512KB cache L2 278
Intel Xeon Pentium-4 3,06
512KB cache L2, 533MHz 509

HEATSINK FAN

Coolermaster HAC-V81 (X-Dream) 21
Coolermaster HSC-V83 30
Coolermaster HHC-001 28
Coolermaster IHC-L71 32

Zalman CNPS-2005 15
Zalman CNPS-3000 18
Zalman CNPS3100 24
Zalman CNPS3100 G 35
Zalman CNPS5001 AL 19
Zalman CNPS 5001CU 26
Zalman CNPS-5700D-CU 32
Zalman CNPS 7000 CU 42
Zalman CNPS 7000 ALCU 35

CASING

Procase ATX PS/2 tipe 477
power supply 350W 23
Procase ATX PS/2 tipe 0207
power supply 350W 24
Procase ATX PS/2 tipe 0208
power supply 350W 26

Enermax ATX CS-5190 AL,
power supply 365W 404
Enermax ATX CS-5190 AL,
power supply 450W 419
Elan Vital S15, big tower, ATX,
power supply 300w 472

VGA CARD

Asus A9600SE/TD/128MB 152
Asus A9200SE/T/ 64MB 64
Asus V9950 Ultra/ DLX,
GeForceFX 5900, AGP 8x,
128MB DDR 567
Asus V9520 Magic/T GeForceFX 5200,
128MB, AGP8X 85
Asus V9520 Home Theater-128MB 189
Asus V9280 /TD, Ti4200-128MB 173
Asus V9950 Ultra/TVD,
GeForce FX5900, 256MB 546
Asus V9180 SE/T 64MB, MX-440-8X 53

Abit Siluro FX5200DT, FX5200,
AGP8X, 128MB DDR 82
Abit Siluro FX5600 Ultra OTES,
FX5600Ultra, AGP8X, 128MB DDRII 207

PixelView GeForce FX 5200 ultra,
128MB DDR 4ns, GPU 250MHz,
RAM Clock 500MHz, TV-out, DVI Port 85
PixelView GeForce FX5600tv,
128MB DDR, 3,6ns, GPU400MHz,
RAM550MHz, TV-out, DVI Port 155
PixelView GeForce FX 5600 Vivo,
128MB DDR, GPU 400MHz,
RAM 550MHz 145
PixelView GeForce 5600 Ultra,
256MB 3,3ns, GPU 325MHz, DVI port 190
PixelView GeForce FX 5900
256MB DDR II, 2,2ns, GPU 400Mhz 450
PixelView FX5700, AGP8X,
DDRII 256MB, VIVO, DVI 205
pixelView FX5700, AGP8X,
DDR 128MB, VIVO, DVI 180
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